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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of 
identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Postfach 48 48 
90026 NÜRNBERG 
GERMANY 
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Preface 

Contents of this commissioning and hardware installation Manual 
This document is part of the SIMOTION D documentation package. 

Scope 
The SIMOTION D4x5 Commissioning and Hardware Installation Manual is valid for the 
SIMOTION D425, SIMOTION D435, SIMOTION D445/D445-1, and CX32 devices.  
A separate SIMOTION D4x5-2 Commissioning and Hardware Installation Manual is available 
for the SIMOTION D4x5-2 devices including the CX32-2 and TB30 system components. 

Standards 
The SIMOTION system was developed in accordance with ISO 9001 quality guidelines. 

Information in this manual 
The following is a description of the purpose and use of this Commissioning and Hardware 
Installation Manual: 

● Description 

Provides information about the SIMOTION system and its integration in the automation 
environment. 

● Use planning 

Provides information on the transport, storage, and environmental conditions. 

● Installation 

Provides information on the various installation options for the device. 

● Connection 

Provides information about connecting and cabling the various devices, and about 
communications interfaces. 

● Commissioning (hardware) 

Provides information on commissioning the device. 

● Parameter assignment / addressing 

Provides information on configuring and parameterizing the various bus systems. 

● Commissioning (software) 

Provides information on configuring and commissioning the system. 
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● Maintenance and servicing 

Provides information about service and maintenance procedures that must be performed 
on the device. 

● Diagnostics 

Provides information about the available diagnostic information, how to interpret it, and its 
meaning. 

● Appendices with factual information for reference (e.g. standards, approvals and ESD 
guidelines). 

SIMOTION Documentation 
An overview of the SIMOTION documentation can be found in a separate list of references.  

This documentation is included as electronic documentation in the scope of delivery of 
SIMOTION SCOUT. It comprises 10 documentation packages.  

The following documentation packages are available for SIMOTION V4.2: 

● SIMOTION Engineering System 

● SIMOTION System and Function Descriptions 

● SIMOTION Service and Diagnostics 

● SIMOTION IT 

● SIMOTION Programming 

● SIMOTION Programming - References 

● SIMOTION C 

● SIMOTION P 

● SIMOTION D 

● SIMOTION Supplementary Documentation 

Hotline and Internet addresses 

Additional information 
Click the following link to find information on the the following topics: 

● Ordering documentation/overview of documentation 

● Additional links to download documents 

● Using documentation online (find and search in manuals/information) 

http://www.siemens.com/motioncontrol/docu 

Please send any questions about the technical documentation (e.g. suggestions for 
improvement, corrections) to the following e-mail address: 
docu.motioncontrol@siemens.com 
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My Documentation Manager 
Click the following link for information on how to compile documentation individually on the 
basis of Siemens content and how to adapt this for the purpose of your own machine 
documentation: 

http://www.siemens.com/mdm 

Training 
Click the following link for information on SITRAIN - Siemens training courses for automation 
products, systems and solutions: 

http://www.siemens.com/sitrain 

FAQs 
You can find Frequently Asked Questions on the Service&Support pages under Product 
Support: 

http://support.automation.siemens.com 

Technical support 
Country-specific telephone numbers for technical support are provided on the Internet under 
Contact: 

http://www.siemens.com/automation/service&support  

Disposal and recycling of the device 
SIMOTION D is an environmentally friendly product. It includes the following features: 

● In spite of its excellent resistance to fire, the flame-resistant agent in the plastic used for 
the housing does not contain halogens. 

● Identification of plastic materials in accordance with DIN 54840. 

● Less material used because the unit is smaller and with fewer components thanks to 
integration in ASICs. 

The disposal of the products described in this manual should be performed in compliance 
with the valid national regulations. 

The products can be largely recycled owing to their low pollutant content. To recycle and 
dispose of your old device in an environmentally friendly way, please contact a recycling 
company certified for electronic waste. 

If you have any further questions about disposal and recycling, please contact your local 
Siemens representative. Contact details can be found in our contacts database on the 
Internet at: 

http://www.automation.siemens.com/partner/index.asp 
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Further information / FAQs 
You can find further information on this manual under the following FAQs: 

http://support.automation.siemens.com/WW/view/de/27585482 

You can also find additional information under: 

● SIMOTION Utilities & Applications: SIMOTION Utilities & Applications will be included in 
the SIMOTION SCOUT scope of delivery and, along with FAQs, also contain free utilities 
(e.g. calculation tools, optimization tools, etc.) as well as application examples (ready-to-
apply solutions such as winders, cross cutters or handling). 

● The latest SIMOTION FAQs at  
http://support.automation.siemens.com/WW/view/en/10805436/133000 

● SIMOTION SCOUT online help 

● Refer to the list of references (separate document) for additional documentation 
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Description 1
1.1 System overview 

Overview 
SIMOTION D is a drive-based version of SIMOTION based on the SINAMICS S120 drive 
family.  

With SIMOTION D, the SIMOTION PLC and motion control functionalities as well as the 
SINAMICS S120 drive software run on shared control hardware. 

SIMOTION D is available in two versions: 

● SIMOTION D410 is a compact control unit for single-axis applications and is snapped on 
to the SINAMICS S120 PM340 power module in blocksize format. 

● SIMOTION D4x5 is a control unit for multi-axis applications in SINAMICS S120 booksize 
format and is offered in several performance variants: 

– SIMOTION D425 (BASIC performance) for up to 16 axes 

– SIMOTION D435 (STANDARD performance) for up to 32 axes 

– SIMOTION D445/D445-1 (HIGH Performance) for up to 64 axes 
Compared with SIMOTION D445, SIMOTION D445-1 offers an improvement in PLC 
and motion control performance of approximately 30%, depending on the application.  
Consequently, SIMOTION D445-1 is the preferred solution for new applications as of 
V4.1 SP2. 

This manual describes the SIMOTION D4x5 for multi-axis applications. Separate manuals 
are available for the SIMOTION D410 single-axis module as well as for the SIMOTION 
D4x5-2 multi-axis modules. 

Like SINAMICS S120, SIMOTION D also follows the Totally Integrated Automation (TIA) 
concept. TIA is characterized by integrated data management, configuration, and 
communication for all products and systems. Thus, an extensive toolbox of automation 
modules is also available for SIMOTION D.  

 

 Note 

In order to cover all versions of SIMOTION D for multi-axis applications, the product will be 
referred to as "D4x5". Specific product designations will be used for information that applies 
only to one product version, e.g. D435. 
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Application  
SIMOTION D4x5 is ideally suited to applications with many coordinated axes with high clock-
pulse rates. 

Typical applications include: 

● Compact multiple-axis machines 

● High-performance applications with short machine cycles 

● Compact machines 

– Including the complete machine control in the drive 

– With extensive connection possibilities for communication, HMI and I/O 

● Distributed drive concepts 

– Applications with many axes 

– Synchronization of several SIMOTION D control units using distributed synchronous 
operation 

Versions  
The individual versions - SIMOTION D425 (BASIC Performance), SIMOTION D435 
(STANDARD Performance) and SIMOTION D445/D445-1 (HIGH Performance) - differ in 
terms of their PLC performance and motion control performance. The main distinguishing 
features are: 

 
 SIMOTION D425 SIMOTION D435 SIMOTION D445/D445-1 
Maximum number of axes 16 32 64 
Minimum servo/interpolator 
cycle clock 

2.0 ms 1.0 ms 0.5 ms 

DRIVE-CLiQ interfaces 4 4 6 

 

SIMOTION D4x5 features PLC and motion control performance (open-loop control and 
motion control) for up to 16, 32 or 64 axes, as required.  

Due to the following functional improvements, we recommend using a SIMOTION D445-1 
instead of a SIMOTION D445 for new applications as of V4.1 SP2:  

● An increase of around 30% in PLC and motion control performance, depending on the 
application 

● Less mounting depth (mounting is possible even without spacers) 

● Double-fan/battery module for higher availability 

● Further information (http://support.automation.siemens.com/WW/view/en/31507782) 

The computing functions integrated into the drive allow the D4x5 control unit to operate up to 
six servo, four vector or eight V/f axes.  

http://support.automation.siemens.com/WW/view/en/31507782�
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The drive control supports servo control (for a highly dynamic response), vector control (for 
maximum torque accuracy) and V/f control. 

 

 Note 

With the SIZER configuration tool, you can easily configure the SINAMICS S120 drive family 
including SIMOTION. 

It provides you with support for selecting and dimensioning the components required for a 
motion control task. 

You can also determine the possible number of axes and the resulting load with SIZER in 
accordance with your performance requirements. 

 

Hardware components 
As the central hardware, SIMOTION D uses the SIMOTION D4x5 as a control unit consisting 
of the SIMOTION runtime system and the SINAMICS drive control. The control unit uses the 
SINAMICS Integrated drive with various SINAMICS S120 drive modules (line and motor 
modules) to perform open-loop and closed-loop control of the axis grouping. A range of 
additional SINAMICS S120 components, such as SMx encoder systems or terminal modules 
can be connected via DRIVE-CLiQ. With a few exceptions (e.g. no basic positioner EPOS, 
no basic operator panel BOP20, etc.), the drive control integrated in SIMOTION D has the 
same control characteristics and performance features as the SINAMICS S120 CU320 
control unit. The EPOS functionality is provided by the SIMOTION technology functions. The 
functionality of SIMOTION D can be expanded with the distributed I/O via PROFIBUS or with 
the CBE30 Ethernet communication board via PROFINET IO.  
The following figure shows a typical SIMOTION D axis grouping.  

 
Figure 1-1 Example of a SIMOTION D4x5 axis assembly  
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A SIMOTION D axis grouping generally consists of the following elements: 

● SIMOTION D (control unit) (1) 

This unit contains the programmable runtime system of SIMOTION and the drive software 
of SINAMICS S120. In principle, SIMOTION D is capable of controlling multiple 
axes/drives.  

● One SINAMICS infeed (line module) (2) 

This module generates a DC link from the supply system. 

● SINAMICS power units (motor modules) (3) 

These modules are used to control motors. 

It is also possible to operate SINAMICS PM340 power modules with the SINAMICS 
control unit adapter (CUA). A separate infeed is then unnecessary. 

● DRIVE-CLiQ components (4) 

In SINAMICS S120 / SIMOTION D, the individual components of the drive system 
communicate with each other via DRIVE-CLiQ. In addition to power components, 
encoder systems and special DRIVE-CLiQ I/O devices can also be linked via 
DRIVE-CLiQ. 

Extension of the drive computing performance 
The motion control performance of a SIMOTION D4x5 can be utilized in full by expanding 
the computing performance at the drive in two different ways: 

● SINAMICS S110/S120 control units complete with further SINAMICS S110/120 drive 
modules can be connected via PROFIBUS or PROFINET. 

● With SIMOTION D435 and D445/D445-1, the CX32 controller extension can be 
connected via DRIVE-CLiQ. This module is extremely compact and can control up to 
six servo, four vector or eight V/f axes. 

Software components 
The basic functionality of SIMOTION D is supplied on a CompactFlash card containing the 
following:  

The SIMOTION runtime system with the following functions: 

● Freely programmable runtime system (IEC 61131) 

● Various runtime levels (tasks) 

● PLC and arithmetic functionality 

● Motion control functions 

● Communication functions 

The SINAMICS S120 drive control with the following functions: 

● Closed-loop current and torque control 

● Closed-loop speed control 

● Regulated infeed 
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1.2 System components 

Central components 
SIMOTION D4x5 communicates with automation components via the following interfaces:  

● PROFIBUS DP 

● Ethernet 

● PROFINET IO (when using a CBE30) 

● DRIVE-CLiQ (DRIVE Component Link with IQ). 

SIMOTION D features a SINAMICS Integrated drive element. Communication with the 
SINAMICS Integrated is via PROFIBUS mechanisms (DP Integrated). 

The most important components of the system and their functions are shown below. 

Table 1- 1 Central components  

Component Function 
SIMOTION D4x5 controller ... is the central motion control module.  

This module contains the programmable SIMOTION runtime for the 
SIMOTION D4x5 and the SINAMICS S120 drive software. 
You can use the integrated high-speed digital I/Os as: 
 Homing inputs 
 Inputs for measuring inputs 
 User-addressable process inputs/outputs 
 Outputs for fast output cams 
The measuring sockets can output any analog signals. 

System software The basic functionality of SIMOTION D is supplied on a CompactFlash 
card containing the following: 
 SIMOTION runtime (kernel) 
 Drive software of SINAMICS S120 - implements all drive functions 

Power supply ... provides the electronic power supply for SIMOTION D, e.g. via the 
SITOP power supply. 
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PROFIBUS DP  
The control unit can communicate with the following components via the PROFIBUS DP 
interfaces: 

Table 1- 2 Components on PROFIBUS DP 

Component  Function 
Programming device (PG/PC) ... configures, parameterizes, programs, and tests with the 

"SIMOTION SCOUT" engineering system (ES) 
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an 

essential requirement for the operation of a control unit. 
Other controllers (e.g. 
SIMOTION or SIMATIC) 

.. e.g. higher-level controller (plant controller); modular machine 
concepts with multiple controls, distributed across individual machine 
modules 

Distributed I/O systems  
SIMATIC ET 200M  Modular I/O system for control cabinet installation and high channel 

density 
SIMATIC ET 200S Finely scalable I/O system for control cabinet configuration and 

particularly time-critical applications; including motor starters, safety 
technology and individual grouping of load groups 

SIMATIC ET 200pro Modular I/O system with IP65/67 degree of protection for machine-
related applications with no control cabinet; with features such as 
compact designs, integrated PROFIsafe safety technology, 
PROFINET connection and live module replacement. 

SIMATIC ET 200eco I/O system with IP65/67 degree of protection for cabinet-free use 
close to the machine with flexible and fast ECOFAST or M12 
connection methods 

Other PROFIBUS I/O 
Gateways  DP/AS-Interface link 20E and DP/AS-Interface link Advanced for 

the PROFIBUS DP gateway to AS-Interface 
 DP/DP coupler for connecting two PROFIBUS DP networks 

Drive interfaces  ADI4 (Analog Drive Interface for 4 axes) for connection of drives 
with analog ± 10 V setpoint interface or for external encoders 

 IM174 (Interface Module for 4 axes) for connection of drives with 
analog ± 10 V setpoint interface, for external sensors, or for 
connection of stepper drives with pulse-direction interface 

Drive units with 
PROFIBUS DP interface (e.g. 
SINAMICS S120) 

... convert speed setpoints into signals for controlling the motor and 
supply the power required to operate the motors. 
Also can be operated as an isochronous slave on PROFIBUS DP.  

Teleservice adapter Remote diagnostics 
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Ethernet 
The control unit can communicate with the following components via the Ethernet interfaces 
or be embedded in an automation environment: 

Table 1- 3 Components on the Ethernet 

Component  Function 
Programming device (PG/PC) ... configures, parameterizes, programs, and tests with the 

"SIMOTION SCOUT" engineering system (ES) 
Master computer ... communicates with other devices via UDP, TCP/IP 
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an 

essential requirement for the operation of a control unit. 

PROFINET IO 
The use of a Communication Board Ethernet (CBE30) enables SIMOTION D4x5 to 
communicate with the following components via PROFINET IO: 

Table 1- 4 Components on the PROFINET IO 

Component Function  
Programming device (PG/PC) ... configures, sets parameters, programs and tests using the 

"SIMOTION SCOUT" Engineering System (ES). 
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an 

essential requirement for the operation of a control unit. 
Other controllers (e.g. 
SIMOTION or SIMATIC) 

... e.g. higher-level controller (plant controller); modular machine 
concepts with multiple controls, distributed across individual 
machine modules 

Master computer ... communicates with other devices via UDP, TCP/IP. 
Distributed I/O systems 
SIMATIC ET 200M Modular I/O system for control cabinet installation and high 

channel densities. 
SIMATIC ET 200S Finely scalable I/O system for control cabinet installation and 

particularly time-critical applications; including motor starters, 
safety technology and individual grouping of load groups. 

SIMATIC ET 200pro Modular I/O system with IP65/67 degree of protection for machine-
related applications with no control cabinet; with features such as 
compact designs, integrated PROFIsafe safety technology, 
PROFINET IO connection and live module replacement. 

SIMATIC ET 200eco PN Compact block I/O with IP65/66/67 degree of protection for 
cabinet-free usage in machines with M12 connection method. Very 
rugged and resistant encapsulated metal enclosure. 

Other PROFINET IO I/O devices 
Drive units with PROFINET IO 
interface 

... convert speed setpoints into signals for controlling the motor 
and supply the power required to operate the motors. 

Gateways  IE/AS-Interface link PN IO for the PROFINET IO gateway to 
AS-Interface 

 PN/PN coupler for connecting two PROFINET IO networks 
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DRIVE-CLiQ 
The DRIVE-CLiQ interfaces permit a fast connection to the SINAMICS drive components. 

DRIVE-CLiQ offers the following advantages within the DRIVE-CLiQ topology rules:  

● Expandability of components 

● Automatic detection of components by the control unit 

● Standardized interfaces to all components 

● Uniform diagnostics down to the components 

● Complete service down to the components 

● Simple mechanical handling 

The controller can communicate with the following components via DRIVE-CLiQ: 

Table 1- 5 Components connected to DRIVE-CLiQ  

Component Function 
Control unit 
(SINAMICS S110/S120) 

Central control module in which the open- and closed-loop 
control functions for the drive are implemented. 

Line module (SINAMICS S120) ... generates a DC link from the supply system. 
Motor module (SINAMICS S120) ... used to control motors (DC/AC inverters, booksize). 
Power module (SINAMICS 
S110/S120) 

...used to control motors (AC/DC converters, blocksize). 

CX32 controller extension ... enables additional axes to be connected for SIMOTION D435 
and D445/D445-1. 

CUA31/CUA32 control unit 
adapter 

...enables a blocksize power module (PM340) to be connected to 
a booksize control unit D4x5, CX32 or CU320. 

TM31 terminal module ... enables a terminal expansion via DRIVE-CLiQ (additional 
analog and digital I/Os). 

TM41 terminal module ... enables a terminal expansion (analog and digital I/Os) and 
encoder simulation. 

TM54F terminal module ... enables terminal expansion (secure digital inputs/outputs) for 
controlling the secure motion monitoring functions of the 
integrated drives. 

TM15, TM17 High Feature 
terminal module 

The terminal modules TM15 and TM17 High Feature are used to 
implement inputs of measuring inputs and outputs of cam 
outputs. In addition, these terminal modules provide drive-related 
digital inputs and outputs with short signal delay times. 

SMx sensor modules ... enable acquisition of encoder data from connected motors via 
DRIVE-CLiQ. 

Motors with DRIVE-CLiQ 
interface 

...allow simplified commissioning and diagnostics, as the motor 
and encoder type are identified automatically. 

DMC20/DME20 DRIVE-CLiQ hub …enables the number of DRIVE-CLiQ interfaces to be increased 
and the creation of a star-shaped topology. 
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 Note 

You can find detailed information about components in the SINAMICS S110/S120 family of 
products in the SINAMICS S110/S120 manuals. 

 

Optional components  
The functionality of the D4x5 control unit can be expanded by using one of the components 
listed below.  

Table 1- 6 Optional components  

Component Function 
Communication Board Ethernet 
CBE30 

Communication via PROFINET IO with IRT and PROFINET IO 
with RT 

Terminal Board TB30 Terminal expansion, i.e. additional analog and digital I/Os 

The selected component is plugged into the option slot of the control unit.  
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1.3 I/O integration 
 

 Note 

Note that not all modules in the ET 200 I/O family are approved for SIMOTION. Moreover, 
system-related functional differences can come into play when these I/O or I/O systems are 
used on SIMOTION vs. on SIMATIC. For example, special process-control functions (e.g., 
HART modules, etc.) are not supported by SIMOTION for the ET 200M distributed I/O 
system. 

A detailed, regularly updated list of the I/O modules approved for use with SIMOTION, as 
well as notes on their use, can be found on the Internet at 
(http://support.automation.siemens.com/WW/view/en/11886029):  

 

In addition to the I/O modules enabled for SIMOTION, in principle all certified standard 
PROFIBUS slaves (DP-V0/DP-V1/DP-V2) and PROFINET IO devices with RT and IRT real-
time classes may be connected to SIMOTION D4x5. These modules are integrated using the 
GSD file (PROFIBUS) or GSDML file (PROFINET) provided by the relevant device 
manufacturer. 

 

 Note 

Please note that in individual cases further boundary conditions must be fulfilled in order to 
integrate a standard slave/standard device into SIMOTION. Thus, a few modules require 
"driver blocks" , e.g., in the form of function blocks, that permit (or simplify) integration. 

For modules enabled for SIMOTION (e.g. SIMATIC S7-300 module FM 350-1, etc.), these 
driver modules are part of the SIMOTION SCOUT Engineering System command library. 

 

http://support.automation.siemens.com/WW/view/en/11886029�
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1.4 Commissioning software 

Requirement 
To create and edit projects on your PG/PC, you need the SIMOTION SCOUT commissioning 
and configuration tool. For information on how to install SIMOTION SCOUT, refer to the 
SIMOTION SCOUT Configuration Manual.  

 

 Note 

SIMOTION SCOUT contains the functionality of STARTER and SIMATIC S7-Technology.  

Simultaneous operation of SIMOTION SCOUT, STARTER and SIMATIC S7-Technology as 
a single installation on one PC/PG is not possible. 

 

Integrated starter  
You can insert a standalone drive (e.g. SINAMICS S120) with the "Insert single drive unit" 
element in the project navigator. It is commissioned using wizards in the working area of the 
workbench that contains the STARTER functionality.  

SINAMICS Support Package (SSP)  
You can use a SINAMICS Support Package (SSP) to upgrade the version of the drive units 
on a STARTER integrated into SIMOTION SCOUT. 

This permits the use of new functions which only become available with new drive unit FW 
versions.  

In this regard, the following SSPs are relevant for SIMOTION SCOUT: 

● "SINAMICS" SSP for upgrading single drive units (e.g. CU3xx) 

● "SIMOTION SINAMICS Integrated" SSP for upgrading the SINAMICS drives integrated 
into SIMOTION D. 

Detailed installation instructions appear in the Readme files supplied with each each SSP.  

Upgrade SIMOTION D4x5 projects and hardware 
Projects that you have created for one SIMOTION D4x5 firmware version can also be 
converted for other firmware versions. Furthermore, you can amend the version of 
SIMOTION D4x5. For example, a D425 can be converted to a D435 (and vice versa, insofar 
as the performance and quantity structure allow this). For further information, see Section 
Adapting a project (Updating the project / Replacing the SIMOTION controller) (Page 272).  
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IT DIAG 
The SIMOTION D4x5 features an integrated web server.  

The web server supports the display of diagnostics and system data in standard Internet 
browsers, even in the absence of an engineering system, and the carrying out of 
project/firmware updates.  

As of firmware version V4.2, it is no longer necessary to purchase licenses for SIMOTION IT 
DIAG and SIMOTION IT OPC XML-DA. 

Additional references 
For detailed information on working with projects, refer to the SIMOTION SCOUT 
Configuration Manual.  

For detailed information about IT DIAG, see the  
SIMOTION IT Ethernet-based HMI and Diagnostic Functions Diagnostics Manual. 

1.5 Safety notes 
Note the following safety information when working with the control unit and its components.   

 

NOTICE  
The 80 mm clearances above and below the components must be observed. The unit 
protects itself from overheating by shutting down. 

 

CAUTION  
An option board may only be inserted and removed when the control unit and option board 
are disconnected from the power supply. 

The Compact Flash card may only be inserted or removed when the control unit is 
disconnected from the power supply.  

The SIMOTION D4x5 is in a de-energized state when all the LEDs are OFF. 
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Use planning 2
2.1 Shipping and storage conditions 

Shipping and storage conditions 
With regard to transportation and storage conditions, SIMOTION D4x5 surpasses the 
requirements specified in IEC 1131, Part 2. The following conditions apply to modules that 
are transported and stored in the original packaging.  

Conditions 

Table 2- 1 Shipping and storage conditions 

Type of condition Permissible range 
Free fall ≤ 1 m 
Temperature From -40° C to +70° C 
Atmospheric pressure Air pressure in mbar (kPa): 

> 700 mbar (70 kPa) 
< 1060 mbar (106 kPa) 
The specified values correspond to a transport or storage altitude of up 
to 3,000 m. 

Relative humidity 5% to 95%, without condensation 

Shipping backup batteries  
If possible, ship the backup batteries in the original packaging. No special measures are 
required to ship backup batteries used for SIMOTION D. The lithium content of the backup 
battery is less than 0.5 g. 
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Storage of backup batteries 
Always store backup batteries in a cool and dry place. The batteries have a maximum shelf 
life of 10 years. 

 

WARNING  
Risk of injury, material damage, release of hazardous substances. 

Do not throw new or discharged batteries into a fire and do not solder the cell body (max. 
temperature 100° C) and also do not recharge the batteries - there is an explosion hazard! 

Do not open a battery. Replace a faulty battery only with the same type.  

Only use a replacement from Siemens (for order number, see manual). 

Always try to return old batteries to the manufacturer or deliver these to a registered 
recycling company. 

 

 Note 

If you have a spare parts inventory, you must not store a SIMOTION D4x5 with the 
fan/battery module mounted. Only connect the fan/battery module if the fan or battery 
backup voltage is required. 

 

2.2 Mechanical and climatic ambient conditions 

Conditions of use 
SIMOTION D4x5 is designed for use in stationary, weather-protected locations. The 
operating conditions surpass the IEC 1131-2 requirements. 

SIMOTION D4x5 satisfies the operating conditions for Class 3C3 in accordance with DIN EN 
607213-3 (operating locations with high traffic densities and in the immediate vicinity of 
industrial equipment with chemical emissions).   

Use prohibition 
Without additional measures, SIMOTION D4x5 may not be used in 

● Locations with a high percentage of ionizing radiation 

● Locations with extreme operating conditions, e.g. 

– Dust accumulation 

– Corrosive vapors or gases 

● In systems, which require special monitoring, e.g. 

– Elevator installations 

– Electrical installations in highly sensitive areas 
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An additional measure for using SIMOTION D4x5 can, for example, be installation in 
cabinets. 

Mechanical ambient conditions 
SIMOTION D4x5 meets the following standards for mechanical stress:   

● Vibrational load: DIN EN 60721-3-3, Class 3M4 

● Shock load: DIN EN 60721-3-3, Class 3M4 

● Free fall: DIN EN 60721-3-2, Class 2M1 and Class 2M2 

● Toppling: DIN EN 60721-3-2, Class 2M1 

The mechanical ambient conditions for SIMOTION D4x5 are listed in the following table in 
the form of sinusoidal vibrations. 

Table 2- 2 Mechanical ambient conditions 

Frequency range (Hz) continuous infrequent 
10 ≤ f ≤ 58  0.0375 mm amplitude 0.075 mm amplitude 
58 ≤ f ≤ 150  0.5 g constant acceleration 1 g constant acceleration 

Vibration reduction 
If SIMOTION D4x5 is subjected to larger shocks or vibrations, you must use suitable 
measures to reduce the acceleration or the amplitude.   

We recommend installation on shock-absorbing material (e.g. rubber-metal vibration 
dampers). 

Testing mechanical environmental conditions 

Table 2- 3 Mechanical ambient conditions 

Testing Test standard Comments 
Vibrations Vibration testing in 

accordance with IEC 68 
Part 2-6 (sine) severity 
level 12 

Type of vibration: Frequency sweeps at a rate of 
change of 1 octave per minute. 
10 Hz ≤ f ≤ 58 Hz, const. Amplitude 0.075 mm 
58 Hz ≤ f ≤ 500 Hz, const. acceleration 1 g 
Duration of vibration: 10 frequency cycles per axis in 
each of the 3 perpendicular axes 

Shock Shock testing in 
accordance with 
IEC 68 Part 2-27 

Type of shock: half sine 
Severity of shock: 15 g peak value, duration = 11 ms 
Direction of shock: 3 shocks each in +/- direction in 
each of the 3 perpendicular axes 
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Climatic ambient conditions 
SIMOTION D4x5 satisfies the climatic environmental conditions for Class 3K5 in accordance 
with DIN EN 60721-3-3.   

SIMOTION D4X5 may not be used under the following climatic ambient conditions: 

 
Ambient conditions Application range Comments 

The fan/battery module is optional for SIMOTION 
D425 and D435 (Type 6AU1 435-0AA00-0AA1).  
The fan/battery module is required at supply air 
temperatures of 43° C and above for 
SIMOTION D435 (Type 6AU1 435-0AA00-0AA0, 
previous version).  
A fan/battery module is always 
required for SIMOTION D445/D445-1. 

Temperature: Vertical 
mounting position: 

From 0° C to 55° C 

The maximum supply air temperature for all 
modules is 55 °C. 

Relative humidity 5% to 95% Without condensation, corresponds to relative 
humidity (RH) severity level 2 in accordance with 
IEC 1131-2 

Atmospheric pressure 700 hPa to 1060 hPa 3000 m - 0 m above mean sea level 
Pollutant concentration  

SO2: < 0.5 ppm; 
Relative humidity < 60%, no 
condensation 
H2S: < 0.1 ppm; 
Relative humidity < 60%, no 
condensation 

Test: 
10 ppm; 4 days 
 
1 ppm; 4 days 
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2.3 Information on insulation tests, safety class, and degree of 
protection 

Test voltages 
During the routine test, the insulation resistance is tested at the following test voltage in 
accordance with IEC 1131 Part 2: 

Table 2- 4 Test voltages 

Circuits with rated voltage Ue relative to other circuits or 
ground 

Test voltage 

0 V < Ue ≤ 50 V 500 VDC 

Class of protection 
Safety class I in accordance with VDE 0106, Part 1 (IEC 536), i.e. a protective-conductor 
terminal is required on the mounting rail. 

Protection against ingress of solid foreign bodies and water 
Degree of protection IP 20 in accordance with IEC 529, i.e., protection against contact with 
standard probes. 

Also: Protection against ingress of solid foreign bodies with diameters greater than 12.5 mm.  

No special protection against ingress of water. 
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Installing 3
3.1 Installation notes 

Open equipment 
These modules are open equipment. This means they may only be installed in housings, 
cabinets, or in electrical equipment rooms that can only be entered or accessed with a key or 
tool. Housings, cabinets, or electrical equipment rooms may only be accessed by trained or 
authorized personnel. An external fire-protection housing is required. 

 

DANGER  
The equipment must be deenergized when you install the control unit. 

 

3.2 Installing the SIMOTION D4x5 

Requirement     
The control unit is installed in a control cabinet along with the SINAMICS components. 

The following requirements must be met for installing a control unit: 

● The control cabinet has been installed and wired. 

● SINAMICS components should already have been installed and wired (for side 
mounting). 

● Components and tools are available. 

Designs 
The control unit is compatible with the SINAMICS S120 in booksize format. There are two 
possible mounting methods:   

● Side mounting on the SINAMICS S120 line module 

In this type of installation, the control unit is attached to the side panel of the line module 
in the control cabinet. 

● Direct installation on the wall of the control cabinet 

In the case of both designs, the CompactFlash Card and the option slot can be accessed 
from the outside. The fan/battery module can be mounted later. 

Because the Control Unit is similar to the SINAMICS S120 family with regard to installation, 
please follow the instructions in the SINAMICS manuals. 
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Mounting and installation aids 
The Control Unit is designed for mounting in a control cabinet (IP20 degree of protection). All 
versions of SIMOTION D4x5 are supplied with pre-assembled spacers for installation on the 
wall of the control cabinet. The spacers can be removed from the SIMOTION D425, D435, 
and D445-1 if necessary. 

 
Figure 3-1 Mounting aids based on the example of SIMOTION D425 and D435 
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Mounting a SIMOTION D445 
Because a SIMOTION D445 has cooling ribs for heat dissipation on its rear, the spacers 
provided as standard cannot be disassembled.  
The D445 can be mounted on the control cabinet wall using spacers or on the side of the 
SINAMICS assembly using mounting fixtures. 

 

 Note 

SIMOTION D445 can only be operated with a fan/battery module. This module is supplied 
with SIMOTION D445 and has to be mounted first. A description of how to install the 
fan/battery module can be found in the SIMOTION D4x5 Manual (Chapter "Spare 
parts/Accessories", Section "Installing the fan/battery module"). 

 

See also 
Side-mounting of SIMOTION D4x5 on SINAMICS assembly (Page 34) 

Mounting the SIMOTION D4x5 with spacers (Page 35) 

Mounting SIMOTION D425, D435, and D445-1 without spacers (Page 37) 
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3.3 Side-mounting of SIMOTION D4x5 on SINAMICS assembly 
The SIMOTION D425, D435, and D445 Control Units can be mounted on the side wall of a 
SINAMICS S120 Line Module. The mounting fixtures required for this are supplied with the 
SINAMICS S120 Line Module.   

 

 Note 

Assembly on the side of the SINAMICS S120 Line Module using 5 mounting fixtures is not 
possible with SIMOTION D445-1. 

SIMOTION D445-1 must always be screwed to the control cabinet wall. 
 

The SINAMICS S120 Line Module has five mounting fixtures on the left side. To mount the 
control unit, proceed as follows: 

1. Attach the Control Unit to the left side of the SINAMICS S120 Line Module. The mounting 
fixtures fit exactly in the five cutouts on the module. 

2. Push the two units together. 

3. Press down on the module until the unit engages and is securely connected to the 
SINAMICS S120 Line Module. 

The module is connected flush with the SINAMICS assembly on top and in front. 

 
Figure 3-2 SINAMICS assembly with SIMOTION D4x5 
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3.4 Mounting SIMOTION D4x5 on the wall of the control cabinet 

Overview 
If you need to or wish to remove the Line Module, the Control Unit can also be mounted on 
the wall of the control cabinet. Two mounting options are provided for mounting on the wall 
of the control cabinet:   

● Mounting with spacers on the wall of the control cabinet (all D4x5) 

● Mounting without spacers on the wall of the control cabinet (D425/D435/D445-1 only) 

D445-1 next to Line Module   

If you wish to install a SIMOTION D445-1 directly to the left of a Line Module, you will need 
to remove the plastic mounting fixtures from the side wall of the Line Module.  

These mounting fixtures stick out over the side wall of the Line Module.  
SIMOTION D445-1 has a smooth wall (i.e. there are no cut-outs on the side). so can only be 
installed flush next to the Line Module if the mounting fixtures on the Line Module are 
removed.  

Proceed as follows to do this: 

 

   

1. Use suitable tools to lift the latching 
device and push up the holder. 

2. Remove the holder View of the side wall once the holder has 
been removed 

3.4.1 Mounting the SIMOTION D4x5 with spacers 
Spacers enable you to attach the Control Unit to a bare, conductive metallic wall of a control 
cabinet with two M5 or M6 screws.  

Purpose of this type of installation 

This type of mounting is needed if: 

● Multiple Control Units are to be used and, therefore, all Control Units cannot be mounted 
on the side 

● The mounting depth of the SINAMICS S120 booksize assembly is to be achieved 
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The spacers are included in the scope of delivery of a Control Unit and are ready-
assembled.   

Procedure 
1. Mount the spacers on the D425/D435/D445-1 Control Unit, if they have previously been 

removed. 

2. Use two M5 or M6 screws to mount the Control Unit on the wall of the control cabinet. 

 
Figure 3-3 Mounting the control unit with spacers 

Result 
The Control Unit is mounted separately from the SINAMICS booksize components and flush 
with the assembly on the wall of the control cabinet. 
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3.4.2 Mounting SIMOTION D425, D435, and D445-1 without spacers 
The control unit has a metal clip at the top of the rear panel; when shipped, the clip is 
pushed in and secured with three M3 screws (0.8 Nm).   

1. Loosen the screws and push the clip up until the upper hole extends beyond the housing. 

2. Tighten up the three screws on the clip again. 

3. Mount the Control Unit directly on the wall of the control cabinet at the top and bottom 
using two M5 or two M6 screws (6 Nm tightening torque). 

 
Figure 3-4 Mounting the Control Unit on the wall of the control cabinet 

The Control Unit is mounted separately from the SINAMICS booksize components on the 
wall of the control cabinet. 
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3.5 Installing supplementary system components 

3.5.1 Installing the TB30 

Requirement 
 

 Note 

The TB30 terminal board may only be inserted and removed when the D4x5 control unit and 
the terminal board are de-energized. 

 

Procedure 
The TB30 is installed in the option slot of the control unit. 

 
Figure 3-5 TB30 terminal board installation 
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3.5.2 Installing the CBE30 

Requirement  
 

 Note 

The CBE30 communication board Ethernet may only be inserted and removed when the 
D4x5 control unit and the CBE30 are de-energized. 

 

Procedure 
A CBE30 is installed in the option slot of the control unit. 

 
Figure 3-6 Installing the CBE30 
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3.5.3 Installing the CX32 

Overview  
The CX32 can be installed in several ways. 

Mounting the CX32 directly on a line module in booksize format 

 
Figure 3-7 Mounting the CX32 directly on a line module booksize 
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Mounting the CX32 on another CX32 
A description with photos of opening the cover can be found in Section Removing the cover 
of the CX32 (Page 45). 

Table 3- 1 Mounting a CX32 on another CX32 

Opening the covers. Unscrewing the screw. The bracket must be moved so 
that the pin is in the opening of 
the bracket. Tighten the screw. 
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Mounted bracket. Closing the cover.  



 Installing 
 3.5 Installing supplementary system components 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 43 

CX32 directly on a mounting surface 
There are two mounting points on the rear side of the CX32. These can be screwed directly 
to a wall, e.g a control cabinet wall. 

 
Figure 3-8 Mounting the CX32 directly on a mounting surface 
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CX32 with spacers on a mounting surface 
To provide the correct mounting depth for a booksize line-up with internal air cooling, a 
spacer element is pre-assembled on the CX32. The spacer must then be fixed to the 
mounting surface. 

 
Figure 3-9 Mounting a CX32 with spacers  



 Installing 
 3.5 Installing supplementary system components 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 45 

3.5.4 Removing the cover of the CX32 

Actions to remove the cover of the CX32 
The following steps are required to remove the cover - see the following photos: 

- Release 

- Swing open through approx. 45° 

- Remove 

Note that the cover can only be removed when it has been swung open through approx. 45°.  
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Figure 3-10 Opening/removing the protective cover 
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Connection 4
4.1 Complete overview (example) 

Overview 
The SIMOTION D4x5 has a number of interfaces that can be used for connecting the power 
supply and for communication with the other components of the system. To make these 
connections, the front cover of the SIMOTION D4x5 must be opened. 

● The different SINAMICS components are interconnected via DRIVE-CLiQ. 

● Actuators and sensors can be connected to the digital inputs/outputs. 

● For communication purposes, the SIMOTION D4x5 can be connected to PROFIBUS DP, 
PROFINET IO with IRT/RT, MPI, and Ethernet. 
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Overview of connections 
The following overview shows examples of the various interfaces and their connection 
possibilities.  

 
Figure 4-1 Connection possibilities for SIMOTION D4x5 
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4.2 Safety information for wiring 

Requirement 
Once you have mounted the control unit in the control cabinet, you can begin wiring the 
assembly. 

 

 Note 

Safety functions, reliability, and EMC are guaranteed only with original SIEMENS cables. 
 

Note the following safety information: 
 

DANGER  
The equipment must be deenergized when you wire the control unit. 

 

Equipotential bonding 
The SIMOTION D4x5 is designed for use in cabinets with a PE conductor connection.  

If the drive line-up is arranged on a common, bare metallic mounting plate (e.g. with a 
galvanized surface), no additional equipotential bonding is needed within the drive line-up.  

If the drive components are located in different cabinets, you have to ensure equipotential 
bonding.  

If, for example, data cables (PROFIBUS, PROFINET, Ethernet or DRIVE-CLiQ) are routed 
through several control cabinets, the "potential connection" of the SIMOTION D4x5 should 
be connected to the equipotential bonding conductor. 

Use a finely stranded copper conductor with 4 mm² cross section and lay it together with the 
PROFIBUS/PROFINET/Ethernet or DRIVE-CLiQ connecting cable.  

The "potential connection" is located below the mode switch on the front of the 
SIMOTION D4x5. See also the SIMOTION D4x5 Manual. 



Connection  
4.3 Opening the front cover 

 SIMOTION D4x5 
50 Commissioning and Hardware Installation Manual, 11/2010 

4.3 Opening the front cover 

Introduction 
The interfaces on the front side of the D4x5 and the CX32 have a cover. This is opened by 
swinging the front cover down; the interface connections are then accessible and can be 
wired. For the opening procedure, see also the photos in Section Removing the cover of the 
CX32 (Page 45). 

A hinge connects the front cover to the front of the housing. Once opened, the cover can be 
removed. The front cover is closed by swinging it up; it automatically locks by means of a 
hook at the top of the device housing. 

Procedure for D4x5 and CX32 
1. Unlatch the release hook on the inside of the front cover (see the following figure). 

2. Remove the front cover with a forward motion. 

 

 
Figure 4-2 D4x5 with cover, figure similar for CX32  

 

 Note 

All cables must be routed vertically upwards to the fullest extent possible so that the front 
cover can be closed. The front cover has an outlet for the upward routing of these cables. 
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4.4 Power supply 

4.4.1 Safety rules 

Basic rules 
Because of the wide range of possible applications, only the basic rules for electrical 
installation can be included in this section. At a minimum, you must comply with these basic 
rules to ensure problem-free operation. 

Rules for safe operation 
In order to ensure safe operation of your equipment, implement the following measures, 
adapting them to suit your conditions:  

● An EMERGENCY STOP strategy in accordance with the generally accepted rules of 
current engineering practice (e.g. European Standards EN 60204, EN 418 and similar).  

● Additional measures for end position limiting of axes (e.g. hardware limit switches). 

● Equipment and measures for protection of motors and power electronics in accordance 
with the SINAMICS installation guidelines. 

In order to identify hazards, we also recommend that a risk analysis be conducted on the 
entire system in accordance with the basic safety requirements set out in Appendix 1 of 
the EU machinery directive. 

Additional references 
● Guidelines on Handling Electrostatically Sensitive Devices (ESD), see Appendix. 

● For configuring a system with SIMATIC ET 200 I/O (e.g. ET 200S, ET 200M, ...), refer to 
the manuals for the relevant ET 200 I/O system. 

● For further information on EMC guidelines, we recommend the publication: EMC 
Installation Guide, Configuration Manual (HW), order no.: 6FC5 297-0AD30-0AP2.  
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4.4.2 Standards and Regulations 

VDE guideline compliance 
During wiring, you must observe the appropriate VDE guidelines, in particular VDE 0100 and 
VDE 0113 for tripping devices and short-circuit and overload protection. 

System startup after certain events: 

The following list identifies considerations required for startup of a system following certain 
events. 

● If the system starts up again following a voltage drop or power failure, all hazardous 
operating states must be prevented from occurring. If necessary, force an EMERGENCY 
OFF. 

● If the system starts up again after the EMERGENCY OFF apparatus is released, the 
startup must not be unchecked or undefined. 

4.4.3 Mains voltage 

Rules for the line voltage 
The following list indicates what you must take into account for the line voltage: 

● For stationary installations or systems that do not have all-pole line disconnect switches, 
the building installation must include a line disconnect switch or a fuse. 

● For load power supplies and power supply modules, the rated voltage range set must 
correspond to the local line voltage. 

● For all circuits, the fluctuation/deviation of the line voltage from the rated value must be 
within the permitted tolerance (see the technical data for the SIMOTION D and 
SINAMICS modules).  

24 V DC supply 
 
For... Requirement 
Buildings External lightning 

protection 
Install lightning protection (e.g. 
lightning conductors). 

24 V DC supply lines, signal lines Internal lightning 
protection 

 

24 V supply safe (electrical) isolation of the extra-low voltage  
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Protection against external electrical phenomena 
The table below shows how you must protect your system against electrical interference or 
faults.   

Table 4- 1 External electrical phenomena 

For ... Requirement 
All plant or systems in which the 
component is installed 

The plant or system is connected to a protective 
conductor for the discharge of electromagnetic 
interference. 

Supply, signal, and bus lines The wiring arrangement and installation complies with 
EMC regulations.  

Signal and bus lines A cable or wire break cannot lead to undefined states in 
the plant or system. 

4.4.4 Connecting the power supply 

Wiring the screw terminal block 
The required 24 VDC load power supply is connected at the screw-type terminal block.  

 

DANGER  
The 24 VDC should be configured as functional extra-low voltage with safe isolation. 

 

Supply system lines 
Use flexible cables with a cross section of 0.25 to 2.5 mm2 (or AWG 23 to AWG 13) for wiring 
the power supply. 

If you only use one wire per connection, a ferrule is not required. 

You can use ferrules without an insulating collar in accordance with DIN 46228, Form A long 
version. 

Pin assignments 
For the pin assignment of the screw-type terminal block, see the SIMOTION D4x5 Manual. 
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4.5 Connecting DRIVE-CLiQ components 

4.5.1 DRIVE-CLiQ wiring 

Introduction 
The components of the SINAMICS S120 drive family and the SIMOTION D4x5 with CX32 
are wired together by means of DRIVE-CLiQ. DRIVE-CLiQ is a communication system that 
enables SIMOTION D4x5 to detect the connected components automatically. It provides a 
wiring tree whose topology can be visualized in SIMOTION SCOUT.  

 

 Note 

For information on the number of DRIVE-CLiQ interfaces and their properties, refer to the 
SIMOTION D4x5 Manual. 

 

Rules for wiring DRIVE-CLiQ 
The following rules must be followed for wiring DRIVE-CLiQ: 

● Ring wiring is not permitted 

● Components must not be double-wired 

● For a motor module, the power line for the motor and the associated motor encoder must 
be connected.  

You will find detailed information about DRIVE-CLiQ wiring in the SINAMICS S120 Control 
Units and Additional System Components Manual. 



 Connection 
 4.5 Connecting DRIVE-CLiQ components 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 55 

Example 
The example shown in this diagram shows the rules for DRIVE-CLiQ wiring. 

 
Figure 4-3 DRIVE-CLiQ wiring (example) 
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4.5.2 Connectable DRIVE-CLiQ components 

Components 
As a general principle, all SINAMICS components approved for SIMOTION D can be 
connected directly to SIMOTION D or another DRIVE-CLiQ component using the 
DRIVE-CLiQ interface.  

Table 4- 2 DRIVE-CLiQ  

Component Description 
CX32 controller extension The CX32 supports scaling of the drive-side computing performance of 

the SIMOTION D435 and D445/D445-1. Each CX32 can operate up to 
six additional servo, four vector or eight V/f axes. 

Line modules Line modules (e.g. active line modules) provide the DC link voltage and 
can be connected via DRIVE-CLiQ depending on the module type.  

Motor modules Motor modules are used to control motors. SMC modules for 
processing encoder signals, for example, can be connected to motor 
modules. 

Motors with DRIVE-CLiQ 
interface 

Motors with a DRIVE-CLiQ interface allow simplified commissioning 
and diagnostics, because the motor and encoder type are identified 
automatically. 

SMx modules SMx sensor modules allow the acquisition of encoder data from the 
connected motors via DRIVE-CLiQ. 

TM15 and TM17 High 
Feature terminal modules 

The TM15 and TM17 High Feature terminal modules are used to 
implement measuring input inputs and cam outputs. In addition, these 
terminal modules provide drive-related digital inputs and outputs with 
short signal delay times. 
 TM15: 24 isolated bidirectional DI/DO, with sensor and cam 

functionality 
 TM17 High Feature: 16 non-floating, bidirectional DI/DO with sensor 

and cam functionality for the highest demands with respect to 
resolution, accuracy and short input delay times. 

TM31 terminal module TM31 provides 8 DI, 4 bidirectional DI/DO, 2 relay outputs, 2 AI, 2 AO 
and 1 temperature sensor input (KTY84-130 or PTC). 

TM41 terminal module TM41 provides 4 DI, 4 bidirectional DI/DO, 1 AI and 1 TTL encoder 
output. 

TM54F terminal module TM54F provides the following interfaces: 4 fail-safe DO (F-DO), 10 fail-
safe DI (F-DI), 2 sensor power supplies with dynamic capability, 1 
sensor power supply without dynamic capability and 4 DI to check the 
F-DO during a test stop. 



 Connection 
 4.5 Connecting DRIVE-CLiQ components 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 57 

Component Description 
DMC20/DME20 DRIVE-CLiQ hubs provide 4 more DRIVE-CLiQ interfaces. They can be 

used, for example, to establish star topologies. 
 DMC20 is the hub for the control cabinet configuration 
 DME20 is the hub for use without a control cabinet (IP67 degree of 

protection) 

SINAMICS S120 power 
module  
(with CUA31/CUA32) 

An AC DRIVE PM340 power module can be connected using the 
CUA31/CUA32 control unit adapter. 
You will find more information on the CUA31/CUA32 in the 
SINAMICS S120 AC Drive Manual. 

Example of axis assembly 
The following figure shows a possible DRIVE-CLiQ wiring scheme for an axis grouping. 

 
Figure 4-4 Axis assembly with DRIVE-CLiQ 
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4.5.3 Connecting CX32 

Installation/Mounting/Wiring 
Information on installing, mounting and wiring the CX32 can be found in the SIMOTION 
D4x5 Manual. 
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CX32 DRIVE-CLiQ topology 
Unlike other DRIVE-CLiQ components (e.g. terminal modules), special rules apply when 
wiring the CX32. 

● Only a star topology is possible between the CX32 and SIMOTION D. Each CX32 needs 
its own DRIVE-CLiQ port on the SIMOTION D control unit. 

● When a CX32 is inserted in an existing DRIVE-CLiQ connection (destination port for 
CX32 is occupied by, for example, a TM31), this connection is disconnected and replaced 
by the CX32 connection. The component that is freed up is moved to the component 
archive of the SINAMICS topology overview. A notice is displayed indicating that the 
component has been moved to the archive. The components must then be reassigned. 

● A CX32 is inserted via HW Config (see Configuring a CX32 (Page 174)). Here, the 
selection made for the PROFIBUS address automatically and permanently assigns the 
DRIVE-CLiQ port for connecting the CX32. Given that this assignment is permanent, the 
following points must be noted: 

– A connected and configured CX32 cannot be connected to another DRIVE-CLiQ port 
without taking additional measures. Reconnecting a CX32 results in a discrepancy 
between the specified and actual topologies of the DRIVE-CLiQ components. 

– A cross-exchange of two occupied DRIVE-CLiQ ports is not permissible. Such an 
exchange results in inconsistencies in the specified-actual topologies. 

– Once it has been created in HW Config, the connecting port of a CX32 cannot be 
changed. 

– In order to change the connecting port of a CX32, the CX32 must be deleted from HW 
Config and recreated with another address. 

– In order to delete a CX32, it must be deleted from HW Config before the configuration 
can be saved and compiled. 

– It is not possible to replace a D445/D445-1 module with a D435 if a CX32 has been 
configured with the address 14 or 15 (since a D435 does not have DRIVE-CLiQ ports 
X104/X105, it does not have addresses 14 and 15). 

  Note 
Connection possibility 

A CX32 can only be connected to and operated on a SIMOTION D445/D445-1 or 
D435.  
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Figure 4-5 CX32 topology 

Drive quantity structures 
If one or more CX32 modules are being used on a SIMOTION D435 or D445/D445-1, the 
number of drives that can be used on the SINAMICS Integrated is reduced by one. This 
results in the following quantity structures: 

SIMOTION V4.1 and V4.2/SINAMICS V2.5 and 2.6 

Table 4- 3 Quantity structure SIMOTION V4.1 and V4.2/SINAMICS V2.5 and 2.6 

 SINAMICS 
Integrated 

1. CX32 2. CX32 3. CX32 4. CX32 

SERVO D435 5+1 (5 drives + 1 
ALM 1)) 

6+1 6+1 --- --- 

SERVO 
D445/D445-1 

5+1 6+1 6+1 6+1 6+1 

VECTOR D435 3+1 4+1 4+1 --- --- 
VECTOR 
D445/D445-1 

3+1 4+1 4+1 4+1 4+1 

1) ALM = Active Line Modules; Basic Line Modules (BLM), and Smart Line Modules (SLM) 
can also be used. 
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SIMOTION V4.0 HF2/SINAMICS V2.4 

Table 4- 4 Quantity structure for SIMOTION V4.0 HF2/SINAMICS V2.4 

 SINAMICS 
Integrated 

1. CX32 2. CX32 3. CX32 4. CX32 

SERVO D435 5+1 (5 drives + 1 
ALM 1)) 

6+0 6+0 --- --- 

SERVO D445 5+1 6+0 6+0 6+0 --- 
VECTOR D435 3+1 4+0 4+0 --- --- 
VECTOR D445 3+1 4+0 4+0 4+0 --- 

1) ALM = Active Line Modules; Basic Line Modules (BLM), and Smart Line Modules (SLM) 
can also be used. 

 

 Note 
Mixed operation of servo and vector-controlled drives 

Mixed operation of servo and vector-controlled drives is not possible on a CX32. Therefore, 
drives on a CX32 must be operated in servo or in vector mode only. As with the SIMOTION 
D4x5, mixed operation of servo-controlled and V/f-controlled drives is possible on a CX32. 

V/f-controlled drives 

A maximum of eight V/f-controlled drives are supported by each CX32. 
 

SIZER 
The SIZER configuration tool makes it easy to configure the SINAMICS S120 drive family, 
including SIMOTION. 

It provides you with support for selecting and dimensioning the components required for a 
Motion Control task. 

Additional references 
Further information on the CX32 can be found in the SIMOTION D4x5 Manual. 
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4.6 Connecting inputs/outputs 

Connecting cables for the inputs and outputs of the D4x5, CX32 and TB30 
The following conditions apply to connecting cables:  

● Use flexible cables with a cable cross-section of at least 0.25 mm2 and maximum 
0.5 mm2 

● Ferrules are not required 

● You can use ferrules without an insulating collar in accordance with DIN 46228, Form A 
long version 

● You can connect two cables each with a cross section of 0.25 mm2 in one ferrule 

  Note 

To achieve optimum interference immunity, shielded cables must be used for connecting 
analog signals, measuring inputs or external zero marks. 

Tools required 
Screwdriver with 2 mm blade width. 

Wiring inputs/outputs 
1. Strip off 8 to 9 mm of cable insulation and, if necessary, press on a ferrule. 

2. Wire the digital inputs of the interface for connection of the sensors. 

3. Wire the digital outputs of the interface for connection of the actuators. 

4. Insert the cable into the appropriate spring-loaded terminal. This is easier when you use 
the screwdriver to push back the spring.  

Pin assignment 
For detailed information about the pin assignment of the X122/X132 interfaces of the D4x5, 
refer to Section "Interfaces" in the SIMOTION D4x5 Manual. Pin assignments for the digital 
inputs/outputs of the CX32 and TB30 can be found in the same manual in Section 
"Supplementary system components".  
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4.6.1 Creating a shield connection 

Using shielded cables 
The following options are available for the shield connection when using shielded cables: 

● A shield connection using a shielding bus supplied separately 

● Shield connection via shield connecting element on the top of the SIMOTION D4x5 
housing 

Using a shielding bus 

If a shielding bus is used, proceed as follows: 

1. Attach the cable shield to a grounded shielding bus after the cable entry point in the 
cabinet. Strip the insulation off the cable first. 

2. Continue routing the shielded cable as far as the module but do not make a connection to 
the shield there. 

Using a shield connection on the D4x5 

1. Remove the fixing bracket on the top of the D4x5. 

2. Insert the cable. Please strip the insulation off the cable first. 

3. Tighten the fixing bracket so that the cable shield and cable are pressed against the 
device housing by the fixing bracket. 

This figure shows where to attach the cables to the front panel connector and where to apply 
the cable interference suppression using the shield connecting element.  

 
Figure 4-6 D4x5 shield connection 
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4.6.2 Connecting inputs/outputs of the TB30 

Pin assignment 

 
Figure 4-7 Interface arrangement on the TB30 

For detailed information about the pin assignment of the X424, X481 and X482 interfaces, 
refer to Section "Interfaces" in the SIMOTION D4x5 Manual. 
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Shield connection on the D4x5 control unit 
The following figure shows the cable routing, cable connection and the connection of the 
analog inputs/outputs on the TB30. The plug connector above is used accordingly for the 
connection of the digital inputs/outputs. 

 
Figure 4-8 TB30 shield connection  

The permissible bending radii for the cables must be maintained when the cables are being 
laid. 
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4.7 Connecting PROFIBUS/MPI 

4.7.1 PROFIBUS connection components 

Connection components 
Individual nodes are connected via bus connectors and PROFIBUS cables. Remember to 
provide a bus connector with a programming port at the ends of the subnet. This will give 
you the option of expanding the subnet if required, for example, for a programming device or 
SIMATIC HMI device.  

Use RS 485 repeaters for the connection between segments and to extend the cable. 

Segments 
A segment is a bus cable between two terminating resistors. A segment can contain up to 32 
nodes. In addition, a segment is limited by the permissible cable length, which varies 
according to the transmission rate.  

Terminating resistor 
A cable must be terminated with its own surge impedance to prevent line disturbances 
caused by reflections. Activate the terminating resistor at the first and last node of a subnet 
or segment. 

Make sure that the nodes to which the terminating resistor is connected are always supplied 
with voltage during power-up and operation.  
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4.7.2 PROFIBUS cables and connectors 

Properties of PROFIBUS cables 
The PROFIBUS cable is a two-core, twisted and shielded cable with defined properties:  

Cable properties 

Table 4- 5 Properties of PROFIBUS cables 

Characteristics Values 
Wave impedance Approximately 135 to 160 Ω (f = 3 to 20 MHz) 
Loop resistance ≤ 115 Ω/km 
Effective capacitance  30 nF/km 
Damping 0.9 dB/100 m (f = 200 kHz) 
Permissible conductor cross section 0.3 mm2 to 0.5 mm2 
Permissible cable diameter 8 mm + 0.5 mm 

Connector features 
The bus connector is used to connect the PROFIBUS cable to the PROFIBUS DP interfaces 
(X126, X136), thus establishing a connection to additional nodes.  

Only bus connectors with a 35° cable outlet should be used in order to ensure that the front 
cover can be closed. 

See also 
Manual SIMOTION D4x5, Chapter "Spare parts and accessories which can be ordered" 

4.7.3 PROFIBUS cable lengths 

Cable lengths and baud rate 
The baud rate determines the cable length of a subnet segment.    

Table 4- 6 Permitted cable length of a subnet segment for specific baud rates 

Baud rate Max. cable length of a segment (in m) 
19.6 to 187.5 kbit/s 10001) 
500 kbit/s 400 
1.5 Mbit/s 200 
3 to 12 Mbit/s 100 

1) With isolated interface 



Connection  
4.7 Connecting PROFIBUS/MPI 

 SIMOTION D4x5 
68 Commissioning and Hardware Installation Manual, 11/2010 

Greater cable lengths 
If you must realize greater cable lengths than permitted in one segment, you must use 
RS 485 repeaters. The maximum possible cable lengths between two RS 485 repeaters 
correspond to the cable length of a segment. You can connect up to 9 RS 485 repeaters in 
series. 

Note that an RS 485 repeater must be counted as a subnet node when determining the total 
number of nodes to be connected. This is true even if the RS 485 repeater is not assigned its 
own PROFIBUS address. 

4.7.4 Rules for the laying of PROFIBUS cables 

Routing bus cables 
When routing the PROFIBUS cable, you must avoid:   

● Twisting 

● Stretch the bus cable 

● Squeezing 

Boundary conditions 
In addition, when routing a bus cable for indoor use, you must take into account the following 
boundary conditions (dA = external cable diameter): 

Table 4- 7 Boundary conditions for routing of PROFIBUS cables 

Characteristics Boundary conditions 
Bending radius for a single bend 80 mm (10xdA) 
Bending radius for multiple bends 160 mm (20xdA) 
Permissible temperature range for cable routing -5° C to +50° C 
Temperature range for storage and stationary operation -30° C to +65° C 

Additional references 
Length codes for prefabricated cables can be found in: 

● Catalog PM 21; SIMOTION, SINAMICS S120, and Motors for Production Machines 

● Catalog IK PI (Industrial Communication) 

4.7.5 Connecting PROFIBUS DP (interfaces X126 and X136) 
PROFIBUS cables are connected to the corresponding interface via a bus connector.  
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Connecting the bus connector 
Proceed as follows to connect the bus connector:  

1. Plug the bus connector into the corresponding interface of the control unit. 

2. Screw the bus connector into place. 

If the control unit is located at the start or end of a segment, you must switch on the 
terminating resistor ("ON" switch setting). 

 
Figure 4-9 Terminating resistor switched on and off 

  Note 

Make sure that the nodes at which the terminating resistor is located are always supplied 
with voltage during startup and operation. 

Removing the bus connector 
You can remove the bus connector with a looped-through bus cable from the PROFIBUS DP 
interface at any time without interrupting data traffic on the bus.  

 

WARNING  
Data traffic error might occur on the bus! 

A bus segment must always be terminated at both ends with the terminating resistor. This 
is not the case, for example, if the last node with a bus connector is de-energized. The bus 
connector draws its power from the node, and the terminating resistor is thus disabled. 

Make sure that power is always supplied to nodes on which the terminating resistor is 
active. 

 

4.7.6 Connection rules in the PROFIBUS subnet 

Introduction 
There are a number of rules for configuring and installing cables for PROFIBUS networks to 
ensure seamless communication over PROFIBUS. These rules apply to both configuring and 
cabling as well as address assignment for the different network nodes. 
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Connection rules 
● Before you interconnect individual nodes in a subnet, you must assign a unique 

PROFIBUS address to each node.  

● Narrow down the number of nodes by limiting the PROFIBUS addresses to the highest 
address in the network. 

Tip: Mark the address on the housing of all nodes in a subnet. Then you can always see 
which address is assigned to which node in your system.  

● Connect all nodes in a subnet "in a series". No spur lines may be routed to the 
PROFIBUS DP. 

In addition, integrate the programming devices and SIMATIC HMI devices for 
commissioning or servicing in the subnet in series. 

● If you operate more than 32 nodes on a subnet, you must use RS 485 repeaters to 
connect the bus segments. More detailed information can be found in the description of 
the RS 485 repeater, see the S7-300 Automation Systems, Module Data Manual. 

In a PROFIBUS subnet, all segments combined must have at least one DP master and 
one DP slave. 

● Use RS 485 repeaters to connect ungrounded bus segments and grounded bus 
segments. 

● The maximum number of nodes per bus segment decreases with each RS 485 repeater. 
That is, if a bus segment contains one RS 485 repeater, the bus segment can contain no 
more than 31 additional nodes. However, the number of RS 485 repeaters does not affect 
the maximum number of nodes on the bus. 

● Up to 10 segments can be connected in a row (max. 9 repeaters). 

● At least one terminator must be supplied with 5 V. 

To accomplish this, the PROFIBUS DP connector with an activated terminating resistor 
must be connected to a device that is switched on. 

● Before inserting a new node on the subnet, you must switch off its supply voltage. 

The station must be inserted first and then switched on. 

When a station is disconnected, the connection must first be deactivated and then the 
connector withdrawn. 

● The bus line of a segment must be terminated at both ends. This is achieved by switching 
on the terminating resistor in the PROFIBUS DP connector at the first and last node and 
switching off the other terminating resistors. 
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Example 
This illustration below shows an example configuration of a subnet with D435. 

A

S A/SS

S A/M M

 
Figure 4-10 Networking example for a D435 

4.7.7 Operating the X136 interface as MPI 

Applications 
The X136 interface can also be operated as an MPI interface instead of a PROFIBUS DP 
interface. The typical (default) baud rate is 187.5 Kbaud. A baud rate of up to 12 MBaud can 
be set for communication with other CPUs. It should be noted, however, that a rate of 
12 MBaud is not supported by all CPUs (e.g. smaller SIMATIC S7 CPUs). 

The following list provides examples of when using MPI (multi-point interface) may prove 
effective: 

● If a PC/PG is being used with an MPI interface 

● If an OP/TP only has an MPI interface 
(newer devices have PROFIBUS or PROFINET interfaces) 

● If SIMOTION and SIMATIC CPUs are coupled via XSEND/XRECEIVE 
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When communicating with XSEND/XRECEIVE, there is no need to configure the connection 
in NetPro. XSEND/XRECEIVE can be used via PROFIBUS or MPI. 

● Via PROFIBUS: For communication between SIMOTION devices 

● Via MPI: For communication between SIMOTION and SIMATIC S7 devices 

The SIMOTION interface must be connected to the MPI interface of the SIMATIC S7 
devices. Connection via PROFIBUS is not possible. 

The baud rate of the SIMATIC S7 device must be set at the SIMOTION interface (see 
documentation for the relevant SIMATIC S7 devices). 

Operate MPI like PROFIBUS 
The information on wiring the connector (terminating resistors) and the rules for routing of 
cables for PROFIBUS apply to this interface as well. When carrying out this procedure, 
consult the relevant references. 

Connector features 
The bus connector is used to connect the MPI bus cable to the MPI interface (X136). This 
enables you to establish connections to additional nodes (e.g. PG or SIMATIC S7-CPU). 
Only bus connectors with a 35° cable outlet should be used in order to ensure that the front 
cover can be closed.    

Additional information 
See SIMOTION D4x5 Manual, Chapter "Spare parts and accessories which can be ordered" 

MPI bus cable 
The PROFIBUS cable specifications apply here as well;  

Please note the relevant information on setting up an MPI network. 

Setting up an MPI network 
Keep in mind the following basic rules when setting up an MPI network:   

● When using the interface as an MPI interface, it is not possible to arrange additional 
control for a drive in isochronous mode or to connect distributed I/Os to this interface. 

● An MPI bus line must be terminated at both ends. This is achieved by activating the 
terminating resistor in the MPI connector in the first and last station and deactivating the 
other terminating resistors. 

● At least one terminator must be supplied with 5 V. 

This means that an MPI connector with an activated terminating resistor must be 
connected to a device that is switched on. 

● Spur lines (cables leading from the bus segment to the station) should be as short as 
possible, that is, < 5 m in length. Unused spur lines should be removed wherever 
possible. 
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● Every MPI station must be connected to the bus first and then activated. 

To disconnect the station, it must first be deactivated. Then, the station can be removed 
from the bus. 

● Maximum cable lengths: 

– 200 m per bus segment 

– 2000 m total length with RS 485 repeaters 

 

 Note 

You can also use intelligent DP slave functionality for PROFIBUS communication between 
CPUs. 

 

See also 
PROFIBUS cables and connectors (Page 67) 

PROFIBUS cable lengths (Page 67) 

4.8 Connecting PROFINET IO components 

4.8.1 Wiring PROFINET 

Procedure 
PROFINET IO is only possible on a SIMOTION D4x5 in conjunction with a CBE30 
(Communication Board Ethernet). PROFINET IO components can then be connected via the 
four ports of the X1400 interfaces of the CBE30. You must use suitable PROFINET cables 
and connectors for this purpose.   

The autocrossing functionality of the CBE30 means both crossed and uncrossed cables can 
be used. 

 
Figure 4-11 Connections on the CBE30  
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Mixed operation of IRT and RT 

For mixed operation of IRT and RT, note that the IRT-compatible devices must form a so-
called IRT domain, i.e., there must not be any non-IRT devices on the data transmission link 
between the IRT devices. 

 

4.8.2 PROFINET cable 

Cable and connector types  
 

 Note 

For connecting PROFINET IO to CBE30 it is recommended using a connector with a 145° 
cable outlet (IE FC RJ45 plug 145). 

 

 
Figure 4-12 RJ45 PN connector with a 145°cable outlet 
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Table 4- 8 Connector types for PROFINET  

Connectors Designation Order No. 
IE FC RJ-45 Plug 145 RJ45 FastConnect connector for 

Industrial Ethernet/PROFINET with 145° 
cable outlet 
 1 package = 1 unit 
 1 package = 10 units 

 
 
 
6GK1 901-1BB30-0AA0 
6GK1 901-1BB30-0AB0 

 

Table 4- 9 Cable types for PROFINET 

Cable Designation Order No. 
IE FC Cable GP 2 (Type A) 4-wire, shielded TP installation cable for 

IE FC RJ45 
6XV1 840-2AH10 

IE FC Flexible Cable GP 2 
(Type B) 

4-wire, shielded flexible TP installation 
cable for IE FC RJ45 

6XV1 870-2B 

IE FC Trailing Cable GP 2x2 
(Type C) 

4-wire TP installation cable for trailing 
cable use  

6XV1 870-2D 

IE FC Trailing Cable 2x2  
(Type C) 

4-wire, shielded TP installation cable for 
connection to FC OUTLET RJ45, for 
trailing cable use  

6XV1 840-3AH10 

IE FC Marine Cable 2x2 4-wire, shielded marine-certified TP 
installation cable for connection to 
FC OUTLET RJ45 

6XV1 840-4AH10 

 

Table 4- 10 Stripping tool for Industrial Ethernet/PROFINET 

Tools Designation Order No. 
IE FC stripping tool Stripping tool for Industrial 

Ethernet/PROFINET 
6GK1 901-1GA00 

 
 

 Note 

For a description of how to connect the connector to the cable, please refer to the 
information on the respective connector in the Industrial Communication Catalog (IK PI 
Catalog). You can also order cables and connectors there. 
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4.9 Routing 
Routing describes the cross-network transfer of information from Network x to Network y. 

 

4.9.1 Routing on SIMOTION D 

Routing between the different interfaces 
The two standard Ethernet interfaces on SIMOTION D4x5 - X120 and X130 - each form a 
separate subnet; all ports on the CBE30 also form a common subnet. 

● Routing from subnet to subnet (IP routing) is not supported. You can use an external IP 
router for this. 

● S7 routing from a PROFINET/Ethernet subnet to PROFIBUS is possible. 

There are two options for connecting a PG/PC or HMI to a SIMOTION D with CBE30 using 
S7 routing. 
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Engineering system / HMI to PROFINET (CBE30) 

 
Figure 4-13 Example for PG/PC to CBE30 

● S7 routing to the (master) PROFIBUS interfaces (only if configured) 

● S7 routing to the PROFIBUS Integrated 

● S7 routing to the standard Ethernet interfaces ET1/ET2 (X120, X130) (as of V.4.1 SP2) 

● Access to the components on the same subnet (CBE30) via the switch functionality 
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Engineering system / HMI to PROFIBUS 

 
Figure 4-14 Example for PG/PC to PROFIBUS 

● S7 routing to the other (master) PROFIBUS interfaces (only if configured) 

● S7 routing to the PROFIBUS Integrated 

● S7 routing to X1400 on the CBE30 

● S7 routing to the standard Ethernet interfaces (X120, X130) (as of V.4.1 SP2) 
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Engineering system / HMI to Ethernet 

 
Figure 4-15 Example for PG/PC to Ethernet X120, X130 

● S7 routing to the other (master) PROFIBUS interfaces (only if configured) 

● S7 routing to the PROFIBUS Integrated 

● S7 routing to X1400 on the CBE30 (as of V4.1 SP2) 

● S7 routing between the Ethernet interfaces 

4.9.2 Routing on SIMOTION D (SINAMICS integrated) 

S7 routing to the internal PROFIBUS on SINAMICS Integrated 
All SIMOTION D have an integrated SINAMICS drive control. In order to be able to access 
drive parameters, the message frames must be routed from the external SIMOTION D 
interfaces to the internal PROFIBUS DP. S7 routing can be used to access the integrated 
PROFIBUS. Here, the internal PROFIBUS DP forms a separate subnet. This must be 
especially taken into account for the communication to several routing nodes.  

Additional references 

Further information about routing and the differences between IP and S7 routing can be 
found in the Communication System Manual. 
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4.10 Connecting Ethernet 

4.10.1 Wiring Ethernet 

Procedure 
An Industrial Ethernet can be connected to the 8-pin RJ45 sockets X120 and X130. 

The interfaces support a transmission rate of 10/100 Mbit/s. Suitable Ethernet cables and 
connectors must be used for the Ethernet connection.  

 
Figure 4-16 Connecting Industrial Ethernet 

4.10.2 Ethernet cables and connectors 

Characteristics of the cables 
A shielded twisted pair cable is used for the networking. 



 Connection 
 4.10 Connecting Ethernet 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 81 

Recommended connecting cables 
The following cables are available: 

● SIMATIC NET, Industrial Ethernet TP XP CORD RJ45/RJ45 

– TP cable prefabricated with 2xRJ45 connectors 

– Crossed send and receive cable 

– Order no.: 6XV1870-3R⃞⃞⃞ (⃞⃞⃞ - length code) 

● SIMATIC NET, Industrial Ethernet TP CORD RJ45/RJ45 

– TP cable prefabricated with 2xRJ45 connectors 

– Uncrossed send and receive cable 

– Order No.: 6XV1870-3Q⃞⃞⃞ (⃞⃞⃞ - length code) 

Devices with Ethernet interfaces can have various pin assignments.  

In the case of terminal devices, for example, the send line may be on pins 1 and 2, while 
pins 1 and 2 on a switch or hub may connect to the receive line. If two devices are 
connected using Ethernet, the type of device will dictate whether crossed or uncrossed 
Ethernet cables need to be used. (For example, a crossed cable is required if two Ethernet 
terminal devices are directly connected.) 

You require a crossed cable for the PG/PC connection if your PG/PC does not have an 
Ethernet interface with autocrossing functionality. 

Additional references 
For further information about the cables and connectors, see the 
Industrial Communication IK PI Catalog. 
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Commissioning (hardware) 5
5.1 Requirements for commissioning 

Requirements 
The following requirements must be satisfied for the initial commissioning of the SIMOTION 
D4x5 and the SINAMICS S120 modules required for operation (SINAMICS S120 line 
modules and SINAMICS S120 motor modules): 

● Your system with SIMOTION D4x5 has been installed and wired. 

● Your PG/PC has been connected to the SIMOTION D4x5 via a PROFIBUS or Ethernet 
interface or via PROFINET (CBE30). 

Commissioning steps 
Commissioning the hardware involves the following steps: 

1. Inserting the CF card (Page 83) 

2. Checking the system (Page 85) 

3. Switching on the power supply (Page 85) 

Additional references 
For information on installing/mounting and commissioning the SINAMICS S120 components, 
refer to the SINAMICS S120 Commissioning Manual. 

5.1.1 Inserting the CompactFlash card 

Properties of the CF card 
The CF card is mandatory for operation of the SIMOTION D4x5. The SIMOTION Kernel and 
the software used to control the drives (SINAMICS firmware) are contained on the CF card.   

In order to load the SIMOTION kernel, the CF card must be inserted when the SIMOTION 
D4x5 is powered up. 

 

CAUTION  
The CompactFlash card may only be inserted or removed when the SIMOTION D4x5 
control unit is disconnected from the power supply. SIMOTION D4x5 is in a de-energized 
state when all the LEDs are OFF. 
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Procedure   
To insert the CF card, carry out the following steps:  

1. The direction of insertion of the CF card is indicated by an arrow located on both the plug-
in slot and the CF card. Align the CF card with the arrows. 

2. Gently insert the CF card into the empty plug-in slot of the SIMOTION D4x5 until it clicks 
into place. 

If correctly inserted, the CF card is flush with the housing.  

 
Figure 5-1 Inserting the CF card 

See also 
Changing the CompactFlash Card (Page 295) 
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5.1.2 Checking the system 

Procedure 
Check the final installed and wired system one more time before it is switched on, keeping in 
mind the safety points in the following check list: 

● Have you observed all ESD measures when handling the components? 

● Have all screws been tightened to their specified torque? 

● Have all connectors been properly inserted and locked/screwed? 

● Are all components grounded and have all shields been attached? 

● Have you taken the load capacity of the central power supply into consideration? 

DANGER  
 

SIMOTION D445/D445-1 must not be operated without a fan/battery module.  
SIMOTION D445/D445-1 will not power up without a fan/battery module. 

5.1.3 Switching on the power supply 

Switching on the external power supply 
Power is supplied to the SIMOTION D4x5 via an external power supply unit such as SITOP.   

Switch on this power supply. 
 

CAUTION  
It is essential to ensure that the external 24 VDC power supply to the D4x5 is not 
interrupted for longer than 3 ms. After the expiration of these 3 ms, the SIMOTION D4x5 
powers down and can be recommissioned with OFF/ON only. 

For additional information, refer to the section titled Properties of the user memory 
(Page 89). 

 

Power-up of control unit   
Once the power supply has been switched on, the SIMOTION D4x5 begins to power up: 

1. At the start of the power-up, all LEDs are briefly illuminated. The LEDs on the SIMOTION 
D4x5 enable you to track the progress of the power-up. Any errors are displayed. 

2. Power-up of the SIMOTION Kernel 
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3. All DRIVE-CLiQ connections (e.g. with the SINAMICS S120 Active Line Module) are also 
detected automatically. 

  Note 

As long as the RDY LED continues to flicker, power-up is not complete and it is not 
possible to go online. 

During commissioning the components' firmware is upgraded or downgraded 
automatically based on the FW version on the CompactFlash Card and the FW version 
on the SINAMICS components (DRIVE-CLiQ components, CBE30, PM340, etc.). 

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT.  

SIMOTION D4x5/CX32/DRIVE-CLiQ components: 

An FW update on DRIVE-CLiQ components is indicated by the RDY LED flashing 
red/green: 
 FW update running: RDY LED flashing slowly (0.5 Hz) 
 FW update complete: RDY LED flashing quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW 
update.  

Go offline once all the FW updates are complete, POWER ON the upgraded/downgraded 
components. 
CBE30 Option Board: 

During the firmware update, the OPT LED of the SIMOTION D module and the SYNC 
LED of the CBE30 flash green. 

4. The first time it is energized, the SIMOTION D4x5 goes to STOP mode following power-
up. 

Following power-up, the SIMOTION D4x5 is in a state in which it can be configured. 

Fan/battery module on a SIMOTION D445/D445-1 faulty or missing 
While the SIMOTION D445/D445-1 is powering up, a test is performed to check whether the 
fan/battery module is functioning properly. If a fan/battery module is not mounted or is 
mounted improperly, the kernel is not downloaded and the RDY LED flashes red/yellow (2 
Hz). Switch off the power supply and correct the fault before switching on the power supply 
again. 

 

DANGER  
If the SIMOTION D445 runs for more than a minute with a missing or faulty fan/battery 
module, the module will switch to the reset state after approximately 1 minute. This state 
can only be reset with a switch-off. 
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DANGER  
If the SIMOTION D445-1 needs to be cooled (fan switches on with temperature control) and 
this is not possible due to a fan/battery module having been removed or being faulty, the 
module state will change to reset after approximately 1 minute. This state can only be reset 
with a switch-off. 

 

5.2 RESET button 

Layout 
The RESET button is located behind the blanking cover on the SIMOTION D4x5. 

Performing a reset 

A reset causes the entire system to be reset and forces the system to power up again. This 
operation is comparable with a "Power on Reset" but does not require the disconnection of 
the 24 V power supply. 
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5.3 User memory concept 

5.3.1 SIMOTION D4x5 memory model 
The following figure provides an overview of the memory model of SIMOTION D4x5.     

 
Figure 5-2 SIMOTION D4x5 memory model 

 

As a result, the SIMOTION Kernel (D4x5 firmware) contains the functions needed for 
virtually all applications and corresponds in essence to a PLC with the IEC 61131-3 
command set plus system functions for controlling various components, such as inputs and 
outputs. 

The SIMOTION Kernel can be expanded by loading technology packages (TPs), e.g. for 
motion control or temperature control. 

In the following chapters, you will learn information about the user memories and the steps 
involved in certain operations. 
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5.3.2 Properties of the user memory 

Non-volatile data  
Non-volatile data make it possible to retain relevant data for the user and the system even 
when the SIMOTION D4x5 has been switched off. You will find information about the area 
that can be used for non-volatile data in the SIMOTION SCOUT Configuration Manual and in 
the SIMOTION D4x5 Technical Data Manual. 

A SIMOTION device has the following non-volatile data: 

Table 5- 1 Non-volatile data contents 

Non-volatile data Content 
Kernel data  Last operating mode 

 IP parameters (IP address, subnet mask, router address) 
 DP parameters (PROFIBUS DP address, baud rate) 
 Diagnostics buffer 

Retain variables  Variables in the interface or implementation section of a unit declared 
with VAR_GLOBAL RETAIN 

 Global device variables set with the "RETAIN" attribute 

Retain TO Absolute encoder offset 
DCC blocks SAV blocks and user-defined blocks with retain behavior ("SAV = SAVE", 

blocks for the non-volatile data backup) 

 
 

 Note 

DCC SIMOTION blocks with retain behavior act like retain variables in terms of copying RAM 
to ROM, resetting memory, downloading, backing up non-volatile data 
(_savePersistentMemoryData) and backing up data. 

With SINAMICS Integrated the SINAMICS retain data is buffered (this is also the case with 
SINAMICS DCC, where SuperCap or a battery is used). With _savePersistentMemoryData 
data is not saved.  
With CX32 there is permanent data buffering via the FRAM. 
With_savePersistentMemoryData data is not saved.  

For further information on DCC, see the "DCC Programming" Programming Manual. 
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The non-volatile data of the SIMOTION D4x5 has the following properties: 

Table 5- 2 Non-volatile data properties 

Property Meaning 
City: The non-volatile data is in the SIMOTION D SRAM. The following backup 

options are available: 
 SRAM backed up by SuperCap (maintenance-free), or 
 SRAM backed up by fan/battery module; with battery mounted 
 Non-volatile data backed up from SRAM to CF card 

(_savePersistentMemoryData) 

Backup time:  SuperCap: 5 days, minimum 
 Battery: At least 3 years 

 

The integral real-time clock in the SIMOTION D4x5 is also backed up, like the SRAM. The 
same backup time applies for the integral real-time clock.  

If the buffer time is exceeded on the real-time clock, the time is reset.  

Fan/battery module  
If the backup time is insufficient, a battery can be connected by means of an external 
fan/battery module. The backup time of a used type of battery is at least 3 years.  

A 3 V lithium SN: 575332 battery type (with cable tail and connector) is used. The battery 
can be replaced without data loss, because the retain data is backed up internally via the 
SuperCap. 

The fan/battery module is optional for the D425/D435 and must be ordered separately. Since 
the fan/battery module is always required for the D445/D445-1 it is included in the scope of 
delivery of a D445/D445-1 (see the SIMOTION D4x5 Manual) 
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CF card 
With the _savePersistentMemoryData system function, the user program can back up the 
contents of the non-volatile data to the CF card. This ensures that the retain variables and 
the absolute encoder position are backed up in the event that a spare part is used.  

 

 Note 
IP and DP parameters in the non-volatile data 

If the CF card contains a configuration, the IP and DP parameters are loaded from the CF 
card during power-up and used by the SIMOTION device. The SIMOTION D4x5 uses the 
addresses defined in these parameters to go online. During power-up, the IP and DP 
parameters on the CF card are also written to the non-volatile data. If the SIMOTION device 
is then powered up with a CF card with no configuration, the IP and DP parameters are 
retained in the non-volatile data and are used by the device. Thus, the SIMOTION device 
can continue to go online if a configuration was loaded with SIMOTION SCOUT at least once 
or if the SIMOTION device is powered up with a CF card containing a configuration. 

 

Volatile data (RAM / current data RAM)  
The volatile data is defined by the following properties:  

● The volatile data is located in the RAM memory of the SIMOTION device. 

● The download data of SIMOTION SCOUT are written to this memory. 
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● This data is lost with the SIMOTION D4x5 is switched off. 

● The "volatile data" area contains the following data: 

– SIMOTION Kernel (D4x5 firmware) 

– Technology packages (TP) 

– User data (programs, configuration data, parameter settings) 

 
Figure 5-3 Configuration data and system variables in the volatile memory 

Further information about memory management for SIMOTION appears in the SIMOTION 
SCOUT Basic Functions Function Manual. 

CompactFlash card (CF card) 
The CF card contain the following data:  

● SIMOTION Kernel (D4x5 firmware) 

● Technology packages (TP) 

● User data (units, configuration data, parameter settings, task configuration) 

● IP parameters (IP address, subnet mask, router address) 

● DP parameters (PROFIBUS DP address, baud rate) 

● Also, if required: 

– User data saved with _savePersistentMemoryData and _export/_saveUnitDataSet 

– Data from SIMOTION IT 

– Archived SCOUT project 
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5.3.3 Operations and their effect on the user memory 
The operations marked with arrows in the figures entitled "SIMOTION D4x5 memory model" 
and "Configuration data and system variables in the volatile memory" and their effects on the 
user memory will be described below. 

SIMOTION SCOUT Download 
The "Download" menu command transfers the following data from the engineering system to 
the "volatile data" area: 

● User data (units, configuration data, parameter settings, task configuration) 

● Technology packages (TPs) 

In addition, the IP and DP parameters are saved to the "non-volatile data" area. The retain 
variables are set to their initial values, but this depends on the settings in SIMOTION 
SCOUT. If the SIMOTION D4x5 is switched off following the download, the volatile data is 
lost. 

Copy RAM to ROM 
The Copy RAM to ROM menu command saves the following data via the engineering 
system to the CF card: 

● Technology packages and user data (units, configuration data, parameters, task 
configuration) of the "volatile data" area 

● Current data values are copied to the "volatile data" area, depending on the settings in 
SIMOTION SCOUT. 

  Note 

The "Copy RAM to ROM" menu command does not save the current values of the retain 
variables to the CF card. Use the system function "_savePersistentMemoryData" for this.

Current RAM 
If you change the system variable values, these take immediate effect in the current RAM. 
New configuration data values are initially stored in the Next memory. Configuration data that 
takes immediate effect is automatically transferred to the current RAM. Configuration data 
that will only become active following a RESTART on the technology object (set the 
restartactivation system variable to the ACTIVATE_RESTART value) is not written to the 
current RAM until after the RESTART. 

To save the configuration data changed online to the offline project, you must first transfer 
the content of the current RAM to the RAM using the menu command "Target system" > 
"Copy current data to RAM".  

Once you have done this, the configuration in SCOUT will no longer be consistent with the 
configuration in the target device, as a consistency check is performed on the RAM data. 
Read the data from the RAM using the menu command "Target system" > "Load" > "Load 
CPU / drive unit to PG" (for the configuration data only) to re-establish a consistent system 
state.  
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To save the configuration to the CF card in non-volatile format, use the menu command 
"Target system" > "Copy RAM to ROM".  
Via the menu "Options" > "Settings..." > "Download", you can set whether current values are 
to be copied to the RAM and configuration data loaded to the PG with "Copy RAM to ROM" 
using the option "Transfer current values with copy RAM to ROM". 

 

 Note 

The "Copy current data to RAM" command does not transfer the values of the system 
variables to the RAM memory. This means that "Save to memory card (Copy RAM to ROM)" 
or "Save in the engineering project (Load CPU / drive unit to PG)" is not possible. 

In order to ensure that system variable values can also be saved to the engineering project 
and memory card, the system variable values must be changed OFFLINE and then 
downloaded to the target device and saved. 

 

SIMOTION D4x5 power-up 
During power-up of the SIMOTION D4x5, the SIMOTION Kernel is loaded from the CF card 
to the "volatile data" area. 

When the SIMOTION D4x5 is switched off, the contents of the "volatile data" area are lost. 
When the SIMOTION D4x5 is powered up again, the following data is loaded from the CF 
card: 

● Technology packages and user data in the "volatile data" area 

● IP and DP parameters in the "non-volatile data" area 

Backing up non-volatile data  
 You have the following options for backing up non-volatile data on the CF card: 

● In the user program: 
With the "_savePersistentMemoryData" system function, the user program can back up 
the non-volatile data content to the CF card. This ensures that the retain variables and 
the absolute encoder position are backed up in the event that a spare part is used. 

● Using a switch position (SIMOTION D4x5 Service selector switch) or IT DIAG. See 
Section Diagnostic data and non-volatile data (Page 310). 
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The contents are saved to the "PMEMORY.XML" backup file in the "USER/SIMOTION" 
directory. On the system side, this system function ensures that a consistent overall image of 
the non-volatile data is always available the next time the unit is powered on, even if there is 
a power failure during backup. To this end, before a new backup file is created, any existing 
backup file is renamed as "PMEMORY.BAK". If the save operation to the new backup file 
fails (e.g. because the capacity of the CF card is insufficient), this backup copy of the backup 
file is used the next time an attempt is made to restore the non-volatile data content. If the 
new file is successfully created, the backup copy of the backup file is deleted.  

 

NOTICE  
Non-volatile data that is not backed up to the CF card will be lost if a spare part is installed 
(in the event of a module defect). For example, failing to back up the current values of the 
retain variables will result in them being lost and reset to their initial values.  

If an absolute encoder overflow occurs after "_savePersistentMemoryData", the actual 
position value will no longer be correct once the non-volatile data has been restored. In this 
case, homing (absolute encoder adjustment) must be repeated. 

 

With the SCOUT functions "Back up variables" and "Restore variables", you also have the 
option of backing up to your PC and restoring data that was changed during operation and 
only stored in the runtime system.  

Reloading non-volatile data  
Data backed up on the CF card with _savePersistentMemoryData is reloaded in the following 
scenarios: 

1. Loss of the SRAM contents (buffer failure due to empty SuperCap or empty backup 
battery) 

2. After a module replacement, see Section Replacing modules (spare parts) (Page 267) 

3. After a memory reset, see Section SIMOTION D4x5 memory reset (Page 249) 

4. Via switch position, see Section Deleting/restoring non-volatile data (Page 317) 

Power failure 
In the event of a power failure, the data in the SRAM of the control unit is backed up by an 
internal SuperCap and a fan/battery module (where applicable).  

The non-volatile data is available again the next time the unit is powered up. Thus, the 
control unit is immediately operational without data loss. 

 

 Note 

After power off and then on again, the SIMOTION part starts in coordination with the 
SINAMICS Integrated, whereby the SINAMICS Integrated takes longer to power up. The 
"Incoming station" alarm is triggered, and the PeripheralFaultTask is called. 

 



Commissioning (hardware)  
5.3 User memory concept 

 SIMOTION D4x5 
96 Commissioning and Hardware Installation Manual, 11/2010 

Power-up and non-volatile data 
The table below lists the cases that can arise during power-up in conjunction with the non-
volatile data and explains how they are handled.  

Table 5- 3 Cases: Power-up with non-volatile data 

Case Initial condition Result 
1 The non-volatile data is valid. SIMOTION D4x5 powers up with the non-volatile data, 

meaning, for example, that the PROFIBUS address in 
the non-volatile data is valid. 

2 The non-volatile data is invalid and there is no backup file 
(PMEMORY.XML) and no backup copy of the backup file 
(PMEMORY.BAK). 

SIMOTION D4x5 copies the default settings to the non-
volatile data and powers up with this data. In this case, 
for example, the default PROFIBUS address is used. 

3 The non-volatile data is invalid. A valid backup file 
(PMEMORY.XML) exists. 

SIMOTION D4x5 copies the backup file contents to the 
non-volatile data and powers up with this data. 

4 The non-volatile data is invalid, the backup file is invalid 
and there is no backup copy of the backup file 
(PMEMORY.BAK). 

SIMOTION D4x5 copies the default settings to the non-
volatile data and powers up with this data, in which 
case, for example, the default PROFIBUS address is 
used. 

5 The non-volatile data is invalid; a backup file exists, but it 
is invalid; a backup copy of the backup file exists and is 
valid. 

SIMOTION D4x5 copies the backup file contents to the 
non-volatile data and powers up with this data. 

Non-volatile data diagnostics 
The user can determine the status of the non-volatile data and the battery using the 
diagnostic buffer, system variables, and PeripheralFaultTask.  

Evaluating via the diagnostics buffer 
When they are issued, the following messages are entered once in the diagnostics buffer: 

Table 5- 4 Messages of the diagnostics buffer 

Entry Meaning Remedy 
Level 1 battery voltage warning 1) Battery voltage below prewarning level Replace battery in the 

fan/battery module 
Level 2 battery voltage warning 1) The battery voltage is below the warning 

level, backing up of non-volatile data / 
clock can no longer be guaranteed. 

Replace battery in the 
fan/battery module 

Battery voltage for data backup in 
permissible range 

  

Non-volatile data memory voltage error The buffer voltage of the SuperCap or 
the battery was too low after Power On. 
Possible data loss in the non-volatile 
data / clock. 

Replace battery in the 
fan/battery module or charge the 
SuperCap over a longer period. 

Non-volatile data loaded from a file 
(Persistent Data File Loading done) 

Non-volatile data has been successfully 
restored from the backup file on the CF 
card. 

- 
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Entry Meaning Remedy 
Non-volatile data loaded from the backup file 
(Persistent Data Backup File Loading done) 

Non-volatile data has been successfully 
restored from the backup copy of the 
backup file on the CF card. 

- 

Error while loading non-volatile data from a 
file 
(Persistent Data File Loading Failure) 

Backup file or backup copy of backup 
file could not be loaded. 
Possible causes: 
 Backup file or backup copy of 

backup file does not exist 
 Data in backup file is invalid 

Use the 
"_savePersistentMemoryData" 
system function to generate a 
valid backup file. 

Device with battery module Fan/battery module is present. - 
Device without battery module Fan/battery module is not present. Connect fan/battery module if 

necessary. 

1) These warnings are only signaled when the fan/battery module has been inserted.  

Refer to the SIMOTION SCOUT Configuration Manual for information about how to read out 
the contents of the diagnostic buffer. 

Evaluating via PeripheralFaultTask 
Battery status changes in RUN are reported to the user program by calling 
PeripheralFaultTask. Changes can be evaluated here using Taskstartinfo: 

● TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) 

● TSI#details = 16#00000040 . 

If there is no fan/battery module present or no battery inserted when the power is on, or in 
STOP mode, no PeripheralFaultTask will be triggered when powering up or in RUN 
(application case: D4x5 should generally be operated without a fan/battery module or 
battery). 

References 
Detailed information on setting up TaskStartInfo(#TSI) can be found in the SIMOTION 
SCOUT Basic Functions Function Manual. 
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Evaluating via system variables 
The system variables in the "device.persistentDataPowerMonitoring" structure indicate the 
status of the non-volatile data and the battery. 

Table 5- 5 Status of the non-volatile data and battery 

System variable Designation State Updating 
powerFailure Buffer voltage 

(SuperCap or battery) 
too low, possible loss of 
data 

NO (91) 
YES (173) 

"YES" was set at too 
low a buffer voltage 
when powering up; 
status needs to be 
reset to "NO" via the 
application. 

persistentDataState Reading the persistent 
data 

See the table below, 
"State of non-volatile 
data following power-
up". 

During power-up 

warningBatteryVoltage 
Level1 1) 

Battery voltage below 
the prewarning level 

NO (91) 
YES (173) 

During a status change, 
remains set if Level 2 is 
reached 

warningBatteryVoltage 
Level2 1) 

Battery voltage below 
the warning level 

NO (91) 
YES (173) 

During a status change 

1) Bothbattery warning levels are set under the following conditions: 

● The fan/battery module has been installed and the battery has been inserted but the 
battery voltage is below warning level 2. 

● The fan/battery module has been installed but no battery has been inserted (as of V4.1 
SP2). 

● No fan/battery module has been installed (as of V4.1 SP2). 

System variable "device.persistentDataPowerMonitoring.persistentDataState" indicates the 
state of the non-volatile data after power-up. 

Table 5- 6 State of non-volatile data after powering up (persistentDataState system variable) 

State Meaning 
FROM_RAM (1) Non-volatile data in the SIMOTION device is used 
FROM_FILE (2) Non-volatile data is restored from the backup file 
FROM_BACKUP (3) Non-volatile data is restored from the backup copy of the backup file 
INVALID (4) Data in the non-volatile data and in the backup file / backup copy of backup 

file is invalid or non-existent/deleted. 
The SIMOTION device has copied the default settings to the non-volatile 
data and used this data to power up. 
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Requirement/availability of the battery (as of V4.2) 
System variables can be used to evaluate:  

● Whether a battery is required for the operation of the device (or not) 

● Whether a battery is available (or not) 

Table 5- 7 System variable batterynecessary/batteryexisting  

System variable 
on the device 

States Description 

fanbattery of the structfanbattery type (the system variables are of the enumfanbattery type) 
MANDATORY Battery is required for the backup of the retain data and 

the real-time clock (RTC) of the device. .batteryexisting 
can be used to query whether a battery is available.  

OPTIONAL The retain data and the real-time clock (RTC) are backed 
up via SuperCap. A battery can be used as an option to 
extend the backup time. .batteryexisting can be used to 
query whether a battery is available.  
Example: D4x5 

OPTIONAL_RTC 1) A battery is not required for the backup of the retain data. 
Only the real-time clock (RTC) is backed up via 
SuperCap. A battery can be used as an option to extend 
the backup time of the real-time clock. .batteryexisting 
can be used to query whether a battery is available.  
Example: D4x5-2 

.batterynecessary 

NOT_MANDATORY 
1) 

A battery is not required for the backup of the retain data. 
The real-time clock (RTC) is backed up via SuperCap.  
Example: D410 

EXISTING EXISTING is only displayed when .batterynecessary is 
set to: 
 MANDATORY or 
 OPTIONAL or 
 OPTIONAL_RTC 
and a battery is available. 

.batteryexisting 

NOT_EXISTING Battery is not available. 

1)  If the SuperCap is discharged, the contents of the real-time clock (RTC) are lost 
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5.4 Fan 

5.4.1 Cooling the SIMOTION D4x5 

Overview  
If natural convection proves inadequate in terms of dissipating heat away from the module, 
and the supply air temperature exceeds the permissible limits as a result, in the case of 
SIMOTION D425/D435 an external fan/battery module must be mounted on the underside of 
the module. A fan/battery module is always required for SIMOTION D445/D445-1. 

Table 5- 8 Fan/battery module for SIMOTION D4x5 

Property SIMOTION 
D425 

SIMOTION D435 SIMOTION D445 SIMOTION D445-1 

D435 with order no. 
6AU1 435-0AA00-
0AA1: Optional 

Fan/battery 
module 

Optional 

D435 with order no. 
6AU1 435-0AA00-
0AA0: Required for 
supply air 
temperatures of 43° 
C and above 

Always required 
 

Always required 

Fan/battery 
module 
included in the 
scope of 
delivery of the 
D4x5 

- - - - Fan/ 
battery module 
(single fan) with 
order no.  
6FC5 348-0AA01-
0AA0 

Double fan/ 
battery module  
with order no.  
6FC5 348-0AA02-
0AA0 

Fan/battery 
modules which 
can be used in 
principle 

Type  
6FC5 348-
0AA01-0AA0 
only (single 
fan) 

Type  
6FC5 348-0AA01-
0AA0 only (single 
fan) 

Type  
6FC5 348-0AA01-
0AA0 only (single 
fan) 

Type 6FC5 348-
0AA01-0AA0 (single 
fan) and Type 
6FC5 348-0AA02-
0AA0 (double fan) 

Max. 
permissible 
supply air 
temperature 

55° C 55° C 55° C 55° C 

Fan control Switches on 
at supply air 
temperatures 
of approx. 43° 
C and above 

Switches on at 
supply air 
temperatures of 
approx. 43° C or 
above 

Fan is always on The fan switches on 
with temperature 
control (continuous 
operation at approx. 
40° C and above) 

The fan/battery modules are usually supplied with a backup battery. 
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Fan faults  
Fan faults are indicated as follows: 

● Entry in diagnostic buffer 

● In the event of a fan failure the RDY LED flashes red/yellow at 2 Hz (SIMOTION 
D445/D445-1 only), which means: 

– With a fan/battery module, the single fan has failed 

– With a double fan/battery module, both fans have failed 

● Indicated via system variable 

● Call to the PeripheralFaultTask 

For further information on the evaluation of fan faults, see Section  
Overview of the fan/battery module states (Page 103). 

5.4.2 Fan/battery module on the D425/D435 
SIMOTION D425/D435 can be operated without a fan/battery module. It is for this reason 
that the standard scope of delivery of the D425/D435 does not include a fan/battery module.   

In the absence of a fan/battery module when the line supply is connected, a warning will be 
output by setting variable device.CpuDataRW.fanwarning = "NO".  

If there is no fan/battery module present when the power is on, or in STOP mode, no 
PeripheralFaultTask will be triggered when powering up or in RUN (application case: 
D425/D435 is generally to be operated without a fan/battery module). 

5.4.3 Fan/battery module on the D445/D445-1 
A fan/battery module is always required for operation of SIMOTION D445/445-1. A 
corresponding module including backup battery is, therefore, included in the scope of 
delivery of the D445/D445-1 control unit.  

● SIMOTION D445: Scope of delivery including fan/battery module (single fan) 

● SIMOTION D445-1: Scope of delivery including double fan/battery module 
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SIMOTION D445 
A fan/battery module (single fan) is always used with SIMOTION D445. 

While the SIMOTION D445 is powering up, a test is performed to check whether the 
fan/battery module is functioning properly. If the fan/battery module is missing or faulty, the 
kernel is not downloaded and the RDY LED flashes red/yellow (2 Hz). Switch off the power 
supply and eliminate the fault. Then switch the power supply back on.  

 

 Note 

If the SIMOTION D445 runs for more than a minute with a missing or faulty fan/battery 
module, the module will switch to the RESET state after approximately 1 minute (7-segment 
display shows "8"). This state can only be reset with a switch-off. 

 

SIMOTION D445-1 
For increased availability a double fan/battery module is used as standard on SIMOTION 
D445-1.  

The double fan/battery module guarantees sufficient cooling even if just one fan is 
operational. 

If one of the fans fails, the remaining fan continues under full load. The fan failure is signaled 
by the generation of an event in the PeripheralFaultTask. In this case it is strongly 
recommended that the double fan/battery module is replaced at the next available 
opportunity.  

Checks are performed during power-up to determine whether the double fan/battery module 
on SIMOTION D445-1 is functioning correctly (i.e. at least one of the two fans is working). If 
a double fan/battery module is missing or faulty, the kernel is not downloaded and the RDY 
LED flashes red/yellow (2 Hz). Switch off the power supply and eliminate the fault. Then 
switch the power supply back on.  

 

 Note 

If the SIMOTION D445-1 needs to be cooled (fan switches on with temperature control) and 
this is not possible due to a fan/battery module having been removed or being faulty, the 
module state will change to the RESET state after approximately 1 minute (7-segment 
display shows "8"). This state can only be reset with a switch-off. 

If only one fan in the double fan/battery module fails, the module is still regarded as 
functional, although it should be replaced as soon as possible. If neither of the fans is 
working, the double fan/battery module is identified as defective.  
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5.4.4 Overview of states, fan/battery module 
The states that can occur during operation are described in the following.  

Table 5- 9 Overview of states 

System variables 3) State Fan 4) PeripheralFaultTask 
 
Diagnostic buffer entry 

_cpuDataRW. 
fanWarning 

_cpuDataRW. 
redundantfanWar
ning 2) (as of 
V4.2) 

Single fan PeripheralFaultTask: 
Is not called 
Diagnostic buffer entry: 
Fan on the module is defective 

= YES 1) = NO Failure of one 
fan during 
STOP, then 
RUN 

Double fan PeripheralFaultTask:  
Is not called 
Diagnostic buffer entry: 
Redundant fan on the module is defective 

= NO = YES 

Failure of both 
fans during 
STOP, then 
RUN 

Double fan PeripheralFaultTask:  
Is not called 
Diagnostic buffer entry: 
Fan on the module is defective 

= YES 1) = NO 

Single fan PeripheralFaultTask: 
TSI#InterruptId = 
_SC_PC_INTERNAL_FAILURE (= 205) 
TSI#details = 16#00000080 
 
Diagnostic buffer entry: 
Fan on the module is defective 

= YES 1) = NO Failure of one 
fan during 
RUN 

Double fan PeripheralFaultTask:  
TSI#InterruptId = 
_SC_PC_INTERNAL_FAILURE (= 205)  
TSI#details = 16#00004000  
 
Diagnostic buffer entry:  
Redundant fan on the module is defective 

= NO = YES 

Failure of both 
fans during 
RUN 

Double fan PeripheralFaultTask:  
TSI#InterruptId = 
_SC_PC_INTERNAL_FAILURE (= 205)  
TSI#details = 16#00000080  
 
Diagnostic buffer entry:  
Fan on the module is defective 

= YES 1) = NO 

1)  For D445/D445-1: Module goes into the RESET state after approx. 1 minute. 
2) Maintenance: Replace double fan/battery module at the next available opportunity. 
3)  The "YES" value must be reset to "NO" by the application. 
4)  Single fans are only supported by SIMOTION D4x5.  

Fan faults are detected if through 
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● A cyclic fan test (as of V4.2) 

● Or when the fan is switched on 

a malfunction is detected (fan does not turn or fan turns at too low a speed). 
 

 Note 

If the "redundant fan" is already defective in a double fan/battery module when the system is 
powered-up, this is detected as a single fan/battery module depending on the type of defect 
(e.g. a wire breakage).  

You should, therefore, also set the .fanexisting system variable to the "SINGLE" state to alert 
the personnel operating the machine to the fact that no is redundancy available. 

 

Diagnostics buffer entry 
The diagnostics buffer entries have the following meanings: 

● Fan on the module is defective 

All of the fans in a fan/battery module have failed 

● There is no redundant fan available 

This message only occurs in the case of modules that support double fan/battery 
modules with a redundant fan.  

The message occurs: 

– If it is only the redundant fan that has failed on a double fan/battery module or 

– If a single fan/battery module is connected, but the module also supports a double 
fan/battery module in principle (with V4.2, this is only the case for D445-1) 

Requirement/availability of a fan (as of V4.2) 
System variables can be used to evaluate:  

● Whether a fan is required for the operation of the device (or not) 

● Whether a fan is available (or not) 
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Table 5- 10 System variable fannecessary/fanexisting 

System variable on the 
device 

States Description 

fanbattery of the structfanbattery type (the system variables are of the enumfanbattery type)  
MANDATORY Fan is required for operation of the device. 

.fanexisting can be used to query whether 
a fan is available. 
Examples: D410, D445, D445-1, 
D445-2 DP/PN, D455-2 DP/PN 

OPTIONAL Fan can be used optionally. .fanexisting 
can be used to query whether a fan is 
available. 
Examples: D425, D435 

.fannecessary 

NOT_MANDATORY Fan is not required for operation of the 
device. 

SINGLE Single fan is available. 
Examples: D410, D4x5 

REDUNDANT Double fan is available. 
Examples: D445-1, D445-2 DP/PN, 
D455-2 DP/PN 

.fanexisting 

NOT_EXISTING No fan available.  
Example: D425 without optional fan 

References 
Detailed information on setting up TaskStartInfo(#TSI) can be found in the  
function manual titled SIMOTION SCOUT Basic Functions.  

5.4.5 Response to overtemperature 
Operation at overtemperature reduces the module service life and can result in damage to 
the module.  

Causes 
Causes of problems in the heat dissipation of the module can be, for example: 

● Violation of the maximum permissible air intake temperature 

● Free convection is not ensured (clearances are not maintained, pollution, convection is 
prevented by cables) 

● Impermissible mounting position of the module 
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Temperature thresholds 
The internal module temperature is monitored via two module-specific temperature 
thresholds: 

● Overtemperature is signaled when the first (lower) temperature threshold is exceeded. 

● When the temperature falls below the first temperature threshold again (minus a 
hysteresis of approx. 5° C), "Normal temperature" is signaled. 

● When the second (higher) temperature threshold is exceeded, the module shuts down in 
order to protect itself. 

Response to overtemperature 

Table 5- 11 Response of the temperature monitoring (as of V4.2) 

Temperature... Response 
... exceeds the 1st temperature 
threshold (overtemperature) 

Call of the PeripheralFaultTask:  
 TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) 
 TSI#details = 16#00000002 
Diagnostics buffer entry:  
"Temperature exceeded in the housing" 

... falls below the 1st 
temperature threshold minus a 
hysteresis of approx. 5° C 

Call of the PeripheralFaultTask: 
 TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) 
 TSI#details = 16#00000004 
Diagnostics buffer entry:  
"Temperature in the housing has returned to normal" 

... exceeds the 2nd temperature 
threshold  

D445, D445-1:  
Module goes into permanent RESET to protect itself (7-segment 
display shows "8", RDY LED flashes red/yellow at 2 Hz). 
D425, D435:  
Module goes into the FAULT state to protect itself (7-segment 
display shows "F", all LEDs flicker red) 

References 
Detailed information on setting up TaskStartInfo(#TSI) can be found in the SIMOTION 
SCOUT Basic Functions Function Manual. 
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Parameter assignment / addressing 6
6.1 Software requirements 

SIMOTION SCOUT Engineering System 
To commission the SIMOTION D4x5, the SIMOTION SCOUT Engineering System must be 
installed on your PG/PC. Please read the information on the current DVD for "SIMOTION 
SCOUT."  

For information on how to install SIMOTION SCOUT on your PG/PC, see the 
SIMOTION SCOUT Configuration Manual. 

 

6.2 Creating a project and configuring communication 

6.2.1 Creating a SIMOTION project and inserting a D4x5 

Procedure 
Proceed as follows to create a new project in SIMOTION SCOUT and insert a 
SIMOTION D4x5: 

1. Select the Project > New... menu command.  

2. In the "New Project" dialog box, assign a name and confirm with "OK." 

A new folder with the name of the project will be created in the project navigator. 
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3. In the project navigator, double-click "Insert SIMOTION device". The "Insert SIMOTION 
Device" dialog box is opened: 

 
Figure 6-1 Inserting a SIMOTION device 

4. In the "Insert SIMOTION Device" dialog box, select the device, the device version and the 
SIMOTION version. 

5. If required, make further settings: 

– SINAMICS: Select either a "SINAMICS S120 Integrated" or a 
"SINAMICS SM150 Integrated" (only for D445/D445-1/D455-2) 

– SINAMICS version: Select the SINAMICS Integrated version if several drive versions 
are available for a SIMOTION version 

– Option module: Select a CBE30 (only for D425, D435, D445 and D445-1) 

6. The Open HW Config option can be used to select whether HW Config should be opened 
in the next step (e.g. in order to insert a CX32 controller extension). 

7. Confirm the "Insert SIMOTION device" dialog box with "OK" 
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PROFINET version 
With SCOUT V4.2  

● PROFINET version V2.1 is created for SIMOTION V4.0 devices 

● PROFINET version V2.2 is created for SIMOTION V4.1 and V4.2 devices 

There is no selection option in the "Insert SIMOTION Device" dialog box - in exceptional 
circumstances (e.g. for existing systems), PROFINET version V2.1 can still be configured for 
V4.1 CPUs. A CPU replacement must be made in HW Config for this. 

Please note that separate SIMOTION D firmware is available for PROFINET versions V2.1 
and V2.2. The required firmware can be found on the SCOUT DVD, as well as at Internet 
address (http://support.automation.siemens.com/WW/view/en/31045047) 

Mixed operation of the PROFINET V2.1 and V2.2 synchronization processes is not possible 
in a network.  

SINAMICS Integrated type 
The following selection options are available for SIMOTION D445/D445-1/D455-2: 

● SINAMICS S120 Integrated 

● SINAMICS SM150 Integrated for applications with medium-voltage converters 

A separate SIMOTION D firmware is available for each of the two versions.  

Version of the SINAMICS Integrated 
Depending on the selected SIMOTION version, several versions are available for the 
SINAMICS Integrated. Please note that a separate SIMOTION D firmware is available for 
each version of the SINAMICS Integrated.  

Additional references 
For further information on IRT in accordance with PROFINET standard IEC 61158 V2.1 and 
V2.2, refer to the SIMOTION Communication System Manual. 

Result 
If you have not yet configured a PG/PC in your project, you can select the interface for the 
PG/PC connection now.  

 

http://support.automation.siemens.com/WW/view/en/31045047�
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6.2.2 Configuring the PROFIBUS PG/PC interface 

Requirements 
The following requirements must be satisfied in order to configure the PG/PC interface: 

● You have acknowledged the "Insert SIMOTION device" dialog with "OK". 

● A PG/PC has not yet been configured in the project. 

If these requirements have been satisfied, you can configure the interface for the PG/PC 
connection in the  
"Interface Selection - D4x5" dialog. 

Proceed as follows to configure the PROFIBUS DP interface:  

Procedure 
1. In the "Select Interface - D4x5" dialog box, select "PROFIBUS DP2/MPI". 

 
Figure 6-2 Selecting a PROFIBUS interface  

2. Confirm with "OK". 

The dialog is closed, the SIMOTION D4x5 is created in the project navigator, and HW Config 
is started automatically (if parameterized).  

A PROFIBUS subnet with factory settings (1.5 MBit/s transmission rate) is created 
automatically.  
The PG/PC is now connected to the SIMOTION D4x5 via PROFIBUS. You can configure 
and parameterize your system.  

 

 Note 

If you do not use the factory settings, you must configure the PROFIBUS interfaces in HW 
Config. 
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Inserting a further SIMOTION device 
If you insert a further SIMOTION device using "Insert SIMOTION device", the PG/PC 
interface selection dialog box is not displayed. A further SIMOTION device is automatically 
connected to the PG/PC via PROFIBUS and a new unique DP address is calculated 
(address 4, 5 ... until 125 is reached). 

Additional references 
Further information on the topic of "Going online" can be found: 

● In the online help via the "Contents" tab at 

– "Diagnostics" > "Service and diagnostics" > "Overview of service and 

– diagnostics options" > "Part III" > "Go online" 

– "Insert device and connect to target system" > "Go online/offline" 

● On the Internet at http://support.automation.siemens.com/WW/view/en/22016709 
(http://support.automation.siemens.com/WW/view/en/22016709) 

● In SIMOTION Utilities & Applications, FAQ "Online connections to SIMOTION devices" 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.  

See also 
Establishing a PG/PC assignment (Page 123) 

6.2.3 Configuring the Ethernet PG/PC interface 

Requirement 
The following requirements must be satisfied in order to configure the PG/PC interface: 

● You have completed the "Insert SIMOTION device" dialog box with "OK". 

● A PG/PC has not yet been configured in the project. 

If these requirements have been satisfied, you can configure the interface for the PG/PC 
connection in the "Interface Selection - D4x5" dialog.  

Proceed as follows to configure the Ethernet interface: 

http://support.automation.siemens.com/WW/view/en/22016709�
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Procedure 
1. In the "Select Interface - D4x5 dialog", select "Ethernet IE2/NET (X130)".  

 
Figure 6-3 Configuring an Ethernet Interface 

2. Select the interface parameter assignment that you would like to use to go online, and 
confirm with "OK". 

The dialog is closed, the SIMOTION D4x5 is created in the project navigator, and HW Config 
is started automatically (if parameterized).  

An Ethernet subnet with factory settings is created automatically. (Factory settings, see 
Section Properties of Ethernet interfaces (Page 125).) 

Your PG/PC is now connected to the SIMOTION D4x5 the Ethernet. You can configure and 
parameterize your system.  

 

 Note 

If you want to change the default settings for IP addresses and the transmission rate, you 
must configure the Ethernet interfaces in HW Config and NetPro.  

 

Please make sure that the PG/PC and SIMOTION D4x5 are located in the same subnet and 
that S7 online access has been activated (PG/PC connection must be yellow and bold in 
NetPro). 

Inserting a further SIMOTION device 
If you insert a further SIMOTION device using "Insert SIMOTION device", the PG/PC 
interface selection dialog box is not displayed. A second SIMOTION device is automatically 
connected to the PG/PC via Ethernet, and a new unique IP address is calculated (last digit + 
1, until 255 is reached).  
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Additional references 
Further information on the topic of "Going online" can be found: 

● In the online help via the "Contents" tab at 

– "Diagnostics" ⇒ "Service and diagnostics" ⇒ "Overview of service and diagnostics 
options" ⇒ "Part III" ⇒ "Go online" 

– "Insert device and connect to target system" ⇒ "Go online/offline" 

● On the Internet at http://support.automation.siemens.com/WW/view/en/22016709 

● In SIMOTION Utilities & Applications, FAQ "Online connections to SIMOTION devices" 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 

See also 
Establishing a PG/PC assignment (Page 123) 

6.2.4 Representation of SIMOTION D4x5 in HW Config 
Once you have created a project and inserted a SIMOTION D4x5 as a module, HW Config 
opens automatically (if parameterized). 

In HW Config the SIMOTION D4x5 units are shown with the SINAMICS Integrated and the 
interfaces. 

 
Figure 6-4 Representation of SIMOTION D4x5 in HW Config 
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6.3 Configuring PROFIBUS DP 

6.3.1 General information about communication via PROFIBUS DP 

Definition of PROFIBUS DP 
PROFIBUS DP is an international, open field bus standard specified in the European field 
bus Standard EN 50170 Part 2. PROFIBUS DP is optimized for fast, time-critical data 
transmissions at the field level.   

Components communicating by means of PROFIBUS DP are classified as master or slave 
components. 

● Master (active bus node): 

Components that represent a master on the bus define data transfer along the bus, and 
are therefore known as active bus nodes. 

Masters components are divided into two classes: 

– DP master class 1 (DPMC1): 

Central master devices are thus designated, which exchange information with the 
slaves in specified message cycles. 

Examples: SIMOTION D435, C240, P350, SIMATIC S7, etc. 

– DP master class 2 (DPMC2): 

These are devices for configuration, commissioning, and operator control and 
monitoring while the bus is in operation. 

Examples: Programming devices, operator control/monitoring devices 

● Slaves (passive bus nodes): 

These devices may only receive, acknowledge and transfer messages to a master when 
so requested. 

Examples: SINAMICS drives, I/O modules 

Functions on PROFIBUS DP 
The functional scope can differ between DP masters and DP slaves. The functional scope is 
different for DP-V0, DP-V1 and DP-V2. 

These functions on the PROFIBUS DP are characterized by: 

● Configurable equidistant isochronous PROFIBUS cycle 

● Synchronization of slaves by the master by means of a global control message frame in 
each cycle clock 

● Independent maintenance of the equidistant cycle clock by the slaves in the event of a 
short-term communication failure 
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Additional references 
You will find additional information about PROFIBUS DP in the SIMOTION Communication 
System Manual. 

See also 
Connection rules in the PROFIBUS subnet (Page 69) 

6.3.2 Operating SIMOTION D4x5 on PROFIBUS DP. 

PROFIBUS DP interface (X126, X136)  
SIMOTION D4x5 provides two interfaces for connection on the PROFIBUS DP. 
Transmission rates up to 12 Mbit/s are possible. Both interfaces can be operated 
isochronously.  

The X136 interface can also be used as an MPI interface. 

As supplied, both PROFIBUS DP interfaces are preset as a master with address 2 and a 
transmission rate of 1.5 Mbit/s. The PROFIBUS DP network is automatically created for this 
setting. 

However, other settings can also be configured. This requires that you configure the network 
manually using HW Config and NetPro. 

 

 Note 

Communication with the SINAMICS Integrated of a D4x5 or CX32 is always equidistant. 
Here, SIMOTION D4x5 is the master and the SINAMICS Integrated drives are slaves. 
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Master-slave configuration 
The master/slave configuration can be used, for example, to establish hierarchical 
PROFIBUS networks that can be used to implement a modular machine concept. 

Table 6- 1 Master-slave configuration 

X126 X136 Note Actions in the application
DP slave, 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X136), application 
controls synchronization to DP slave (X126) 
Internal drive is synchronous with external cycle clock 
Cycle clock DP-136 = cycle clock DP Integrated 

DP master/DP slave 
synchronization 
mechanisms 

DP master, 
isochronous 

DP slave, 
isochronous 

Application synchronized to DP master (X126), application 
controls synchronization to DP slave (X136) 
Internal drive is synchronous with external cycle clock 
Cycle clock DP-126 = cycle clock DP Integrated 

DP master/DP slave 
synchronization 
mechanisms 

DP slave, 
isochronous 

DP master, not 
isochronous 

Application synchronized to DP slave (X126) 
(can be monitored by the application) 
Internal drive is synchronous with X126 

DP slave 
synchronization 
mechanisms 

DP master, not 
isochronous 

DP slave, 
isochronous 

Application synchronized to DP slave (X136)  
(can be monitored by the application)  
Internal drive is synchronous with X136 

DP slave 
synchronization 
mechanisms 

DP master, 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X126, X136) 
Internal drive is synchronous with external cycle clock 
Cycle clock DP-126 = cycle clock DP-136 = cycle clock 
DP Integrated  

None 

DP master, 
isochronous 

DP master, not 
isochronous 

Application synchronized to DP master (X126) 
Internal drive is synchronous with X126 
Cycle clock DP-126 = cycle clock DP Integrated 

None 

DP master, 
isochronous 

DP slave, not 
isochronous 

Application synchronized to DP master (X126) 
Internal drive is synchronous with X126 
Cycle clock DP-126 = cycle clock DP Integrated 

None 

DP master, not 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X136) 
Internal drive is synchronous with X136 
Cycle clock DP-136 = cycle clock DP Integrated 

None 

DP slave, not 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X136) 
Internal drive is synchronous with X136 
Cycle clock DP-136 = cycle clock DP Integrated 

None 

DP master, not 
isochronous 

DP master, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP slave, not 
isochronous 

DP master, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP master, not 
isochronous 

DP slave, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP slave, not 
isochronous 

DP slave, not 
isochronous 

Application synchronized to internal drive cycle clock None 
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X126 X136 Note Actions in the application
DP slave, 
isochronous 

DP slave, not 
isochronous 

Application synchronized to DP slave (X126) (can be 
monitored by the application) 
Internal drive is synchronous with X126 

DP slave 
synchronization 
mechanisms 

DP slave, not 
isochronous 

DP slave, 
isochronous 

Application synchronized to DP slave (X136)  
(can be monitored by the application)  
Internal drive is synchronous with X136 

DP slave 
synchronization 
mechanisms 

For detailed information about controlling synchronization across the application, see the 
Basic Functions for Modular Machines Description of Functions. 

Alternatively, the X136 interface can be used as an MPI interface with a transmission rate of 
19.2 kbit/s up to 12 Mbit/s.  

6.3.3 Assignment of the PROFIBUS addresses in HW Config 

Assigning PROFIBUS addresses 
In order for all devices to communicate with each other, you must assign a PROFIBUS 
address to each device before connecting them:   

 

 Note 

Before you assign any PROFIBUS addresses, please remember that all addresses must be 
unique on the PROFIBUS subnet. 

 

You set these PROFIBUS addresses individually for each device with the PG/PC using HW 
Config. Some PROFIBUS DP slaves have a switch for this purpose.  

 

 Note 

The PROFIBUS addresses set at the devices using these switches must correspond with the 
address settings in HW Config. 

 

Recommendation for PROFIBUS addresses 
Reserve PROFIBUS address "0" for a service programming device and "1" for a service HMI 
device, which will be connected to the subnet if required. 

Recommendation for the PROFIBUS address of the SIMOTION D4x5 in case of 
replacement or service: 

Reserve address "2" for a SIMOTION D4x5. This prevents duplicate addresses from 
occurring when a SIMOTION D4x5 is installed in the subnet using default settings (for 
example, when replacing a SIMOTION D4x5). You should therefore assign addresses 
greater than "2" to additional units on the subnet. 
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See also 
Connection rules in the PROFIBUS subnet (Page 69) 

6.3.4 Setting the DP cycle and system cycle clocks 
All cycle clocks for SIMOTION D4x5 are based on the DP cycle of SINAMICS Integrated, 
which must be set in HW Config.  

To do so, click the SINAMICS block on the integrated PROFIBUS. The "DP Slave 
Properties" dialog box opens. You can adjust the DP cycle of the SINAMICS Integrated on 
the "Isochronous mode" tab.  

Table 6- 2 Range of values for SIMOTION D4x5 

 D425 D435 D445/D445-1 
DP cycle ≥ 1 ms ≥ 1 ms ≥ 0.5 ms 
Grid 0.125 ms 0.125 ms 0.125 ms 
Min. IPO cycle ≥ 2 ms ≥ 1 ms ≥ 0.5 ms 

 

External DP interfaces can only be operated with a DP cycle of ≥ 1 ms.  

The SINAMICS Integrated always runs in isochronous mode. The DP cycle setting of the 
SINAMICS Integrated is displayed as the "Bus cycle clock" in the "System Cycle Clocks" 
dialog box. In SIMOTION SCOUT, select SIMOTION D4x5 and then select the "Set System 
Cycle Clocks" option in the "Target System" > "Expert" menu item. 

The table below shows the possible ratio settings for the SIMOTION D4x5 system cycle 
clocks based on the bus cycle clock.  

Table 6- 3 Ratios of system cycle clocks 

Bus cycle clock: Servo cycle clock Servo cycle clock: IPO cycle Servo cycle clock: IPO 2 
cycle clock 

1:1 …1:4, 1:8 1:1 … 1:6 1:2 … 1:64 

 

In addition, if the DP interfaces (DP1/DP2) are configured as equidistant master interfaces, 
you must set both DP cycles equal to the bus cycle clock of the SINAMICS Integrated in HW 
Config. 

If the DP interfaces (DP1/DP2) are operated as the master, the system cycle clocks are 
obtained from an internal cycle clock of the module. Of the two DP interfaces (DP1/DP2), no 
more than one can also be operated as an isochronous slave interface. In this case, the 
system cycle clocks are obtained from the cycle clock of the slave interface.  

As a result, the task system of SIMOTION and SINAMICS Integrated runs synchronously to 
the slave cycle clock. This assumes that a slave cycle clock exists and synchronization with 
the slave cycle clock has been achieved. If this is not the case, the system cycle clocks are 
acquired from an internal replacement clock. 
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When the project is downloaded, the cycle clock configuration is downloaded to the 
SIMOTION D4x5 and automatically set according to the specifications. 

See also 
Setting a send cycle clock and a system cycle clock (Page 132) 

Settings for DP slave properties (Page 190) 

6.3.5 Cycle clock scaling of external PROFIBUS interface to internal PROFIBUS 
interface 

Definition 
Cycle clock scaling means that an external PROFIBUS interface of the SIMOTION D4x5 
(X126/X136) can be operated in an integer multiple of the internal PROFIBUS interface. This 
reduces the CPU load, thereby allowing you to operate more axes, for example. The settings 
of the scaled cycle clocks for the external DP interfaces are made in HW Config.  

Boundary conditions 
The following boundary conditions are applicable to cycle clock scaling: 

● An external DP interface of D4x5 is used as an isochronous slave interface. Only in this 
case can an integer cycle clock scaling of isochronous external DP slave interface to 
internal interface be specified. This is checked during compilation and an error message 
is output in the event of noncompliance. If the external DP interfaces are configured as 
equidistant interfaces but none are configured as slaves and cycle clock scaling is 
specified for these interfaces, an error is output during compilation. 

● For SERVO, IPO, and IPO2, settings can also be made for all permissible cycle clocks. 
Master and slave axes can run in different IPO levels. Different cycle clocks and phase 
offsets are tolerated by the system. 

  Note 

The IPO cycle clock of the IPO in which the Synchronous Operation technology object 
runs must be set equal to the cycle clock of the equidistant external DP slave interface. 

● The second external DP interface can be operated as an equidistant master (while the 
other is an equidistant slave) in order to operate external drives, for example. In this case, 
the cycle clock must be the same as the cycle clock of the internal PROFIBUS DP. If this 
condition is not satisfied, an error message is output during compilation. 

● One or both external DP interfaces can also be operated as non-isochronous, free-
running interfaces. In this case, there is no effect on the cycle clock settings. 
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Example of an application 
The system consists of a synchronous master (DP master) and at least one SIMOTION 
D4x5 synchronous slave (DP slave). The synchronous master contains the master axis; the 
synchronous slave contains the following axes: 

● The axes in SINAMICS Integrated of the D4x5 synchronous slave must exhibit high 
performance with a servo cycle clock of 1 ms and an internal DP cycle of 1 ms. This 
requires that the internal fast PROFIBUS DP be decoupled from the slower external 
PROFIBUS DP. 

● The PROFIBUS DP has, for example, a cycle time of 4 ms due to the quantity framework 
on the bus; in all cases, its cycle time exceeds that of the cycle clock of the internal DP 
interface. 

● The master setpoints are transferred via the DP bus. Further nodes can also be 
connected to the DP bus, e.g. DP drives, distributed I/Os, etc. 

 
Figure 6-5 Example application for a cycle clock scaling 
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6.3.6 Creating a new PROFIBUS subnet 

Introduction 
SIMOTION SCOUT is used to network the SIMOTION D4x5. During the configuration 
process, the desired bus parameters can be set for the PROFIBUS DP interfaces. 

 

 Note 

If a hardware configuration is loaded without a PROFIBUS network (DP1 or DP2) being 
configured on the CPU, a new PROFIBUS address that was previously set in HW Config or 
NETPRO will not be accepted by the CPU. 

 

Requirement 
You have created a project and have already inserted a SIMOTION D4x5. 

Procedure 
To create a new subnet, proceed as follows:   

1. In the project navigator, double-click D4x5 to access HW Config. 

2. In the SIMOTION D4x5 representation, double-click the interface for which you want to 
create a PROFIBUS subnet. 

The "DPx Properties" dialog box is opened. 

3. Click "Properties" to show the "PROFIBUS Interface DPx" dialog box. 

4. Click "New" to call the "Properties - New PROFIBUS Subnet" dialog. 

5. Name the new subnet and enter the properties of the new subnet, such as transmission 
rate, on the "Network Settings" tab. 

6. Confirm with "OK" to accept the settings. 

The new subnet is now displayed in the "Properties - PROFIBUS Interface DPx" dialog. 
You can now connect the new subnet to the corresponding PROFIBUS interface. 

Follow the same steps to configure the second PROFIBUS interface. 

A graphical representation of the PROFIBUS subnet you have created is shown in HW 
Config. 
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6.3.7 Modifying the data transmission rate 

Introduction 
You can modify the transmission rate in a PROFIBUS subnet in HW Config according to 
your requirements.    

Procedure 
1. Open the project in SIMOTION SCOUT. 

2. Double-click the device whose PROFIBUS subnet you want to configure. 

HW Config is displayed showing the settings for this device. 

3. In HW Config, double-click in the graphical display on the PROFIBUS network whose 
transmission rate you want to configure. 

The "Properties - DP Master System" dialog is displayed. 

4. Click on "Properties" to display the "PROFIBUS Properties" dialog. 

5. Select the required transmission rate on the "Network settings" tab. 
If you wish to activate an equidistant bus cycle, the setting can be made under "Options". 

6. Confirm with "OK". 

7. Save and compile the new hardware configuration, and load it on the SIMOTION D. 

 

 Note 

If you modify the transmission rate of the subnet over which you are operating the PG/PC, 
the PG/PC loses its active designation. You must then reconfigure it manually in NetPro or 
else you will no longer be able to go online by means of this PG/PC.  

 

 
 

 Note 

PROFIBUS DP functionality is both equidistant and isochronous in nature. As such, it can 
guarantee that bus cycles will have exactly the same length and ensures deterministic 
behavior.  
Applications: Connecting drives or synchronized I/O devices. 

 

See also 
Function Manual SIMOTION SCOUT Basic Functions, Chapter Isochronous I/O processing 
on fieldbus systems 
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6.3.8 Establishing a PG/PC assignment 

Introduction 
A PG/PC is required to create projects for a SIMOTION D4x5 and download them to the 
target device. The interface via which the PG/PC can be connected is polled during the 
automatic communication configuration. If you change these settings, you must reestablish 
the active designation of the PG/PC in NetPro. (The PG/PC connection must appear yellow 
and bold in NetPro.)  

Procedure  
1. Open the project in SIMOTION SCOUT. 

2. Click the "Open NetPro"  button. 

NetPro is accessed, and the configured network is graphically displayed. The PG/PC 
connection to the configured network is shown in bold in a color other than yellow. 

3. Double-click the PG/PC you would like to configure. 

The "Properties - PG/PC" dialog will be displayed with the "Assignment" tab in 
foreground. 

4. Select the interface in the "Assigned" field and activate S7ONLINE access by clicking the 
appropriate checkbox. 

5. Click "OK" to accept the settings. 

The PG/PC connection to the configured network is displayed again in bold and yellow. 

6. Save and compile the changes and download them to the SIMOTION D4x5. 

You can now go online via the PG/PC once again.  

Alternatively, you can make the assignment in SIMOTION SCOUT by clicking the "Assign 
PG/PC" button. This calls the properties window for PG/PC assignment, where you can 
modify the assignment and "activate" it (S7ONLINE access). 
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6.4 Configuring an Ethernet subnet 

6.4.1 Configuring an MPI bus 

6.4.1.1 Operating the X136 interface as MPI 
The X136 interface can also be used as an MPI interface, for example, to connect to an 
external PG/PC.  

When the X136 interface is used as an MPI bus, additional activation of a drive on this 
interface is not possible. 

 
Figure 6-6 Connection of D4x5 (using X136) and MPI bus component 

6.4.1.2 MPI parameters 

MPI bus addresses and data transmission rate 
Every node on the MPI bus must have a bus address in the range 0 to 31. 

The data transmission rate on the MPI bus can be set to any value for the SIMOTION D4x5.  

Communication attempt unsuccessful 
If communication cannot be established at all, or if it cannot be established with individual 
nodes on the MPI bus, check the following elements: 

● Is the transmission rate setting for the D4x5 used for all nodes? 

● Are there any loose plug connections? 

● Are all bus segments terminated properly? 

Bus segments that are not terminated properly will disrupt communication on the MPI 
bus. 
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6.4.2 Properties of the Ethernet interfaces 

Properties 
SIMOTION D4x5 has two onboard Ethernet interfaces (X120 and X130). You can connect 
an Industrial Ethernet with a transmission rate of 10/100 MBit/s to the 8-pin X120 and X130 
RJ45 sockets.  

There is no HUB/switch functionality, i.e. message frames are not forwarded from one 
interface to the other. The interfaces belong to separate Ethernet subnets. SIMOTION D4x5 
does not have any router functionality; it does not forward the message frames from one 
subnet to another.  

The features of the Ethernet interfaces are as follows: 

● TCP/IP timeout parameters can be set once for both interfaces. 

● The transmission rate/duplex can be set individually for the two interfaces. 

● The interfaces do not have autocrossing functionality. 

Ethernet communication 
SIMOTION D4x5 offers the following functions via Industrial Ethernet: 

● Communication with STEP 7, SIMOTION SCOUT, and SIMATIC NET OPC via a PG/PC 

● Communication via UDP (user datagram protocol) with other components, e.g. other 
D4x5 devices 

● Communication with other devices via TCP/IP 

● Connection of SIMATIC HMI devices such as MP27x, MP37x, or PC-based HMIs 

● IT communication (SIMOTION IT DIAG, SIMOTION IT OPC XML-DA; as option: 
SIMOTION IT Virtual Machine) 

Routing 
"Services via TCP" are supported for both Ethernet interfaces.  
From the two Ethernet interfaces, S7 routing is possible to the  

● PROFIBUS interfaces and 

● PROFINET interfaces (as of V4.1 SP2). 

● As well as between the Ethernet interfaces 

IP routing from one Ethernet interface to another, as well as from PROFINET to the Ethernet 
interface and vice versa, are not possible.  

You can find the MAC addresses on the nameplate located on the front of the SIMOTION 
D4x5. 
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See also 
Further information about routing and the differences between IP and S7 routing can be 
found in the Communication System Manual.  

Default Ethernet addresses 
The following addresses are set on the module when shipped: 

X120 (IE1/OP) 

● IP address: 192.168.214.1 

● Subnet mask: 255.255.255.0 

● Router address: 0.0.0.0 

 

X130 (IE2/NET) 

● IP address: 169.254.11.22 

● Subnet mask: 255.255.0.0 

● Router address: 0.0.0.0 

  Note 

The IP addresses 192.168.215.240 to 192.168.215.255 are reserved for internal 
communication in SIMOTION D4x5 (subnet mask 255.255.255.240). When configuring 
the external Ethernet interfaces (X120 and X130) it has to be observed that the internal 
addresses are not inside their network. (In IP, the network is defined as an AND link of IP 
address and subnet mask.) 

  Note 

If you want to go online via Ethernet, you have to make sure that the connection from 
PG/PC to SIMOTION D4x5 is active. You can check this in NetPro. A description of how 
to switch a connection to active again can be found in Establishing the PG/PC 
assignment (Page 123). 

Separate Ethernet interfaces 
The two Ethernet interfaces are entirely separate and must be connected to two different 
networks.  
The two Ethernet interfaces support: 

● S7 routing (as of V4.1 SP2) 

● No IP routing 

SIMOTION D4x5 can, therefore, be connected to the machine user's internal company 
network with one interface and the second can be used, for example, by the machine 
manufacturer for the purpose of remote maintenance.  
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The Ethernet connection of the D4x5 can be configured in HW Config. Proceed as follows to 
do this:  

1. Open your project. 

2. Open HW Config. Double-click the D4x5 module to open the "Properties - D4x5" dialog 
box. 

3. You can configure the Ethernet connection in the "Extended Ethernet" tab.  
Recommendation: Use the default setting "Automatic setting". With Automatic setting, the 
baud rate and duplex operating mode are automatically aligned with the connection 
partner. 

4. Close the "Properties - D4x5" dialog with "OK". 

5. Save and compile the modified hardware configuration. 

6. Load the new hardware configuration to the SIMOTION D4x5 via PROFIBUS 
DP/Ethernet. 

For additional information, refer to the  
SIMATIC NET Industrial Twisted Pair and Fiber Optic Networks Manual.  
See the list of references for the order number (this is a separate document). 

For further information about the cabling spectrum for Ethernet, see the  
Industrial Communication IK PI catalog.  

6.4.3 Configuring Ethernet addresses in HW Config 

Requirement 
For configuration using Industrial Ethernet, SIMOTION D4x5 must be provided with an IP 
address, the subnet mask, and the router address. 

 

 Note 

Only one router may be configured. 
 

Procedure 
To configure and transfer Ethernet addresses to the D4x5, proceed as follows:  

1. Open your project. 

2. Open HW Config. Double-click the interface to be configured to open the "Properties" 
dialog box. 

3. On the "General" tab, click the "Properties" button of the Ethernet interface. The 
"Properties - Ethernet Interface" dialog is displayed. 

4. Click the "New" button. The "New Industrial Ethernet" subnet dialog is displayed. In this 
dialog box, you can change the name of the new subnet or confirm the default setting 
with "OK". 
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5. The newly created Ethernet subnet is now displayed under "Subnet" in the "Properties - 
Ethernet Interface" dialog box and must be selected. 

6. In this dialog box, enter the required addresses for "IP Address" and "Subnet". Under 
"Router", choose whether a router is to be used. If using a router, enter the router 
address. 

7. Confirm this dialog box with "OK". 

8. Close the "Properties" dialog by clicking "OK". 

9. To configure the second Ethernet interface, open the "Properties" dialog of the second 
interface and repeat Steps 3 to 7. 

10. Save and compile the modified hardware configuration. 

11. Load the new hardware configuration to the SIMOTION D4x5 via PROFIBUS 
DP/Ethernet. 

6.4.4 Reading out IP and MAC address 

Requirement 
To read out the IP and MAC addresses, the following requirements must be met: 

● SIMOTION D4x5 is wired. 

● You have assigned the communication parameters. 

● You are online. 

Procedure 
The IP addresses and MAC addresses of SIMOTION D4x5 can be displayed as follows via 
SIMOTION SCOUT. 

1. Right-click the module. 

2. Select "Target Device" > "Device Diagnostics" in the context menu. 

The examples below show how addresses are displayed: 

X120 (IE1/OP) 

● Active MAC Address: 08-00-06-73-25-3E 

● IP address: 192.168.214.1 

● Subnet mask: 255.255.255.0 

● Standard gateway: No router used 

X130 (IE2/NET) 

● Active MAC Address: 08-00-06-73-25-3F 

● IP address: 169.254.11.22 
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● Subnet mask: 255.255.0.0 

● Standard gateway: No router used 

As an alternative, you can set the IP address as follows:  

● By selecting "Project" > "Accessible nodes" in SIMOTION SCOUT or 

● By calling "Target system" > "Ethernet" > "Edit Ethernet Node..." in HW Config and 
browsing to "Online accessible nodes". 

● Using the system function _getIpConfig 

  Note 

The MAC address is listed on the nameplate on the front of the module. 

6.5 Configuring PROFINET IO 

6.5.1 General information about communication via PROFINET IO 

Communication cycle 
In PROFINET, the communication cycle is subdivided into different, time-specific intervals. 
The first interval is used for isochronous real-time communication (IRT), followed by real-
time communication (RT) and standard TCP/IP communication. The bandwidth reservation 
for IRT ensures that RT communication and standard communication have no effect on the 
transmission of IRT message frames, which are important for motion-control applications. 

The following figure shows how the PROFINET communication cycle is divided into 
isochronous real-time communication (IRT), real-time communication (RT), and standard 
TCP/IP communication. 
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Figure 6-7 PROFINET communication cycle 

Isochronous realtime Ethernet 
STEP 7 V5.4 and higher can be used to configure PROFINET devices supporting data 
exchange via isochronous real-time Ethernet (IRT). IRT message frames are transferred 
deterministically via planned communication paths in a defined sequence to achieve the best 
possible synchronism and performance.  

IRT requires special network components supporting a planned data transmission.  

Equidistance and Cycle Clock Synchronization 
What is possible for PROFIBUS DP with isochronous bus cycles and clock synchronization, 
also functions for PROFINET IO.  

For PROFIBUS DP, in isochronous operation all nodes are synchronized using a global 
control signal created by the DP master.  

In PROFINET IO with IRT, a sync master generates a signal to which sync slaves 
synchronize themselves. Sync master and sync slaves belong to a sync domain which is 
assigned a name via configuration. The role of the sync master can in principle be played by 
an I/O controller as well as an I/O device. A sync domain has exactly one sync master.  

Context: Sync domain and I/O systems 
An important fact is that sync domains do not need to be limited to one PROFINET IO 
system: The devices of several I/O systems can be synchronized by a single sync master, 
provided they are connected to the same Ethernet subnet.  

The following applies the other way around: An I/O system must only belong to a single sync 
domain.  
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Signal propagation delays not negligible 
For the extremely exact synchronization interval, line lengths, namely the associated delay 
times, must be taken into consideration. You can use a topology editor to enter the 
properties of the lines among the ports of the switches. STEP 7 uses this data and the other 
configuration data to calculate the optimized process of the IRT communication and the 
resulting update time.  

IRT runs in parallel to realtime and TCP/IP communication 
Apart from IRT communication for which a defined bandwidth is reserved within the update 
time, RT communication and TCP/IP communication are also permitted within the update 
time.  

With RT communication (real-time communication), the cyclic data is transferred between IO 
controller and IO device, though without "best possible synchronism". 

With non-synchronized IO devices, data is exchanged automatically via RT communication.  

Due to the fact that TCP/IP communication is also possible, other non-realtime data, e.g. 
configuration data or diagnostic data, can be transported. 

PROFINET IO controller 
Typically, the function of a PROFINET IO controller is taken on by controllers (e.g. 
SIMOTION C/P/D, SIMATIC S7 CPUs, ...). 

The PROFINET IO controller takes on the master function for I/O data communication of the 
distributed field devices. The function is comparable to a PROFIBUS DP master class 1. 

PROFINET IO device 
Distributed field devices such as I/Os, drives (e.g. SINAMICS S120 with CBE20), or operator 
terminals are designated as IO devices. The function is comparable to a 
PROFIBUS DP slave.  

Delivery condition 
In the delivery condition the CBE30 does not have an IP address or a subnet mask. 
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6.5.2 Setting a send cycle clock and a system cycle clock 

Setting the DP cycle in HW Config 
All cycle clocks for SIMOTION D4x5 are based on the DP cycle of SINAMICS Integrated, 
which must be set in HW Config.  

To do so, click the SINAMICS block on the integrated PROFIBUS. The "DP Slave Property" 
dialog box opens. You can adjust the DP cycle of the SINAMICS Integrated on the 
"Isochronous mode" tab. See also Additional information on configuring the SINAMICS 
Integrated (Page 190).  

Table 6- 4 Range of values for SIMOTION D4x5 

 D425 D435 D445/D445-1 
DP cycle ≥ 1 ms ≥ 1 ms ≥ 0.5 ms (DP internal) 

≥ 1.0 ms (DP external) 
Grid 0.125 ms 0.125 ms 0.125 ms 
IPO cycle ≥ 2 ms ≥ 1 ms ≥ 0.5 ms 

Setting the send cycle clock in HW Config 
The send cycle clock for PROFINET IO must be set in the "Domain Management" dialog in 
HW Config. To do this, select the "Edit" > "PROFINET IO" > "Domain management ..." menu 
command in HW Config and set the desired cycle clock. 

The configured PROFINET send cycle clock is displayed in SIMOTION SCOUT as the "Bus 
Cycle Clock" in the "System Cycle Clocks - D4x5" dialog. Select SIMOTION D4x5 and then 
select the "Set System Cycle Clocks" option in the "Target System" > "Expert" menu item. 

The PROFINET interface can be operated with a send cycle clock in the range of: 0.5 ms ≤ 
send cycle clock ≤ 4 ms. The smallest configurable grid is 0.125 ms.  

If there are IO devices with RT class "RT" in a sync domain, it is only possible to set the 
send cycle clocks 0.5 ms, 1 ms, 2 ms and 4 ms. 
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Cycle clock scaling 
When PROFINET is operated isochronously, the servo cycle clock must always correspond 
to the PROFIBUS cycle clock. The servo cycle clock and the PROFIBUS cycle clock can be 
scaled to the PROFINET cycle clock. 

Example: 
PROFINET sending cycle = 0.5 ms 
PROFIBUS cycle clock = position control cycle clock =1 ms 

The PROFIBUS cycle clock can operated relative to the PROFINET cycle clock at a ratio of 
1:1 to 1:16. 

The table below shows the possible ratio settings for the SIMOTION D4x5 system cycle 
clocks based on the DP cycle of SINAMICS Integrated or PROFINET send cycle clock. 

Table 6- 5 Ratios of system cycle clocks 

DP cycle/send cycle clock: Servo cycle clock Servo cycle clock: IPO 
cycle clock 

IPO cycle clock: IPO 2 
cycle clock 

1:1 ... 1:4, 1:6, 1:8, 1:10, 1:12, 1:14, 1:16 1:1 ... 1:6 1:2 ... 1:64 

6.5.3 Properties of PROFINET 

Properties 
In order to work with SIMOTION D4x5 over PROFINET IO, the Communication Board 
Ethernet CBE30 must be inserted into the option slot on the SIMOTION D4x5.  

The PROFINET IO IRT module CBE30 supports parallel operation of: 

● IRT - isochronous real-time Ethernet 

– Operation of IRT I/O (e.g. ET 200S) 

– Operation of a SINAMICS S120 as an IRT device 

● RT - realtime Ethernet 

– Operation of RT I/O (e.g. ET 200S, ET 200pro, etc.) 

– Operation of a SINAMICS S120 as an RT device 

● TCP/IP, UDP, HTTP, … standard Ethernet services 

  Note 

For mixed operation of IRT and RT, make sure that the IRT-compatible devices form what 
is referred to as an IRT domain; i.e. there must not be any non-IRT devices on the data 
transmission link between the IRT devices. 
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Additional references 
You will find an overview of the specific properties of PROFINET IO on SIMOTION D4x5 in 
the SIMOTION Communication System Manual. 

6.5.4 Configuration tasks 
Configuration of PROFINET involves the following steps: 

1. Insert the SIMOTION D4x5. 

2. Insert and configure the CBE30 module in HW Config. 

3. Create a topology: Here, you specify how the individual ports of the PROFINET IO 
devices are interconnected. 

4. Configure the sync domain: Here, you specify which PROFINET nodes are sync masters 
(clock generator) and sync slaves. 

5. Specify the send clock: Describes the time during which a PROFINET IO device 
exchanges user data with the PROFINET IO controller. 

6. Configure the direct data exchange: With the direct data exchange you define which 
address areas are to be used for sending and which for receiving. 

Additional references 
You will find a detailed description of each configuration step in the chapter entitled 
"Configuring PROFINET IO with SIMOTION" of the SIMOTION Communication System 
Manual. 
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Commissioning (software) 7
7.1 Overview of commissioning 

Requirements 
The following requirements must be fulfilled in order to commission the SIMOTION D:  

● The system has been connected and wired. 

● The SIMOTION D has been switched on and powered up (STOP mode). 

● SIMOTION SCOUT (with integrated STARTER) has been installed and powered up on 
the PG/PC. 

● The communication and networks have been configured. 

● You have created a project and inserted a SIMOTION D in the project. 

  Note 

The order numbers (MLFB) of the SINAMICS S120 components must be available. 

You need these order numbers when setting up a SIMOTION project to verify that the 
components selected from the hardware catalog in the HW Config application correspond 
to the ones used in the system. 

7.1.1 Symbolic assignment / adaptation 

Symbolic assignment 
As of V4.2, SIMOTION supports the symbolic assignment on SINAMICS drive objects (DOs) 
during the configuration of technology objects (TO) and I/Os. 

This simplifies the configuration of the technological relationships including the 
communication between controller and drive. 

With the symbolic assignment: 

● Only suitable assignment partners are offered in an assignment dialog box 

● Commmunication between axis and drive is set up automatically by the engineering 
system and the required PROFIdrive axis message frames as well as the used addresses 
set up 

● Message frames are extended and interconnections created automatically in the drive 
depending on the selected TO technology (e.g. SINAMICS Safety Integrated) 
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● Axis and drive configuration can initially be carried out independently of one another 

● Communication connections are established automatically during the configuration of I/O 
variables on SINAMICS I/Os (message frames are set up automatically, the I/Os 
interconnected to the message frame and the addresses set up) 

Apart from the symbolic assignment, no further configuration is required for the 
communication. As addresses no longer have to be configured, the connection is retained 
even with address offsets.  

 

 Note 

During the configuration of drive objects (DO drive, DO encoder, ...) as well as in the 
Message Frame Configuration dialog box (see Section Message frame configuration 
(Page 216)), you can deactivate the automatic message frame configuration and the 
automatic message frame adaptation. 

As many of the previously described advantages are lost through a deactivation, we 
recommend that a deactivation only be performed in exceptional circumstances. 

 

The symbolic assignment enables an independent configuration of the axes on the 
SIMOTION side and the drives on the SINAMICS side. 

This enables, for example:  

● The PLC and motion control functions to be completely configured by a programmer even 
without drive know-how using technology objects (e.g. TO axis) and loaded to the device 

● The drives to be separately configured and optimized by a drive expert and 

● The technology objects to be symbolically assigned later to the drive objects via an 
interconnection dialog box 

  Note 

The previous methods of drive, axis and I/O configuration are still available.  
The symbolic assignment must be deactivated for these methods. 

For newly created projects, the symbolic assignment is used per default. 

If projects < V4.2 are upgraded, the symbolic assignment is deactivated per default and 
must be activated when required. 

The symbolic assignment can be activated/deactivated in SIMOTION SCOUT via the 
menu  
"Project" > "Use symbolic assignment".  

Activating the symbolic assignment later 
The symbolic assignment simplifies the configuration of the technological relationships 
including the communication between controller and drive significantly. The names of the 
symbolic assignments in plain text is also advantageous for project maintenance. The 
symbolic assignment is therefore recommended for new projects as of V4.2 and is 
automatically active.  
If symbolic assignment is used in a project, message frames, interconnections and 
addresses are automatically created by the engineering system per default. 



 Commissioning (software) 
 7.1 Overview of commissioning 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 137 

The engineering system sets the "optimal" PROFIdrive message frames and message frame 
extensions for the system, makes the required BICO interconnections and determines the 
addresses. 

It is also possible to change updated projects to symbolic assignment and this must be 
decided individually, as follow-up work may be required. 
Extensive follow-up work is usually required, particularly for free message frame 
configurations (e.g. for TB30, TM15 DI/DO, TM31).  

 

 Note 

If symbolic assignment is subsequently activated for a project in which message frames 
have already been configured and interconnected, these can be changed together with the 
BICO interconnections! 

For this reason, make a backup copy of your project before activating the symbolic 
assignment. 

Further details can be found in the SIMOTION SCOUT Basic Functions Function Manual. 
 

Assigning a drive later 
You can create an axis in SIMOTION SCOUT and assign it later to a drive. You can thus 
load your user program to the controller and (with the exception of the non-existent drives) 
test it. 

Compared to a procedure with temporarily created "virtual axes", "axes without assigned 
drive" have the advantage that the configuration data is completely available and do not 
require a "virtual axis -> real axis" reconfiguration. 

Adaptation 
In addition to the symbolic assignment, the automatic adaptation facilitates the configuration 
of SINAMICS S110/S120 data as of SIMOTION V4.2. During power-up of the SIMOTION 
devices, reference variables as well as drive and encoder data of the SINAMICS S110/S120 
are automatically taken over for the configuration data of the SIMOTION technology objects 
"TO axis" and "TO externalEncoder". This data no longer has to be entered in SIMOTION. 

For further information refer to  

● SIMOTION SCOUT Basic Functions Function Manual 

● TO Axis Electric/Hydraulic, External Encoder Function Manual 
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Requirement 
The symbolic assignment is supported by the TO axis, TO externalEncoder and the 
TO outputCam, TO camTrack and TO measuringInput. The onboard I/Os of a SIMOTION D, 
of a SINAMICS S110/S120 control unit as well as from a TB30 and selected terminal 
modules can be interconnected symbolically.  

Table 7- 1 Control units that support a symbolic assignment 

Module Supports symbolic assignment 
SIMOTION D4x5-2 As of SIMOTION V4.2 
SIMOTION D410, D4x5 As of SIMOTION V4.2 
Controller extension 
 CX32-2 
 CX32 

As of SIMOTION V4.2 

SINAMICS S110 CU305 As of SINAMICS V4.3 
SINAMICS S120  
 CU310 
 CU320-2 
 CU320 

 
As of SINAMICS V2.6.2 
As of SINAMICS V4.3 
As of SINAMICS V2.6.2 

See also 
Only the drive configuration by means of symbolic assignment is described in this 
documentation.  

The documentation of older SIMOTION versions can found on the Internet at 
(http://support.automation.siemens.com/WW/view/en/40211807) 

For further information on the configuration of the TO axis and TO externalEncoder, refer to 
the TO Axis Electric/Hydraulic, External Encoder Function Manual. 

 

http://support.automation.siemens.com/WW/view/en/40211807�
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7.1.2 Procedure when commissioning 

Commissioning steps  
This section shows you how to configure a system and test the configured drives and axes. 
The commissioning steps are listed below. The sequence is only an example and can vary 
depending on the supplementary conditions.  

1. Configure the SINAMICS Integrated: 
You can configure the integrated drives (SINAMICS Integrated) offline or online: 

– Offline configuration:  
Performing D4x5 offline configuration (Page 141) and Performing CX32 offline 
configuration (Page 180) 

For offline configuration, all of the components and their order numbers must be 
known.  

– Online configuration:  
Performing D4x5 online configuration (Page 166) and Performing CX32 online 
configuration (Page 183) 

During online configuration, you can download all of the information from the 
connected DRIVE-CLiQ components to your user project. 

  Note 

The next two sections describe how a SIMOTION D4x5 including SINAMICS 
Integrated is configured. The described procedure also applies when CX32 controller 
extensions are used. 

The Section "Configuring a CX32" also describes the step-by-step commissioning with 
a CX32 controller extension. The advantage of a step-by-step configuration is that the 
location and cause of an error are easier to identify. 

2. Testing a drive with the drive control panel 

3. Creating an axis with the axis wizard (Page 204) 

4. Testing an axis with the axis control panel (Page 211) 

5. Activating the infeed (line module) (Page 213) 

6. Setting up addresses and message frames (Page 216) 

7. Linking an additional encoder (optional) (Page 219) 

8. Configuring drive-related I/Os (with symbolic assignment) (Page 226) 

9. Configuring the technology (Page 230) 

10. Optimizing the drive and controller (Page 238) 

This section also contains additional configuration information, e.g. for vector drives, Safety 
Integrated, etc.  
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See also 
Testing a drive with the drive control panel (Page 200) 

Creating and testing axes (Page 203) 

7.1.3 Important functions for the project handling during commissioning 
The following functions are very important for the project handling and commissioning:  

Table 7- 2 Functions with their symbols 

Symbol Function Effect 

 Save project and 
compile all 

Select Save project and compile all to save the 
entire project and compile the project data (e.g. 
programs) in an executable code. 

 Connect to selected 
target devices 

The online connection is established to the selected 
target devices. Under "Target system" > "Select 
target devices", you can set which target devices are 
to go online. 

 Download project to 
target system 

Downloading programs to the SIMOTION device and 
performing configuration for the SINAMICS 
Integrated and any connected CX32 modules 

 Download CPU / drive 
unit to target device 

The configuration is only loaded to the device 
selected in the project tree (which means that the 
function needs to be performed separately for each 
D4x5/CX32 and each SINAMICS Integrated). 

 Load CPU / drive unit 
to PG 

The unit's configuration is only loaded to the 
programming device selected in the project tree 
(which means that the function needs to be 
performed separately for each D4x5/CX32 and each 
SINAMICS Integrated). 

 Copy RAM to ROM Copying from RAM to ROM is only performed for the 
device selected in the project tree (which means that 
the function needs to be performed separately for 
each D4x5/CX32 and each SINAMICS Integrated). 
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 Note 
Tips for going ONLINE: 

In online operation, SCOUT attempts to conduct online operation with all hardware 
components contained in the project. This means that the time needed for going online 
increases.  

We recommend that you make settings for SCOUT so that online operation is made only 
with those components currently needed. The setting can be found at "Target system > 
Select target devices ..." in the menu. The selection and deselection of the devices in the 
online state can be made via the "Connect target device" context menu on the device. 

This procedure is also advantageous when the configuration of the drive unit is completed. 
Without going completely offline, the connection can be simply deselected via the context 
menu on the drive unit.  

 

7.2 Performing offline configuration for the D4x5 

7.2.1 Overview 

Introduction 
In the offline configuration, the project is created without all the hardware components 
(especially drives) being available. In this way, a SIMOTION project in the office environment 
can be created up to a point where a basic project specification including a program exists. 
You can then load the finished project to the SIMOTION D4x5 later and test it with the 
drives.  

Requirements  
● For offline configuration, all of the components and their order numbers must be known. 

● You have created a project in SIMOTION SCOUT and inserted a SIMOTION D4x5 into 
the project in the hardware configuration. 

● You have configured the communication between the SIMOTION D4x5 and the PG/PC. 

See Creating a project and configuring communication (Page 107). 
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Procedure  
Offline configuration involves the following steps: 

● Accessing the drive wizard (Page 142) 

● Configuring components (Page 143) 

● Downloading the project to SIMOTION D4x5, by means of one of the following options: 

– Download to target system (Page 161) 

– Download to the CF card  (Page 163) 

– Download incl. sources and additional data (Page 164) 

– Archiving a project to the CF card (zip file) (Page 165) 

 

 Note 

During offline configuration, you can also configure the available option boards (TB30) and 
terminal modules, e.g. TM41. 

 

7.2.2 Accessing the drive wizard 

Integrated drive 
The SIMOTION D4x5 contains an integrated SINAMICS S120 drive device, which is 
automatically inserted along with the SIMOTION D4x5 control unit in the project navigator. 
The integrated drive must be operated in equidistant, isochronous mode using PROFIdrive-
compliant message frame types.  

The drive wizard for the integrated starter is available in SIMOTION SCOUT for configuring 
the integrated drive and its associated modules (e.g. SINAMICS S120 active line modules 
and SINAMICS S120 motor modules). 

 

 Note 

Take note of all the necessary safety precautions and rules governing connections, which 
can be found in the latest SINAMICS S120 documentation on the SIMOTION SCOUT DVD. 

 

Requirement 
You have created a project and have already inserted a SIMOTION D4x5. 
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Procedure 
To call the drive wizard for the configuration of your drive unit, double-click "Configure drive 
unit" below "D4x5" > "SINAMICS Integrated" in the project navigator.  

You can configure the following components: 

● Infeed (e.g. SINAMICS S120 active line module) 

● Drive 

● Power unit (e.g. SINAMICS S120 motor module) 

● Motor 

● Encoder 

● Option module 

7.2.3 Configuring components 

Requirement 
You have inserted a SIMOTION D4x5 into the project, configured the communication, and 
accessed the drive wizard by double-clicking "Configure Drive Unit" in the project navigator.  

 

 Note 

An overview of permissible configurations, quantity structures and DRIVE-CLiQ topologies 
can be found in the Commissioning Manual for SINAMICS S120.  
It should be noted, for example, that mixed operation of servo and vector is not possible, 
although mixed operation of servo and vector V/fis possible. 

Failure to comply with the rules listed in this manual will result in errors that are not output 
until the download is performed, rather than at the configuration stage. 
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Procedure 
While executing the wizard you will be prompted to perform, for example, the following 
configuration steps:  

1. In the "Option Module" dialog box, select whether you want to use a TB30 as option 
module. 

 
Figure 7-1 Selecting an option module 

  Note 

The TB30 is displayed as a drive object below the control unit in the project navigator and 
can be configured there. 
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2. In the "Insert Infeed" dialog box", select whether you want to use an infeed with or without 
a DRIVE-CLiQ connection. If the DC link has an external supply, select "No" (no 
DRIVE-CLiQ connection). 

 
Figure 7-2 Selecting an infeed with DRIVE-CLiQ connection 

  Note 

If you have selected an uncontrolled infeed without a DRIVE-CLiQ connection, omit steps 
3 to 6 below. 
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3. In the "Infeed Configuration" dialog box, enter a name for the drive object and select a 
type for your infeed (e.g. Active Infeed). 

 
Figure 7-3 Selecting the infeed type 

 

4. Using the order number, select an infeed from the list. You can filter the information to 
limit the number of infeeds displayed, by using "Type", for example. 

 
Figure 7-4 Selecting an infeed 
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5. You can make additional settings for the infeed in the "Infeed Drive Object - Additional 
Data" dialog box. 

 
Figure 7-5 Making settings for the infeed 
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6. The communication for the control of the infeed is configured in the following dialog box. 
It is recommended that these settings be made automatically by the engineering system.  
You can also make the settings manually for the process data exchange by selecting 
"User-defined". 

 
Figure 7-6 Configuring the process data exchange for the infeed  

If the automatic communication setting has been selected, SIMOTION SCOUT uses 
PROFIdrive message frame 370 per default. This message frame is also used by the 
system function _LineModule_control to control the infeed. 

You can find further information on control of the infeed in Section Activating the infeed 
(line module) (Page 213). 

If you are using a CX32 controller extension, also refer to the information in Section 
Interconnecting the infeed "Operation" signal on the CX32 (Page 185). 
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If you activate the line module with "Free message frame configuration using BICO", you 
will have to connect the enabling signal via BICO. You will find information about 
interconnecting signals with BICO technology in the SINAMICS S120 Commissioning 
Manual. 

7. Now configure the drive. 

 
Figure 7-7 Configuring a drive 
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8. Enter a name for the drive and select the type of drive object (servo or vector). 

 
Figure 7-8 Drive properties 

 

9. In the "Control Structure" dialog, you can select the function modules and the control 
type. Here, you can select "Vector" for the V/f control under "Drive objects type". 

 
Figure 7-9 Closed-loop control structure 
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10. In the "Power Unit" dialog box, use the order number to select your motor module from 
the list. 

 
Figure 7-10 Selecting a power unit 
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11. If you have selected an infeed without a DRIVE-CLiQ connection in step 2, a message 
prompting you to wire the operation signal will appear. The next dialog allows you to 
select the source of the infeed's operation signal. 

 
Figure 7-11 Selecting the infeed operation signal 
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12. In the case of double motor modules, you need to specify the terminal to which the motor 
is connected. 

You specify the motor in the following dialog boxes:  

– Either by selecting a standard motor from the list 

– Or by entering the motor data 

– Or by automatically identifying the motor (motor with DRIVE-CLiQ interface) 

 
Figure 7-12 Selecting a drive (1) 

  Note 

Motors with DRIVE-CLiQ interface have an integrated encoder evaluation that is 
connected to the motor module via a fully digital communication interface 
(DRIVE-CLiQ). 

In this way, motor encoder and temperature signals as well as electronic rating plate 
data, such as unique ID numbers, rated data (voltage, current, torque) can be 
transferred directly to the control unit. 
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Figure 7-13 Selecting a drive (2) 
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13. Selecting a motor holding brake (if available). 

 
Figure 7-14 Selecting a motor holding brake. 
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14. If you are using a motor that is not equipped with a DRIVE-CLiQ interface, select the 
encoder order number in the "Encoder Selection via Motor Order Number" dialog box. 

 
Figure 7-15 Selecting a motor encoder (1) 
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Figure 7-16 Selecting a motor encoder (2) 

  Note 

If required, you can configure a second or third encoder in the "Encoder" dialog box. You 
can transfer a maximum of two encoder values to SIMOTION via the axis message 
frame. 

In the case of motors with a DRIVE-CLiQ interface, the motor encoder is identified 
automatically. It is not necessary to enter encoder data in such cases (the dialog for 
selecting Encoder 1 is grayed out and, therefore, inactive). 

 

15. The communication for the control of the SINAMICS drive is configured in the following 
dialog box.  
It is recommended that these settings be made automatically by the engineering system.  
You can also make the settings manually for the process data exchange by selecting 
"User-defined".  
Information about the manual setting options can be found in the online help and in the 
manuals for the SINAMICS S120 drive system. 
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Figure 7-17 Configuring the process data exchange 

After you have configured all of the settings in the drive wizard, the "Summary" dialog 
displays a list of all settings. You can accept these settings with "Finish" or edit the 
configuration of individual components using the "Back" button. 
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Figure 7-18 Finishing the drive 
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Result 
The configured drive will appear in the project navigator. 

 
Figure 7-19 Representation in the project navigator 
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You will find an overview of the configured SINAMICS components under 
"SINAMICS_Integrated" > "Topology". 

 
Figure 7-20 Displaying the topology 

 

See also 
If you configure the message frames for the infeed and drive manually, you can find detailed 
information on the respective message frame types in the following: 

● Motion Control, TO Axis Electric/Hydraulic, External Encoder Function Manual 

● SINAMICS S120 Function Manual 

7.2.4 Downloading a project into the target system 

Requirement 
You have configured the hardware. You now need to download the hardware configuration 
and the entire SIMOTION project to the target system.  

If you have not yet configured your SIMOTION project (i.e. created ST programs, assigned 
execution levels, etc.), complete this step first.  

 

 Note 

You can only perform a project download in the STOP mode and for all target devices with 
which you are ONLINE. You cannot download to drives that cannot be configured in SCOUT, 
e.g MASTERDRIVES. The project data is loaded to all the devices connected ONLINE and 
their subordinate drive units (provided these are selected in the Target Device Selection 
dialog box). This can only be done in STOP mode. 
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Procedure 
1. Save and compile the project. 

2. Go online. 

3. To load the project, perform "Download project to target system".  
The data must also be saved on the CF card to ensure that the project is retained in the 
event of a power failure. The following options are available: 

– Perform the "Copy RAM to ROM..." function manually on the D4x5-and all drives 
(SINAMICS Integrated, CX32, etc.). 

– In the "Download to Target System" dialog box, select the option "After loading, copy 
RAM to ROM". You can change the default setting for this dialog box in "Options" > 
"Settings" > "Download". 

 
Figure 7-21 Download project to target system 

The SIMOTION project is downloaded to the target system and the online connection to 
the drives established automatically.  

  Note 

Online access to the drives is not possible if HW Config is not loaded at the time you 
initially connect to the target system. 

Download HW Config first to enable online access to the drives.  

  Note 

If you have deselected the "Drives" option under "Tools" > "Settings" > "Download" in 
SIMOTION SCOUT, you must download the configuration separately to each drive 
(SINAMICS Integrated, CX32, etc.).  

To do this, select the drive (e.g. SINAMICS Integrated) in the project navigator and 
perform "Download CPU / drive unit to target device".  
For fast operation, we recommend that, in principle, the drives be deselected and a 
download only performed when required. 

4. To save the parameter calculations of the drive in the project, perform "Target device" ⇒ 
"Load CPU / drive unit to PG" for each drive. 
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7.2.5 Downloading a project to the CF card 

Requirement 
Loading a project created offline to the CF card has the advantage of being faster than a 
download. 

It should be noted, however, that the first system power-up will take longer, as the 
SINAMICS Integrated and CX32 controller extension will perform one-off parameter 
calculations. These are automatically backed up on the CF card. 

 

 Note 

In order to save the project data via the PG/PC, you need a CF card adapter in which you 
can insert the CF card. The CF card must be displayed as a removable storage device with 
any drive letter in Windows Explorer. 

If the CF card is not displayed, check the CF card adapter and contact the hotline if 
necessary. 

 

Procedure 
You can use a card adapter to write the entire project to the CF card, even in offline mode. In 
SIMOTION SCOUT, you can call the "Load into file system" function in the context menu of 
the SIMOTION device.  

1. Save and compile the project. 

2. Switch the SIMOTION D4x5 off. 

3. Remove the CF card and insert it into a card adapter. The card adapter must be 
connected to a PG/PC. 

4. In the SCOUT project, select the SIMOTION D4x5 device you wish to download to the 
CF card. 

5. Click "Load into file system" in the context menu. A dialog opens. 

6. In the "Load into file system" dialog, select the "Save normally" option and click the 
"Select target" button. 

7. Select the target drive. 

8. Confirm your entries with "OK". The data is written to the CF card. 
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9. Remove the CF card and insert it into the slot on the D4x5. 

10. Switch the D4x5 on. The D4x5 powers up with the downloaded project. 

  Note 

The components' firmware is upgraded or downgraded automatically based on the FW 
version on the CF card and the FW version on the SINAMICS components (DRIVE-CLiQ 
components, CBE30, PM340, etc.).  

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT.  

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red 
and green: 
 FW update running: RDY LED flashes slowly (0.5 Hz) 
 FW update complete: RDY LED flashes quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW 
update. 

Go offline once all the FW updates have been completed. POWER ON the 
upgraded/downgraded components. 

7.2.6 Loading a project, including sources and additional data 

Overview 
As of SIMOTION V4.1 SP2, it is possible to load additional data (e.g. sources) to the target 
device when saving a project to the CF card or downloading to the D4x5. This data is 
required for: 

● Online object comparison (e.g. additional properties) 

● Various detailed comparisons (e.g. ST source file comparison) 

● Synchronization with online objects 

In order to be able to load a project's sources and additional data to the PG, this must be 
specified in the project under "Options" ⇒ "Settings" ⇒ "Download" ⇒ "Store additional data 
on the target device". 

If the sources and additional data have been saved on the CF card, the option described in 
the sections that follow becomes available. 

Project comparison 
You intend to carry out servicing work on a commissioned system and have brought a 
project on your PC/PG. This project is not consistent with the project on the D4x5 in the 
system. In order to analyze the differences, perform an object comparison via "Start object 
comparison". 
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You have the following options in terms of re-establishing consistency: 

● In the object comparison, it is possible to establish consistency for sources and 
technology objects on an object-granular basis. 

● Consistency can be established for the entire control unit by loading from the CF card via 
"Target system" ⇒ "Load" ⇒ "Load CPU / drive unit to PG...". 

Additional references 
Detailed information on "loading data to the target device" can be found in the SIMOTION 
SCOUT Basic Functions Function Manual. 

7.2.7 Archiving a project to the CompactFlash Card (zip file) 

Procedure 
In SIMOTION SCOUT, you can save the project as a *.zip file to the CF card.  

Proceed as follows to archive the SIMOTION project on the CF card: 

1. Open SIMOTION SCOUT and select the "Project" > "Archive" menu command. 

2. In the "Archive" dialog, select the SIMOTION project and save it to your drive (PG/PC). 

3. Open the project. 

4. Go online with the SIMOTION D4x5. 

5. In the project navigator, select the SIMOTION D4x5 and select the "Target system" ⇒ 
"Load" ⇒ "Save archive project on card..." menu command. 

6. In the dialog that is displayed, select the project and click "Open". This saves the project 
to the CF card as Project.zip in the directory USER\SIMOTION\HMI\PRJLOG. 

  Note 

If you want to load the current project from the card, select the "Target system" ⇒ "Copy 
archived project from card to PG/PC..." menu command. 

Prerequisite is that you have backed up the project with "Save archive project on card..." 
each time a change was made. 

Additional references 
Detailed information on loading data to the target device can be found in the SIMOTION 
SCOUT Basic Functions Function Manual. 
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7.3 Performing online configuration for D4x5 

7.3.1 Overview 

Introduction 
You can configure the plant in online mode after having completed its wiring. You can load 
the data of SINAMICS components connected via DRIVE-CLiQ to your PG/PC using the 
"Automatic configuration" function. However, this is only possible for initial commissioning. 

 

 Note 

Components without DRIVE-CLiQ connection must be edited in offline mode. You may need 
to edit DRIVE-CLiQ components which were detected in the course of automatic 
configuration (for example, adding encoder data if using SMC modules). 

 

Requirements  
● Your system has been mounted and wired. 

● You have created a project in SIMOTION SCOUT and inserted a SIMOTION D4x5 in the 
project. 

● You have configured the communication between the SIMOTION D4x5 and the PG/PC. 

See Creating a project and configuring communication (Page 107). 

Procedure  
Online configuration involves the following steps: 

● Establishing an online connection (Page 167) 

● Starting the automatic configuration (Page 168) 

● Editing SINAMICS components (Page 172) 

● Downloading a project to SIMOTION D4x5 (Page 172) 
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7.3.2 Establish an online connection 

Requirement 
You have created a project. 

Procedure 
This section outlines the procedure for initial commissioning. 

To perform online configuration, you must establish an online connection to the SIMOTION 
D4x5. In this case, no connection can yet be established to the SINAMICS Integrated. An 
appropriate message is output. Once the hardware configuration has been loaded to the 
target device, an online connection to the SINAMICS Integrated is established automatically. 
Proceed as follows: 

1. Save and compile the project. 

2. Establish an online connection. 

3. Highlight the SIMOTION D4x5 device in the project navigator. 

4. Use the "Download CPU / drive unit to target device" function to download the 
SIMOTION D4x5 to the target device. The connection to the SINAMICS Integrated is 
automatically established. 

Result 
Now you can perform the automatic configuration on the SINAMICS Integrated.  
See Section Starting the automatic configuration (Page 168). 

Additional references 
Further information about establishing an online connection to the programming device/PC 
can be found in the following documentation: 

● SIMOTION SCOUT Configuration Manual 

● SIMOTION SCOUT Online Help 

● SIMOTION Utilities & Applications FAQs 
SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 
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7.3.3 Starting the automatic configuration 

Requirements 
You have established the online connection to the SINAMICS Integrated. 

Procedure 
1. In the project navigator, open the "Automatic Configuration" dialog box by selecting 

"SINAMICS Integrated" > "Automatic Configuration".  
 

 
Figure 7-22 Starting the automatic configuration 

 

2. Click the "Configure" button. 

3. If the drive unit is not in the "Initial commissioning" state, the factory settings are restored 
after acknowledging a prompt. 
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4. The drive object types can now be selected via a further dialog box. 
 

 
Figure 7-23 Selecting the drive object type 

5. Select whether a servo- or vector-type drive object is to be used. 

6. Click "Create" to start the automatic configuration. As soon as automatic configuration 
has been run through, an upload operation (Load to PG) is performed automatically. 

  Note 

The components' firmware is upgraded or downgraded automatically based on the FW 
version on the CF card and the FW version on the SINAMICS components (DRIVE-CLiQ 
components, CBE30, PM340, etc.).  

The upgrade can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT.  

A firmware upgrade on DRIVE-CLiQ components is indicated by the RDY LED flashing 
red and green: 
 FW update running: RDY LED flashes slowly (0.5 Hz) 
 FW update complete: RDY LED flashes quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW 
update. 

Go offline once all the FW updates have been completed. POWER ON the  
upgraded/downgraded components. 
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7. At the end of the automatic configuration, you are prompted whether you want to "Go 
OFFLINE" or "Stay ONLINE" with the drive unit. 
 

 
Figure 7-24 Automatic configuration completed 

8. Execute the "Copy RAM to ROM ..." function on the D4x5 and the SINAMICS Integrated. 
This saves the project on the CF card, meaning that it does not need to be reloaded after 
switching off and on again. 
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Result 
The DRIVE-CLiQ components loaded to the user project by means of automatic 
configuration are displayed in the project navigator. 

 
Figure 7-25 Project navigator with real configuration 

You must then  

● If required, reconfigure SINAMICS components (e.g. components without a DRIVE-CLiQ 
interface, such as an encoder connected via SMCxx). 

● Assign the "TO axis" to "Drive" 

See also 
Restoring the default settings of SINAMICS Integrated (Page 253) 
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7.3.4 Editing SINAMICS components 

Requirement 
● You have loaded all connected DRIVE-CLiQ components to your user project. 

● You have shut down the connection to the target system (offline mode). 

Procedure  
You can now adapt your component to the application. 

Run through the wizard for all the DRIVE-CLiQ components to be adapted and perform the 
required reconfigurations.  

This procedure conforms to the description Performing offline configuration for the D4x5 
(Page 141). 

The amount of editing work involved depends on the components used. For example, in the 
case of a motor with a DRIVE-CLiQ interface, the motor and encoder type are identified 
automatically.  

7.3.5 Downloading a project to SIMOTION D4x5 
After you have performed the reconfigurations, you must download the configuration to the 
SIMOTION D4x5 (incl. SINAMICS Integrated).  

1. Save and compile the project. 

2. Go online. 
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3. To load the project, perform "Download project to target system".  
The data must also be saved on the CF card to ensure that the project is retained in the 
event of a power failure. The following options are available: 

– Perform the "Copy RAM to ROM..." function manually on the D4x5-and all drives 
(SINAMICS Integrated, CX32, etc.). 

– In the "Download to Target System" dialog box, select the option "After loading, copy 
RAM to ROM". You can change the default setting for this dialog box in "Options" ⇒ 
"Settings" ⇒ "Download".  
 
 

 
Figure 7-26 Download project to target system  

The SIMOTION project is downloaded to the target system and the online connection to 
the drives established automatically.  

  Note 

Online access to the drives is not possible if HW Config is not loaded at the time you 
initially connect to the target system. 

Download HW Config first to enable online access to the drives.  

  Note 

If you have deselected the "Drives" option under "Tools" > "Settings" > "Download" in 
SIMOTION SCOUT, you must download the configuration separately to each drive 
(SINAMICS Integrated, CX32, etc.).  

To do this, select the drive (e.g. SINAMICS Integrated) in the project navigator and 
perform "Download CPU / drive unit to target device".  
For fast operation, we recommend that, in principle, the drives be deselected and a 
download only performed when required.  

4. To save the parameter calculations of the drive in the project, perform "Target device" ⇒ 
"Load CPU / drive unit to PG" for each drive. 

The drive has been assigned parameters and commissioned. You can now test the drive via 
the drive control panel.  
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See also 
Optimizing drive and closed-loop controller (Page 238) 

7.4 Configuring a CX32 

7.4.1 Overview 
The SIMOTION CX32 controller extension is a component in SINAMICS S120 booksize 
format and supports scaling of the drive-end computing performance of the SIMOTION D435 
and D445/D445-1 control units. Each CX32 can operate up to six additional servo, four 
vector or eight V/f drives.  

The CX32 controller extension offers the following advantages: 

● At only 25 mm wide, the CX32 is extremely compact. 

● Since the CX32 is connected to the SIMOTION D435/D445/D445-1 via DRIVE-CLiQ, 
high-performance isochronous closed-loop control of the drives is possible without the 
need for additional modules. 

● The communications interfaces on the SIMOTION D435/D445/D445-1 remain available 
for other connections. 

● As the data for the CX32 is stored exclusively on the SIMOTION D435/D445/D445-1 CF 
card, no action needs to be taken if the module is replaced. 

● The "Control operation" signal from an infeed connected to the SIMOTION D4x5 is 
particularly easy to interconnect to the drives of a CX32. 

SIMOTION CX32 is automatically also updated when the SIMOTION D4x5 is updated 

7.4.2 Basic principles of the CX32 

Basic principles of the CX32 
Each CX32 is entered as a separate DRIVE object in the project navigator on the level of 
SINAMICS Integrated. As a general principle, a CX32 can be configured the same way as 
SINAMICS Integrated. 

Communication 
With CX32 (as with the SINAMICS Integrated) communication takes place via PROFIBUS 
Integrated, although the SINAMICS Integrated is also used for routing to the relevant CX32 
via DRIVE-CLiQ. 
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Communication with the CX32 runs in the same cycle (same DP cycle ) as communication 
with the SINAMICS Integrated. Direct communication between two CX32 modules or the 
SINAMICS Integrated and CX32 is not possible Exception: Interconnection of the infeed's 
"Operation" signal for the CX32. Section Interconnecting the infeed "Operation" signal on the 
CX32 (Page 185) describes how to interconnect the "Operation" signal. 

Power-up 
The CX32 does not require its own CF card. Both the firmware and parameterization are 
stored centrally on the SIMOTION D CF card. This means that the CX32 modules only 
power up after the SINAMICS Integrated has done so. As a result, it usually takes longer for 
the system to power up than if a SIMOTION D were being used with just one SINAMICS 
Integrated. 

Copying from RAM to ROM also takes longer, as the devices perform this function one after 
the other. 

Please refer to Section CX32 configuring tools on how to detect if a power-up has been 
completed during CX32 power-up (Page 184).  

Online functions 
Since the SINAMICS Integrated routes online functions to the CX32 via DRIVE-CLiQ, 
operational performance is reduced by up to a factor of 2 in the case of online functions (e.g. 
parameter modifications or downloads) compared to a similar installation with CU320. 

Requirements for commissioning 
In order to commission a SIMOTION D with CX32, all drive components which were 
configured offline must also be present and connected to the correct DRIVE-CLiQ port. 

Only when there are no topology errors 

● Will the download be successful (where a project created offline is loaded to the target 
system) 

● Will the system startup be successful 

● Can the CX32 modules be accessed "online" 

Loading the SINAMICS Integrated 
If the SINAMICS Integrated of a SIMOTION D is loaded, the connected CX32 controller 
extensions go offline as a result of reinitialization. 
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7.4.3 Preparing for configuration 

Preparing for configuration  
The following measures are required to enable online or offline configuration of a CX32. 

1. Create a project and insert a SIMOTION D435 or D445/D445-1 (in this example, a D435 
is used). 

2. Double-click "D4x5" in the project navigator. The HW Config is displayed. 

3. In the hardware catalog, open the "PROFIBUS DP" entry and select "SINAMICS". 

4. Drag a SINAMICS CX32 to the PROFIBUS Integrated master system of the SIMOTION D 
module. The mouse pointer permits the CX32 to be inserted on the master system only. 
The "DP Slave Properties" screen form is displayed with the PROFIBUS address. The 
PROFIBUS address is assigned automatically. See the table below. 
Select the relevant DRIVE-CLiQ port by selecting the relevant PROFIBUS address (in 
this example, PROFIBUS address 13). 

 
Figure 7-27 Inserting CX32 in HW Config 
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5. Click "OK" to confirm your settings. 

The CX32 is displayed in the project navigator and can be configured there in the same 
way as a SINAMICS Integrated. 

In HW Config, the respective PROFIBUS address of the CX32 is represented in 
parentheses in the module icon.  

 
Figure 7-28 CX32 in the project navigator 

6. Save the project. 

7. A CX32 is configured in the same way as a SINAMICS Integrated on a SIMOTION D4x5. 

Using an offline configuration  

Where configuration is being performed offline, configure the drive components (infeed, 
motor modules, motor, encoder, terminal modules, etc.) by running through the drive wizard 
for the SINAMICS Integrated or CX32. After you have done this, carry out commissioning. 

Automatic commissioning 

With automatic commissioning, the drive components that are physically connected to a 
SIMOTION D are determined online. This means you only need a D4x5 project with the 
CX32 modules configured in HW Config. 
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Assigning DRIVE-CLiQ ports to PROFIBUS addresses 

Table 7- 3 CX32 PROFIBUS addresses (PROFIBUS Integrated) 

DRIVE-CLiQ port PROFIBUS address (PROFIBUS Integrated) 
X105 (D445/D445-1 only) 15 
X104 (D445/D445-1 only) 14 
X103 (D435/D445/D445-1) 13 
X102 (D435/D445/D445-1) 12 
X101 (D435/D445/D445-1) 11 
X100 (D435/D445/D445-1) 10 

See also 
Configuring components (Page 143) 

Performing CX32 configuration online (Page 183) 

Performing CX32 configuration offline (Page 180) 
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7.4.4 Displaying the topology 

Topology of the SINAMICS Integrated 
Because the CX32 is connected to the SINAMICS Integrated of a SIMOTION D4x5 via 
DRIVE-CLiQ, it is also represented in the topology tree of SINAMICS Integrated. 

All inserted CX32s are represented in the SINAMICS Integrated topology without their 
subtopology. 

 
Figure 7-29 SINAMICS Integrated topology 
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CX32 topology 
The CX32 topology represents the DRIVE-CLiQ port required for connection to the 
SINAMICS Integrated. The drive objects connected to the CX32 are also displayed. 

 
Figure 7-30 CX32 topology 

 

 Note 

Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online. 

 

See also 
CX32 diagnostics  (Page 187) 

7.4.5 Performing CX32 configuration offline 

Options 
The following options are available for commissioning a project created offline: 

● Loading a project created offline to the target system 

● Loading a project created offline to the CF card 
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7.4.5.1 Loading a project created offline to the target system 

Requirement 
● Your project, including all SINAMICS Integrated and CX32 drive components, must have 

been configured already (see Preparing for configuration (Page 176)). 

● The actual topology must correspond with the reference topology. 

Procedure 
1. Deselect all target devices, with the exception of the SIMOTION D4x5, using the "Target 

system" > "Select target devices" menu command in SCOUT. 

2. Go online with the D4x5 by clicking "Connect to selected target devices". 

3. Select the D4x5 in the project tree. Load the configuration to the SIMOTION D4x5 with 
"Download CPU / drive unit to target device". 

4. Copy the configuration from RAM to ROM with "Copy RAM to ROM". 

5. Select "Connect target device" in the SINAMICS Integrated context menu. You will then 
be connected to the SINAMICS Integrated online. 

6. Load the parameterization by selecting "Target device" > "Download" in the SINAMICS 
Integrated context menu. 

7. Copy the parameterization from RAM to ROM with "Copy RAM to ROM". 

8. Then select "Load CPU / drive unit to PG" to load the parameterization from the 
SINAMICS Integrated back to the programming device in order to back up the SINAMICS 
parameter calculations. 

Result 
The SINAMICS Integrated is now ready for operation (RDY LED is green). The CX32 can be 
accessed online, although it will not yet have been configured (RDY LED is green, DP1 LED 
is red). 

1. Select "Connect Online" in the CX32 context menu. You will then be connected to the 
CX32 online. 

2. Load the parameterization to the CX32 and copy the parameterization from RAM to 
ROM. 

3. Then load the parameterization from the CX32 back to the programming device in order 
to back up the SINAMICS parameter calculations. 

4. Repeat steps 1 to 3 for each CX32. 

5. Save the project. 

  Note 

Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online.  
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See also 
CX32 diagnostics  (Page 187) 

7.4.5.2 Loading a project created offline to the CF card 
Loading a project created offline to the CF card has the advantage of being faster than a 
download. 

It should be noted, however, that the first system power-up will take longer, as the 
SINAMICS Integrated and CX32 will perform one-off parameter calculations. These are 
automatically backed up on the CF card. 

Requirement 
● You will need a card reader for the SIMOTION D4x5 CF card. 

● Your project, including all SINAMICS Integrated and CX32 drive components, must have 
been configured already (see Preparing for configuration (Page 176)). 

● The actual topology must correspond with the reference topology. 

Procedure 
1. Select "Load to file system" in the SIMOTION D4x5 context menu. 

2. Select "Normal save" and click the "Select target" button. Select your card reader's drive 
and confirm with "OK". 

3. If a project has already been saved to the CF card, the message "Memory card file 
already exists. Do you want overwrite this file?" appears. Confirm the message with 
"Yes". 

4. Once the project has been subsequently transferred to the CF card, insert the card into 
the disconnected SIMOTION D4x5. Switch on the power supply for the D4x5 and 
connected components. 

5. After a successful power-up, the RDY LED of the D4x5 and CX32 will be green, as will 
the DP1 LED of the CX32. 

The components' firmware is automatically updated, depending on the FW version on the 
SINAMICS components and on the CompactFlash Card. Please see the corresponding 
instructions in the chapter titled Upgrading D4x5/CX32 (Page 188). 

 

 Note 

Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online. 
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7.4.6 Performing CX32 configuration online 

Requirement  
You need a project which has already been created and which contains SIMOTION D4x5 
with SINAMICS Integrated, as well as the CX32 controller extension(s). 

Additional drive components (line module, motor modules, terminal modules, etc.) are 
configured using "Automatic commissioning" and must not, therefore, be created offline. 

Procedure 
1. Deselect all target devices, with the exception of the SIMOTION D4x5, using the "Target 

system" ⇒ "Select target devices" menu command in SCOUT. 

2. Go online with the D4x5 by clicking "Connect to selected target devices". 

3. Select the D4x5 in the project tree. Load the configuration to the SIMOTION D4x5 with 
"Download CPU / drive unit to target device". 

4. Copy the configuration from RAM to ROM with "Target device" ⇒ "Copy RAM to ROM". 

5. Select "Connect target device" in the SINAMICS Integrated context menu. You will then 
be connected to the SINAMICS Integrated online. 

6. Perform "Automatic Configuration" on the SINAMICS Integrated. This may take several 
minutes, depending on the number of components connected. 

The SINAMICS Integrated is now ready for operation (RDY LED is green). The CX32 can 
be accessed online, although it will not yet have been configured (RDY LED is green, 
DP1 LED is red). 

7. Select "Connect target device" in the CX32 context menu. You will then be connected to 
the CX32 online. 

8. Perform automatic configuration on the CX32. The CX32 is now also ready for operation 
(RDY LED is green, DP1 LED is green). 

9. Repeat steps 7 to 8 for each CX32. 

10. Copy the parameterization from RAM to ROM with "Copy RAM to ROM". 

11. Save the project. 

If you run the "automatic configuration" in Step 6 and 8, a check will be made to see if the 
firmware on the SINAMICS components differs from the firmware on the CF card. If it does, 
you will be informed accordingly and the firmware on the SINAMICS components will be 
upgraded/downgraded automatically.  

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT.  

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red 
and green: 

● FW update running: RDY LED flashes slowly (0.5 Hz) 

● FW update complete: RDY LED flashes quickly (2 Hz) 
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These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW update. 

Go offline once all the FW updates have been completed.  
POWER ON the upgraded/downgraded components. 

 

 Note 

Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online.  

 

See also 
CX32 configuration instructions (Page 184) 

CX32 diagnostics  (Page 187) 

7.4.7 CX32 configuration instructions 
This section contains configuration tips relating to a number of features which are specific to 
operating CX32 in conjunction with D4x5.  

7.4.7.1 CX32 power-up 

Powerup times 
The CX32 does not require its own CF card. Both the firmware and parameterization are 
stored centrally on the SIMOTION D CF card. This means the CX32 will only power up once 
the SINAMICS Integrated has done so. As a result, it usually takes longer for the system to 
power up compared to when a SIMOTION D is used with a SINAMICS Integrated and any 
CU320 Control Units which may be connected. 

Detecting when the CX32 powers up in the user program 
The user must wait for the CX32 to power up before the drive objects can be accessed by 
the user program. 

One way of checking is to query the status of system variables on the CX32 drives. 

● <axis name>.actormonitoring.cyclicinterface = ACTIVE AND 

● <axis name>.sensordata[1].state = VALID 

This procedure can also be used to establish when the SINAMICS Integrated drives power 
up. 
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7.4.7.2 Interconnecting the infeed "Operation" signal on the CX32 

Requirement 
● Drive line-up with SIMOTION D4x5 Control Unit and Line Module with DRIVE-CLiQ 

interface 

● One or more CX32 Controller Extensions with no Line Module of their own (in other 
words, the Motor Modules of the D4x5 and CX32 modules are supplied by the same DC 
link). 

In this example, the Line Module must to be connected to the SIMOTION D4x5 (not the 
CX32). 

Procedure 
When drives are created in Drive System 1, the signal "Closed-loop control operation" r863.0 
from the Line Module is automatically interconnected with the "Infeed operation" signal from 
the drives (Drive 1...n) via p864. 

There is an internal communication channel available (V4.1 SP1 and higher) for the CX32 
Controller Extension (Drive System 2), via which the following signals from the SIMOTION 
D4x5 Control Unit can be automatically interconnected to the CX32 Controller Extensions: 

● "Closed-loop control operation" from the Line Module connected to SIMOTION D4x5 

● Status of the SIMOTION D4x5 onboard digital inputs 

These signals are available on the CX32 Controller Extension; since there is no need to 
perform any additional configuration steps, it is very easy to make additional 
interconnections with them within the CX32. 
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Interconnecting the infeed operation signal 
The "Closed-loop control operation" signal from the Line Module connected to the 
SIMOTION D4x5 is available in parameter r8510.0 of the CX32. Using the expert list or the 
drive wizard, interconnect parameter p864 (drives on CX32) with parameter r8510.0 of the 
CX32 Controller Extension.  

 
Figure 7-31 Interconnecting the infeed operation signal 

 
Figure 7-32 Operation signal interconnection (explanatory illustration) 
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Terminal status of D4x5 onboard digital inputs 
The terminal statuses of the SIMOTION D4x5 onboard digital inputs are available in 
parameter r8511[0..15] of the CX32. Additional interconnections can be made on the CX32 
using these.  

7.4.7.3 CX32 diagnostics 

Error analysis/Error correction 
In order to commission a SIMOTION D with CX32, all drive components which were 
configured offline must also be present and connected to the correct DRIVE-CLiQ port. 

Only when there are no topology errors 

● Will the download be successful (where a project created offline is loaded to the target 
system) 

● Will the system startup be successful 

● Can the CX32 modules be accessed online 

Error correction procedure 
If the actual topology of the SINAMICS Integrated is either incomplete or has been inserted 
incorrectly, 

● The RDY LED of the D4x5 remains yellow. 

● The RDY LED and DP1 LED on the CX32 are yellow and red respectively. 

● The CX32 cannot be accessed online in this state. 

Procedure 

Rectifying a topology error 

1. Select "Target System" > "Select Target Devices" in SCOUT. 

2. In the next window, deselect all the target devices apart from the D4x5 and the 
SINAMICS Integrated. 

3. Close the window by clicking "OK". 

4. Now click the "Connect to selected target devices" button. The D4x5 and the SINAMICS 
Integrated are connected. 

5. Using the alarm window and the topology view of the SINAMICS Integrated, the topology 
error can now be analyzed (for example, a component may be missing or in the wrong 
port). 
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6. Switch off the D4x5 and the CX32, rectify the topology error, and switch all devices back 
on again. 

7. Once the SINAMICS Integrated has started up successfully, the RDY LED of the D4x5 
will be green. 

– If the CX32 has been configured and has powered up successfully, the RDY LED and 
DP1 LED of the CX32 will also be green. 

– If, however, the RDY LED on the CX32 is green but the DP1 LED is red, this means 
the CX32 has not yet been configured. If this is the case, complete the next 4 steps. 

 

On the CX32, the RDY LED is green but the DP1 LED is red: 
In this state, the CX32 can be accessed online but has not been configured. 

1. Select the CX32 and select "Connect Online" in the context menu. 

2. Click the "Download CPU/drive unit to target device" button. This will load the CX32 
configuration. 

3. Save the data with "Copy RAM to ROM". 

4. Once the SINAMICS Integrated and the CX32 have started up successfully, the RDY 
LED of the D4x5 and the CX32 will be green, as will the DP1 LED of the CX32. 

7.4.7.4 Upgrading D4x5/CX32 
CX32 modules are always operated with the same firmware version as the SINAMICS 
Integrated of a SIMOTION D. 

This means no additional measures need to be taken for CX32 modules.  

If the firmware version of the SIMOTION D is upgraded via HW Config, the SINAMICS 
Integrated and the connected CX32-2 controller extension are also automatically upgraded 
as of SCOUT V4.2.  

If a SIMOTION SCOUT < V4.2 is used, the SINAMICS Integrated and CX32 must be 
manually upgraded via the context menu "SINAMICS drive" ⇒ "Target device" ⇒ Device 
version". 
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For instructions on upgrading a SIMOTION D see also Section Adapting a project (Updating 
the project / Replacing the SIMOTION controller) (Page 272). 

 

 Note 

The components' firmware is upgraded or downgraded automatically based on the FW 
version on the CF card and the FW version on the SINAMICS components (DRIVE-CLiQ 
components, CBE30, PM340, etc.).  

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT.  

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red 
and green: 
 FW update running: RDY LED flashes slowly (0.5 Hz) 
 FW update complete: RDY LED flashes quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW update.

Go offline once all the FW updates have been completed. POWER ON the  
upgraded/downgraded components.  

 

7.4.7.5 Replacing D4x5/CX32 

Replacing a module 
When used as a replacement part, a CX32 behaves like other DRIVE-CLiQ components. 

D445/D445-1 ⇔ D435 replacement 
Drag-and-drop can be used to carry out D445/D445-1 ⇔ D435 module replacement in HW 
Config. 

Please note that it will not be possible to replace a D445/D445-1 with a D435 if a CX32 has 
been configured with the address 14 or 15. (since a D435 does not have DRIVE-CLiQ ports 
X104/X105, it does not have addresses 14 and 15). 
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7.5 Additional information on configuring the SINAMICS Integrated 

7.5.1 Settings for DP slave properties 

Settings in HW Config 
Depending on the cycle clock ratios (bus cycle clock, servo cycle clock) and the drives used, 
it may be necessary to change the properties of the DP slave (SINAMICS Integrated) on the 
PROFIBUS Integrated. 

Open HW Config. Double-click the SINAMICS Integrated to display and, if necessary, 
change the properties of the DP slave on the "Isochronous mode" tab. Example: 

● Synchronizing a drive to the isochronous DP cycle 

SINAMICS Integrated and CX32 can only be operated isochronously. For this reason, 
this option cannot be deactivated. 

● Changing the master application cycle (TMAPC) 

The master application cycle must always be the same as the servo cycle clock set 
(setting: "Context Menu of the D4x5" > "Set System Cycle Clocks" in the project tree). 
Provided that the DP cycle is not scaled down to the position control cycle clock, the 
master application cycle will always be the same as the DP cycle. 

● Changing the DP cycle (TDP) 

Depending on the requirements in terms of the quantity structures and the response 
times, the DP cycle may need to be changed (see also SIMOTION SCOUT Basic 
Functions Function Manual). 

In addition, the minimum DP cycle for vector drives also depends on the speed controller 
clock cycle, which in turn depends on the drive quantity structure and the device type 
used. This means that, particularly in the case of vector drives, the DP cycle must be 
checked and changed if necessary (see Using vector drives (Page 191)). 

  Note 

After TDP has been changed on the PROFIBUS master, the drive system must be 
switched on (POWER ON). 

● Changing the TI and TO times 

A change to TI/TO is required in the case of vector drives, for example, where the TI/TO 
time depends on the number of vector drives or, with chassis devices, on the device type 
used. 

If you are changing settings for the SINAMICS Integrated, you must also change the settings 
on the CX32 modules accordingly. This is easily done by using the Align button to transfer 
the settings for all the CX32 modules. 
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Figure 7-33 HW Config - settings 

The times are modified by changing the value in the "Factor" field. 

Additional references 
For additional information, please refer to the 

● SINAMICS S120 Function Manual 

● SIMOTION SCOUT Basic Functions Function Manual 

7.5.2 Using vector drives 
Changes need to be made in HW Config when using SINAMICS vector drives. This means, 
for example, that the TI/TO time and the minimum DP cycle depend on the number of vector 
drives or, with chassis drives, also on the device type used. 
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Therefore, we recommend adopting the following procedure is when using vector drives with 
SIMOTION D4x5. 

Scenario 1: Current and speed controller cycle is known 
As long as you know the current and speed controller cycle, you will be able to determine 
times TMAPC, TDP, TI, and TO . Where there are several drives with different cycle clocks, the 
largest cycle clock must be used for the current and speed controller cycle. 

Procedure 
1. Open HW Config. Double-clicking SINAMICS Integrated allows you to change the 

properties of the DP slave on the "Isochronous mode" tab. 

2. For TI = TO =, enter an integer multiple of the current controller cycle. 

3. For TDP, enter an integer multiple of the speed controller cycle. For drives on the 
SINAMICS Integrated, TDP must always be ≥ TO. 

4. Enter TMAPC = TDP (exception: You are working with cycle clock scaling; i.e. position 
control cycle clock > DP cycle). 

5. Use the "Download project to target system" menu command to load the configuration to 
the SIMOTION D4x5. 

6. After the download has successfully completed, you should determine the current and 
speed controller cycles of the drives from the drives' expert lists, as the cycle clocks are 
set in the SINAMICS drive unit after a project has been downloaded. 

p115[0]: Current controller cycle 

p115[1]: Speed controller cycle 

7. If the current and speed controller cycles from the expert lists are different to the cycle 
clocks used in steps 2 and 3, you will have to repeat the steps with the current values for 
the current and speed controller cycles. 

Table 7- 4 Example for power units in booksize format (vector drives) 

Example Settings 
1 or 2 vector drives 
Current controller cycle = 250 µs 
Speed controller cycle = 1 ms 

TI = TO = at least 250 µs  
TDP = 1 ms (... or 2 ms, 3 ms, etc.) 
TMAPC = TDP 

3 or 4 vector drives 
Current controller cycle = 500 µs 
Speed controller cycle = 2 ms 

TI = TO = at least 500 µs  
TDP = 2 ms (... or 4 ms, 8 ms, etc.) 
TMAPC = TDP 

 

 

 Note 

Vector drives in chassis format can also be operated with a current controller sampling time 
of 400 µs, amongst other settings. 
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In a SIMOTION context, the following should be considered: 

● A current controller sampling time of 400 µs is only possible if control is via a 
SINAMICS S120 control unit, which is not operated isochronously via 
PROFIBUS/PROFINET on SIMOTION D. 

● If the bus is operated isochronously, only cycle clocks with an integer multiple of 125 µs 
are possible (375 µs or 500 µs instead of 400 µs, for example). 

● The PROFIBUS Integrated of a D4x5/CX32 is always isochronous! This means a current 
controller sampling time of 400 µs is not possible. 

● With CU parameter p0092 = 1, the sampling times are pre-assigned so that isochronous 
operation with a controller is possible. 

Scenario 2: Current and speed controller cycle is not known 
This procedure is especially suitable for devices in chassis format, as the current and speed 
controller cycle also depends on the relevant device type. 

1. To determine which cycle clocks are set in the SINAMICS drive unit after a project has 
been downloaded, first set reliable values for the cycle clocks in HW Config (see table 
"Recommended cycle clock settings in HW Config"). 

2. Use the "Download project to target system" menu command to download the 
parameterization. 

3. After the download has successfully completed, you will be able to determine all the 
current and speed controller clock cycles of the drives from the drives' expert lists. 

p115[0]: Current controller cycle 

p115[1]: Speed controller cycle 

4. If required, it is now possible to optimize the TMAPC, TDP, TI  and TO times in HW Config 
(see procedure for Scenario 1). 

Table 7- 5 Recommended cycle clock settings in HW Config 

Setting Explanation 
TDP = 3.0 ms TDP = DP cycle time 
TI = TO = 1.5 ms TI = time of actual value acquisition 

TO = time of setpoint transfer 
TMAPC = 3.0 ms TMAPC = master application cycle time 

Output cams / measuring inputs with vector drives 
With vector drives, the cycle clock ratios (current controller cycle clock, speed controller 
cycle clock, sampling time of the inputs/outputs, etc.) depend on the number of vector drives, 
or with chassis units also on the device type used. 

Note the information in Section Current controller cycle clocks <> 125 µs / Using output 
cams and measuring inputs (Page 199). 
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Additional references 
Additional information on quantity structures and cycle clock settings can be found in the 
SINAMICS S120 Function Manual.  

See also 
Settings for DP slave properties (Page 190) 

7.5.3 Setting the time of day 

Time on SIMOTION (real-time clock) 
SIMOTION D4x5 has an integrated real-time clock. All events on a module (alarms, 
messages, etc.) are "time-stamped" based on the time shown by this real-time clock. 

To set the clock from SIMOTION SCOUT, select the D4x5 in the project tree, followed by 
"Target system" ⇒ "Set time". 

Alternatively, the clock can be set using the "rtc" system function block. 

SINAMICS system runtime (operating hours meter) 
With the SINAMICS Integrated of a SIMOTION D, controller extensions and the 
SINAMICS S110/S120 control units, faults and alarms are "time-stamped" on the basis of 
the system runtime. This means that events are recorded by default on the basis of 
operating hours rather than a particular time of day or date. 

System runtime 

The entire system runtime is displayed in CU parameter p2114.  

● p2114[0] indicates the system runtime in milliseconds. After reaching 86,400,000 ms (24 
hours), the value is reset. 

● p2114[1] indicates the system runtime in days. 

At power-off the counter value is saved. After the drive unit is powered-up, the counter 
continues to run with the value that was saved the last time that the drive unit was powered-
down. 

As a result, the drive displays the system runtime from 00:00:00 on 01/01/1992 in both the 
alarm window in SIMOTION SCOUT and the diagnostic buffer for entries.  

If faults and warnings need to be "time-stamped" based on a time of day, "Time-stamp 
operating hours" needs to be changed to "Time-stamp UTC format" as described below. 

Requirements 
A message frame 39x is required for the time synchronization. If the automatic PROFIdrive 
message frame setting is selected for the control unit, this message frame is used 
automatically.  
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(See Section Calling the drive wizard (Page 142), Standard/automatic setting) 

If the message frames are specified manually, message frame  39x must be set up. See 
Section Message frame configuration (Page 216). 

So that drive units can be synchronized with the SIMOTION time, they must support 
message frame 39x and the UTC time format.  

These include, for example: 

● SINAMICS Integrated of the SIMOTION D 

● CX32/CX32-2 controller extensions 

● SINAMICS S110/S120 CU305, CU310, CU320, CU320-2 control units connected via 
PROFIBUS or PROFINET 

Synchronizing the SINAMICS clock 
Proceed as follows to convert the SINAMICS clock to UTC format and to synchronize this 
with the SIMOTION clock: 

1. Call the D4x5 context menu in the project navigator. 

2. Select the "Properties" entry in the context menu. 

3. Select the "Perform time synchronization with SINAMICS drive units" option in the 
"Settings" tab of the "Properties - D4x5" dialog box. 

  Note 

This setting is automatically activated for new projects as of V4.2 and applies for all drive 
units connected to the D4x5. The SINAMICS clock is automatically synchronized with the 
SIMOTION clock for all drive units with configured message frame 39x. 

The first time synchronization is performed after the SIMOTION D control unit has reached 
the RUN mode.  

To compensate for deviations between the SIMOTION and SINAMICS clocks, the time of 
day is automatically resynchronized at regular intervals. 

Via the system variable _driveStates.allClocksSynchronized on the device, the user program 
can query whether the automatic time synchronization is activated (=YES) or deactivated 
(=NO).  

Before the first synchronization, alarms and messages are stored with the time stamp valid 
in the SINAMICS at this time, all subsequent alarms and messages with the synchronized 
time. 

The first time synchronization after switching on is entered with the status of the operating 
hours counter and the time (UTC time, synchronized with SIMOTION) in the diagnostic 
buffer of the drive (e.g. SINAMICS Integrated).  
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Figure 7-34 Diagnostics buffer entry, time synchronization 

 

 Note 

The time synchronization must be performed "applicatively" for SIMOTION versions < V4.2. 
You can find a sample program in the SIMOTION Utilities & Applications.  

If the "applicative time synchronization" is used for SIMOTION versions ≥ V4.2, the time 
synchronization must be deactivated via the "Settings on the Device" dialog box. 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 
 

Compensation of runtime deviations 
To compensate for deviations between the SIMOTION and SINAMICS clocks, the time of 
day is automatically resynchronized at regular intervals. 

The following behavior must be taken into consideration when setting the SIMOTION time: 

● "Time/date to be set" is after "Time/date on SINAMICS": Time and date on SINAMICS is 
updated. 

● "Time/date to be set" is before "Time/date on SINAMICS": The SINAMICS clock must be 
stopped until the SINAMICS "Time/date" has caught up with "Time/date to be set". 

Adopting this procedure ensures that the sequence of SINAMICS diagnostic buffer entries 
remains the same, even when the runtime differences are aligned. 

The SINAMICS clock operates with a resolution of 1 ms. A synchronization accuracy of 1 ms 
can be achieved for all bus cycle clocks that can be divided exactly by 1 ms (e.g. 1 ms, 2 ms, 
3 ms, etc.). 

A slightly lower synchronization accuracy is achieved for all bus cycle clocks that cannot be 
divided exactly by 1 ms (e.g. 1.25 ms) due to the system.  
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7.5.4 SINAMICS diagnostic buffer 

Requirement 
The diagnostic buffer is supported for SINAMICS S120 devices as of version V2.6. The 
SINAMICS Integrated variants support the diagnostic buffer as of version V2.5. There are 
minimum requirements for the HW version for the following components: 
- For D425/D435, product version "D",  
- For CU320 (-0AA1), product version "C".  

Procedure 
To do this, select the SINAMICS Integrated, the CX32 or the SINAMICS S120 control unit in 
the project tree. Then select "Target System" > "Device Diagnostics" in the menu. 

In addition, the SINAMICS diagnostic buffer entries are displayed in the D4x5 device 
diagnostics. All D4x5 diagnostics buffer entries are displayed first, followed by those for the 
SINAMICS Integrated and the CX32. The start of the SINAMICS diagnostics buffer entries is 
identified by the following entry: 

>>>>>> >>>>>> Start of SINAMICS Integrated diagnostics buffer, station address = x 
<<<<<< 

You also have the option of viewing the SIMOTION D4x5 and SINAMICS Integrated 
diagnostics buffers via IT DIAG.  

7.5.5 Acyclic communication with the drive 

Overview 
PROFIdrive drive units are supplied with control signals and setpoints by the controller and 
return status signals and actual values. These signals are normally transferred cyclically (i.e. 
continuously) between the controller and the drive. 

For the SINAMICS S110/S120, configure the axis message frames for data exchange (see 
Performing the configuration for the D4x5 offline (Page 141)). 

As well as offering cyclic data exchange, PROFIdrive drive units have an acyclic 
communication channel. In particular, this is used for reading and writing drive parameters 
(e.g. error codes, warnings, controller parameters, motor data, etc.).  

As a result, data can be transferred on an "acyclic" as opposed to a "cyclic" basis when 
required. Acyclic reading and writing of parameters for PROFIdrive drives is based on the 
DP V1 services "Read data set" and "Write data set". 

The acyclic DP V1 services are transferred in parallel to the cyclic communication via 
PROFIBUS or PROFINET. The PROFIdrive profile specifies precisely how these basic 
mechanisms are used for read/write access to parameters of a PROFIdrive-compliant drive. 

The PROFIdrive standard states that "pipelining" of jobs on PROFIdrive drives is not 
supported. This means: 
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● Only one "Write/read data set" can be performed at any one time on a drive unit (e.g. 
SINAMICS S110/S120 control unit or the SINAMICS Integrated of a SIMOTION D). 

● However, if several PROFIdrive drive units are connected to a controller, a job can be 
processed for each of these drive units at the same time. In this case, the maximum total 
number of jobs will depend on the control (for SIMOTION, this is a maximum of eight jobs 
at a time). 

For acyclic data exchange with SINAMICS drives, this means you will have to coordinate the 
write/read jobs with each other (buffer managemenr). An interlock must be set to prevent the 
application or different parts of the application from sending overlapping jobs to the same 
PROFIdrive drive unit. 

Additional references 
Additional information on how to use DP V1 services can be found in the SIMOTION 
Communication System Manual. 

SIMOTION Utilities & Applications also has a DP-V1 library with functions that are capable of 
performing coordination tasks commonly associated with acyclic communication. The library 
not only coordinates access to the system functions 
(_ReadRecord/_WriteRecord/_readDriveParameter/_writeDriveParameter/, etc.), but also 
expands the range of functions for frequently required tasks, e.g. the reading of faults and 
alarms from the drive unit. 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 

The following functions are available in the DP V1 library: 

● Buffer management (coordination of a number of parallel DP V1 services) 

● StartUp (function for coordinating the power-up of the SINAMICS drive with SIMOTION) 

● TimeSync (applicative time synchronization: Transfer of SIMOTION time of day to the 
SINAMICS drives) 

● SetActIn (activating/deactivating objects in SIMOTION and SINAMICS) 

● RwnPar (reading and writing of drive parameters) 

● GetFault (reading of faults and alarms from the drive) 

7.5.6 Control properties and performance features 
With a few exceptions, the integrated drive control of SIMOTION D4x5 and CX32 has the 
same control properties and performance features as the SINAMICS S120 CU320 control 
unit.  

However, the following points must be particularly observed: 
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● SINAMICS Integrated and CX32 have no basic positioner (EPOS). The EPOS 
functionality is provided by the SIMOTION technology functions. 

● The BOP20 Basic Operator Panel cannot be connected to the SIMOTION D4x5. 

The following alternative options are available: 

– Use of SIMATIC HMI devices (e.g. TP177B, configurable with WinCC flexible) 

– Use of SIMOTION IT DIAG: You can use a Web browser to access the standard 
diagnostics pages of the SIMOTION D4x5 (diagnostics and alarm buffers, Watch 
table, read/write SIMOTION variables and drive parameters, access protection, trace 
function, etc.)  
You also have the option of creating your own Web pages, in order for example to 
visualize machine states and implement service functions. The SIMOTION D4x5 Web 
pages can be accessed for example using a PC or PDA over Ethernet. Wireless 
access is also possible in conjunction with WLAN. 

● The use of the CU parameter p972 is restricted with SIMOTION D4x5. CU parameter 
p972 can be used to reset the drive unit. You can use this method, for example, in the 
context of the implementation of modular machine concepts to force a restart of the CX32 
controller extension (see the description of functions titled Motion Control Basic Functions 
for Modular Machines). 

NOTICE  
 

You are not permitted to use parameter p972 on the SIMOTION D4x5 to reset the drive. 
This leads to a fault on the SIMOTION D4x5, with all eight status LEDs flickering red. In 
this fault situation, the SIMOTION D4x5 must be switched off and back on again. 

7.5.7 Current controller cycle clocks <> 125 µs / use of output cams and measuring 
inputs 

If current controller cycle clocks <> 125 µs are used, the parameter calculations of the drive 
must be transferred to the PG when using cam outputs on the TM15 / TM17 High Feature or 
for global measuring inputs, and FastIO configuration generated again.  

A change of the current controller cycle clock may have effects on the sampling times of the 
inputs/outputs on the drive side (e.g. TM15/TM17 High Feature, p4099 Sampling time of the 
inputs/outputs). 

Sampling times <> 125 µs occur in the following cases: 

● For servo drives with manual change of the current controller sampling time (drive 
parameters p112 and p115[0]) 

● For vector drives depending on the number of vector drives and with chassis units 
depending on the device type used 

● If only an infeed and no drives are connected to the drive unit, then the sampling time is 
250 µs 

For the cam outputs and the measuring input inputs (only for global measuring inputs) to 
function correctly, the sampling times must be known to the engineering system.  
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Table 7- 6 Influence of the current controller cycle clock on the dead time compensation 

 Current controller cycle clock has no 
effect on the function 

Current controller cycle clock has an 
effect on the function 

Cam outputs SIMOTION D  TM15/TM17 High Feature  
Measuring input inputs  
(global measuring 
inputs) 

D4x5-2 (terminal X142)  TM15/TM17 High Feature 
 SIMOTION D (except D4x5-2, 

terminal X142) 
 Controller extension (CX) 
 SINAMICS S110/S120 control 

units 

Measuring input inputs  
(local measuring 
inputs) 

--- --- 

In order that the changed cycle clock ratios are taken into account by the the engineering 
system, proceed as follows: 

1. Go online and perform a project download. The SINAMICS performs parameter 
calculations once. These are automatically backed up on the CF card. 

2. Perform an upload to the PG ("Target system" > Load" > "Load CPU / drive unit to PG"). 

3. This transfers the parameter calculations of the drive to the PG. The cycle clock ratios are 
then known in the engineering system. 

4. Go offline. 

5. Generate the configuration information (Fast IO configuration) again. To do this, select 
the SIMOTION CPU in the project tree and right-click to open the context menu "Fast IO" 
> "Create new configuration". 

6. Click "Save project and compile all". 

7. Go online and download the project to the target system. 

SCOUT uses the described procedure to calculate internal system data that is required for 
outputting/detecting signals with a high level of position accuracy.  

 

 Note 

If the cycle clock ratios are not set correctly, an appropriate message is output in the 
diagnostic buffer.  

 

7.6 Testing a drive with the drive control panel 

Introduction 
You can test a configured drive with the drive control panel, where you can specify a speed 
and adjust it with a scaling factor. The drive control panel should only be used for 
commissioning purposes.  
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Requirements 
● The project has been downloaded to the target system. 

● SIMOTION SCOUT is in online mode. 

● The drive is not being used by a current project in RUN mode. 

WARNING  
 

Make sure no one is endangered by the drive test. 

Testing a drive with the drive control panel 
1. Change to the configured drive in the Project Navigator and open the drive control panel 

by selecting "Commissioning" > "Control panel". The drive control panel opens in the 
detail view. 

 
Figure 7-35 Drive control panel 

 

2. To display the control range and axis diagnostics, click the "Show/hide control range" and 
"Show/hide diagnostics area" buttons. 
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3. Click "Assume control priority". The "Assume Control Priority" dialog box is opened. 

  Note 

If you are using an infeed without a DRIVE-CLiQ interface, you will have to interconnect 
the "Infeed operation" signal (drive parameter p864) yourself. If you are using an infeed 
with a DRIVE-CLiQ interface, select the infeed for which the control priority is to be 
assumed under "Infeed" in the "Assume Control Priority" dialog box. 

If the infeed signal "Closed-loop control operation" already has a BICO interconnection to 
the drive, the infeed is permanently specified (infeed selection and checkbox are grayed 
out). 

The infeed must be switched on before the drive can move ("LM" button, switch infeed 
on/off). 

 
Figure 7-36 Assuming control priority 

 

4. Read the notices and click "Accept" to confirm. 

5. Select the "Enables" checkbox to enable the drive. 

All enables are now set except ON/OFF1. 
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6. Enter the desired setpoint in the entry field, and, as a safety setting, slide the scaling to 
0%. 

 
Figure 7-37 Entering a setpoint 

7. Click the "Drive On" button. The green "Enable available" LED lights up. If you move the 
slider to the right, the drive rotates. The current motor speed is displayed under "Actual". 

8. Click "Drive Off" to stop the drive after the test. 

9. Deactivate the enable and click the "Give up control priority" button to deactivate control 
from the PG/PC. In this state, you can no longer make the drive rotate. 

7.7 Creating and testing axes 

7.7.1 Overview of SIMOTION engineering 

Performing engineering with SIMOTION SCOUT 
You use the engineering software to configure the individual axes and define the project 
sequence by means of programs.  

1. First, run through the axis wizard to configure the axes and interconnect to the real drive 
(e.g. SINAMICS Integrated). 

2. Then, select the "SINAMICS_Integrated" in the project navigator and deactivate the 
"Connect Online" option in the context menu. This only downloads the project to the 
SIMOTION D4x5. 
Provided you have completed configuration at the drive end, we strongly recommend you 
deactivate the SINAMICS Integrated so that work can be carried out faster via "Target 
system" > "Select target device". 

3. Complete your SIMOTION application, for example, by creating axis functions and 
SIMOTION execution programs. 

4. Compile the project and download it to the SIMOTION D4x5. 
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See also 
Downloading a project into the target system (Page 161) 

Downloading a project to the CF card (Page 163) 

7.7.2 Creating an axis with the axis wizard 

Overview 
The TO axis provides the user with the technological functionality and the interface to the 
drive/actuator. The TO axis processes the motion control commands from the user program 
(e.g. MCC) and coordinates the interface to the drives. It executes control and motion 
commands and indicates statuses and actual values. The TO axis communicates with an 
actuator (drive or hydraulic valve) via a field bus system (PROFIBUS or PROFINET via 
PROFIdrive protocol) or via a direct setpoint interface (analog ±10 V or pulse/direction). 

When running through the axis wizard, the basic settings are made for the axis and the 
TO axis interconnected to a drive (e.g. SINAMICS Integrated). Further options are available 
when "Symbolic assignment and adaptation" is used:  

● A real axis is interconnected to an already configured drive 

● A real axis including drive is created via the axis wizard and the drive interconnected to 
the axis 

● A real axis is created without assigning this to a drive (assignment is made later) 
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Inserting an axis 
1. In the project navigator, double-click the entry "Axis" > "Insert Axis". 

This will access the axis wizard. Set the required technology and then click "OK". 

 
Figure 7-38 Inserting an axis 

2. Set an axis type and, if required, configure the units. 
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Figure 7-39 Defining the axis type 

3. Create a new drive or make the assignment to an existing drive. 
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Figure 7-40 Assigning a drive 

The following setting options are available for the drive assignment: 

● Assign drive  
Assigning a previously configured drive 

● Assign later  
The TO axis is to be assigned to a drive at a later point in time. 
This enables 

– The PLC and motion control functions to be completely configured by a programmer 
even without drive know-how using technology objects (e.g. TO axis) and loaded to 
the device 

– The drives to be separately configured and optimized by a drive expert and 

– The technology objects to be symbolically assigned later to the drive objects via an 
interconnection dialog box 
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● Create drive  
From the assignment dialog box, a new drive can be created on an existing drive unit 
(e.g. S120 CU320-2 or SINAMICS Integrated) and assigned to the axis. This allows the 
axis, including the drive, to be created in one operation. It is not necessary to configure a 
drive before creating an axis. 

● Set up addresses  
The addresses must be set up manually if "Symbolic assignment and adaptation" is not 
used. This corresponds to the previous methods of the drive and axis configuration, 
available in SCOUT versions < V4.2.  
This is required, for example, for drive units that do not support symbolic assignment (e.g. 
SINAMICS S120 with FW version < 2.6.2, MASTERDRIVES, SIMODRIVE, etc.) 

The address list in the "All Addresses" view provides an overview of the assignments to all 
interfaces of the TO axis. From this view, the assignments can also be changed via the 
interconnection dialog box (  button).  

 

 Note 

The methods of the drive and axis configuration, previously available in SCOUT versions 
< V4.2, are still available. The symbolic assignment must be deactivated for these methods. 

 

4. Run through the wizard and enter the settings of your system. The required axis message 
frames as well as the addresses used are automatically specified by the engineering 
system. Message frames are also extended and interconnections created automatically in 
the drive depending on the selected TO technology (e.g. SINAMICS Safety Integrated) 
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5. Click Finish to confirm the "Summary" window.  
The configured real axis is displayed in the project navigator. 

 
Figure 7-41 Axis wizard summary 

  Note 

During system power-up, reference variables as well as drive and encoder data of the 
SINAMICS are automatically taken over for the SIMOTION configuration data of the 
SIMOTION technology objects "TO axis" and "TO externalEncoder". 

Encoder assignment 
With a position axis, encoder 1 is also created at the Axis TO (motor encoder) and 
automatically assigned to the first encoder on the drive. 

If encoder 2 (direct encoder) is created at the TO axis, it is assigned to the second encoder 
of the drive control. 
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Result 
The configured axis will appear in the project navigator.  

Save and compile the project and download it to the target system. 

On completion of the axis wizard, the symbolic drive assignment is visible:  

● Via the "configuration" of the axis 

● Via the address list (view all addresses) 

 

The assignment dialog box can be called again from these dialog boxes using the " " 
button. 

Instead of calling the assignment dialog, it is also possible to edit the input field 
 containing the symbolic name directly. 

Safety data block (SIDB) and technology data block (TDB) 
The activation of  

● The technology data block (for the cyclic exchange of technology data, e.g. actual torque 
value) and 

● The safety data block (to support the SINAMICS Safety Integrated extended functions by 
the TO) 

can be made in the Configuration of the TO Axis dialog box. ("Change ..." button under 
functions). 

The assignment is always made to the drive DO of the actuator of the axis. The system 
automatically generates a message frame extension and the BICO interconnection of the 
relevant SINAMICS parameters. 

 

 Note 

The safety data block (SIDB) is automatically configured by the engineering system and 
interconnected in the drive. 

The PROFIsafe message frame must be configured by the user. 
 

If the activation of the safety functions is to be made using PROFIsafe, configure the 
PROFIsafe communication to the higher-level SIMATIC F-CPU (see SINAMICS S120 Safety 
Integrated Function Manual). 

I/O signals at the TO axis 

For the assignment of I/O signals on the TO axis (e.g. the inputs for the homing output cam 
or hardware limit switches), call the assignment dialog box from the parameterization dialog 
boxes of the created TOs or from the address list (view of all addresses) by clicking the  
button. 
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See also 
See Section Downloading a project to the target system (Page 161). For further information 
about the symbolic assignment, see the  
SCOUTBasic Functions Function Manual. 

7.7.3 Testing the axis with the axis control panel 

Axis control panel 
The axis control panel is used exclusively for testing axes. You can use the axis control 
panel for the following tasks, for example:  

● To test each part of the system individually before program-driven axis motions are 
initiated. 

● In the event of an error, to test whether the individual axes and drives can be traversed 
from the axis control panel 

● To traverse the axes for optimization purposes (controller optimization) 

● To perform active homing 

● To set and remove the axis enable 

● To test an axis that has been created 

Requirement 
The following requirements must be fulfilled for testing: 

● The project has been downloaded to the target system. 

● SIMOTION SCOUT is in online mode. 

● The mode switch is in position STOPU. 

Recommendation: Operate the mode selector only via SIMOTION SCOUT ("Target system" 
> "Control operating mode").  
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Axis test 
1. Open the AXES folder in the project navigator and click the "Control Panel" entry below 

the axis (for example, Axis_1). 

The axis control panel is displayed. 

 
Figure 7-42 Axis control panel 

 

2. To display the control range and axis diagnostics, click the "Show/hide control range" and 
"Show/hide diagnostics area" buttons. 

3. Click "Assume control priority". 

If the CPU is in RUN mode, confirm the prompt that appears with "Yes" to set the control 
to STOPU mode. 

  Note 

In order to move the axis from the PG/PC, you must assume control priority. However, by 
pressing the SPACER bar, you can stop the axis at any time. 

If you are using the axis control panel for a real axis, you must first activate the infeed for 
SINAMICS drives before the axis can be moved. The infeed must be activated before you 
enable the axis. 

4. The "Assume Control Priority" dialog box is opened. 

Read the notices and click "Accept" to confirm. The activated Service function is 
displayed via the LEDs (RUN flashes green at 2 Hz and SU/PF flashes yellow at 2 Hz) 

5. To enable the axis, click the "Set/remove enable" button. 

Confirm the "Switch Axis Enable" dialog with with "OK".  

  Note 

If you are using an infeed without a DRIVE-CLiQ interface, you will have to interconnect 
the "Infeed operation" signal (drive parameter p864) yourself. 

If you are using an infeed with a DRIVE-CLiQ interface, select the infeed for which the 
control priority is to be assumed under "Infeed" in the "Switch Axis Enable" dialog box. 
Select this checkbox when the control priority is to be fetched and activated. If the infeed 
signal "Closed-loop control operation" already has a BICO interconnection to the drive, 
the infeed is permanently specified (infeed selection and checkbox are grayed out). 
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6. To traverse the axis, click the "Position-controlled traversing of the axis" button. 

7. Enter a velocity and close the dialog box by clicking "OK". 

8. Click the "Start motion" button to traverse the axis. You can monitor the traversing motion 
under speed and position. Use "Stop motion" to stop axis movement again. 

9. To cancel the enable and switch off the infeed, click the "Set/remove enable" button. 
Confirm the "Remove Axis Enable" dialog with with "OK". 

10. Click the "Give up control priority" button to deactivate axis control from the PG/PC. In 
this operating mode, the axes can no longer be controlled from the PG/PC. 

See also 
Activating the infeed (line module) (Page 213) 

7.8 Activating the infeed (line module) 

Requirement 
Before a drive can be traversed, the infeed (line module) must be switched on and the 
"Closed-loop control operation" signal of the infeed must be present at the drives.  

If this is not taken into account, this can result in a fault state, and in the worst case, damage 
to the infeed. 

How the infeed is controlled and how the drives receive the Ready signal depends on the 
type of infeed used.  

A distinction is made between: 

● Infeeds without DRIVE-CLiQ connection 

● Infeeds with DRIVE-CLiQ connection 
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7.8.1 Infeed without DRIVE-CLiQ connection 
The infeed is controlled via terminals on the line module, e.g. DO Ready (DC link is 
precharged and ´pulse enable is set). 

These terminals must be connected to the SIMOTION D4x5 (e.g. wire "DO Ready of the 
infeed" to "X122, DI 0 of the D4x5").  

The enable signal is queried when the drive is configured and must be interconnected 
accordingly.  

 
Figure 7-43 Interconnection of the "Infeed in operation" signal 

7.8.2 Infeeds with DRIVE-CLiQ connection 
The infeed is controlled via DRIVE-CLiQ. The infeed is switched on or off by the 
SIMOTION D4x5 via PROFIdrive message frame 370.  

If "Symbolic assignments and adaptation" is used, message frame 370 is set automatically 
when setting standard/automatic (see Section Calling the drive wizard (Page 142)). 
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With message frame 370, the required BICO interconnections to the message frame are 
created automatically on the drive unit.  

If an infeed with DRIVE-CLiQ connection has already been created, the infeed signal 
"Closed-loop control operation, r863.0" is automatically interconnected to "Infeed 
operation, p864" of the drive when drives are inserted (only applies to drives that are 
attached to the same drive unit as the infeed). 

The FB _LineModule_control function block is available on the controller for control and 
diagnostics of the infeed.  

 

 Note 

Always create the infeed first so that the infeed "Closed-loop control operation" signal is 
automatically interconnected to a drive when this is inserted.  
Recommendation: If the drive unit has not been configured, use "Configure drive unit" in the 
project navigator. "Configure drive unit" has the advantage that all basic settings for the drive 
unit are queried via one wizard.  

 

FB _LineModule_control 
The _LineModule_control function block (FB) can be used to switch the infeed on and off and 
also perform simple diagnostics.  

The following infeeds are supported by the _LineModule_control function block: 

● Basic line modules (BLM) 

● Smart line modules (SLM) 

● Active line modules (ALM) 

The _LineModule_control FB is part of the command library of the "SIMOTION SCOUT" 
engineering system. You can find the FB at "Drives" ⇒ "SINAMICS". 

For detailed information on the _LineModule_control FB, refer to the SIMOTION SCOUT 
online help or the Standard Function for SINAMICS S120 Line Modules Function Manual.  

CX32 
Further information on how to use line modules with the CX32 can be found in Section 
Interconnecting the infeed "Operation" signal on the CX32. 

Additional references 
For a detailed description of the control words and status words of the PROFIdrive message 
frames for SINAMICS S120 drives, see the SINAMICS S120 Commissioning Manual. 

See also 
Interconnecting the infeed "Operation" signal on the CX32 (Page 185) 
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7.9 Setting up addresses and message frames 

Overview 
After all SINAMICS components have been configured, addresses must be determined for 
the process data exchange between the drive and the controller.  

This procedure depends on whether symbolic assignments are used. 

● With symbolic assignment, the addresses are determined automatically by the 
engineering system, see Section Setting up communication for symbolic assignment 
(Page 216) 

● Without symbolic assignment, the determination of the addresses must be started 
manually, see Section Message frame configuration (Page 216). 

7.9.1 Setting up communication for symbolic assignment 
The communication for symbolic assignment is set up with the following actions: 

● Via the SCOUT menu (call the following in the menu: "Project" > "Set up communication 
for symbolic assignment") 

● at "Download project to target system" 

● at "Save project and compile changes" 

When setting up the communication, the message frames, BICO interconnections and 
addresses are set up for the entire project. 

See also 
Message frame configuration (Page 216) 

7.9.2 Message frame configuration 

Requirement 
You have configured the drive unit. 

On the basis of this configuration, one or more of the following actions should be performed: 

● The automatic PROFIdrive message frame setting for a drive object should be 
activated/deactivated 

● The automatic message frame extension for a drive object should be 
activated/deactivated 

● The automatic address adaptation for a drive object should be activated/deactivated 

● PROFIdrive message frames should be configured for drive objects 
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● The addresses should be set up 

● Message frames should be extended manually 

Procedure 
Proceed as follows: 

In the project navigator, open the "Communication" > "Message frame configuration" entry 
under "SINAMICS_Integrated".  
The "SINAMICS Integrated - Message Frame Configuration" dialog box is displayed with the 
PROFIdrive PZD message frames tab. 

The dialog box lists all the available drive objects. The possible setting options are described 
in the following.  

 

 Note 

When using the symbolic assignment, the default setting does not have to be changed or 
configured.  

 

 Note 

When using the symbolic assignment, the default setting does not have to be changed or 
configured. 

 

 
Figure 7-44 Message frame configuration 
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Table 7- 7 Explanation of the figure 

Number Meaning 

 Selection of a message frame 
 The drive message frames (message frames 1 ... 6 and message frame 1xx) are defined in accordance 

with the PROFIdrive specification and can be selected based on the required functional scope. 
 You can transfer the signals of the I/Os or the global measuring inputs, for example, via the message 

frames 39x. Message frame 39x is also required for the time synchronization between SIMOTION and 
SINAMICS. 

 Free message frame configuration with BICO allows you to define your own message frame. 
 Free message frame configuration with p915/p916 (for TM15/17). 
 Message frames 37x for control of the infeed. 

 The "Standard/automatic" and "User-defined" settings are only visible if "Use symbolic assignment" is 
activated. Using the setting "Standard/automatic" is generally recommended. 
The "User-defined" setting allows the automatic message frame setting, message frame extension, and 
address adaptation to be deactivated or activated. 
 "Automatic PROFIdrive message frame setting" allows the message frame to be set by the system 

depending on the configured technology (message frame selection, e.g. for infeed, drive, and control unit 
incl. onboard I/O). 

 "Automatic message frame extension" allows the message frame to be extended by the system depending 
on the configured technology (e.g. if the technology data block is activated in the axis configuration). 

 "Permit automatic address adaptation" allows addresses to be adapted by the system in the case of 
address offsets, for example. Address offsets can occur, for example, if a message frame is extended and 
the adjacent addresses are already occupied by other message frames. 

With TM15/TM17 High Feature, "Automatic PROFIdrive message frame setting", "Automatic message frame 
extension", and "Automatic address adaptation" cannot be deactivated by design, since for these drive objects 
the message frame is always set up in accordance with the parameterized terminal functionality (DI, DO, 
output cam, measuring input) and cannot be extended.  
"Automatic PROFIdrive message frame setting" and "Automatic message frame extension" must be 
deactivated if the message frames are to be configured manually for TM15 DI/DO, TM31, and TB30 and 
interconnected with BICO. 
See Section Setting up communication for symbolic assignment (Page 216). 

 

 
Message frame status 

 Length: Displays the size of the message frame component. 
Address: Address area in HW Config. The addresses will be displayed only after the addresses have been set 
up. 

 Displays the SIMOTION object that is interconnected to the SINAMICS object (e.g. axis or encoder). 



 Commissioning (software) 
 7.10 Linking an additional encoder (optional) 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 219 

Number Meaning 

 Changing the message frame sequence 
Before the alignment, all drive objects without input/output addresses ("---..---") must be moved behind the 
objects with valid input/output addresses or those still to be aligned ("???..???"). 

 "Manual" adaptation of the message frame configuration (e.g. when additional data, such as a motor 
temperature, is to be transferred via the message frame) 

 Display of the individual control and status words of the associated message frame. 

 Setting the addresses (alignment of the addresses with HW Config)  
Only the addresses of the respective device are determined (no automatic determination of message frames / 
BICO interconnections) 

 

 

 Note 

If symbolic assignment is deactivated, the following applies: 

If the message frames for drive objects change (drives, terminal modules, etc.), you must set 
up the addresses again. The addresses are not updated automatically. 

 

7.10 Linking an additional encoder (optional) 

7.10.1 Fundamentals 

Using encoders 
In addition to a motor encoder, additional encoders can be linked and configured: 

● Additional encoders on the drive 

– Encoders with DRIVE-CLiQ interface 

– Encoders connected to a CU310 or CUA32 via the onboard encoder interface 

– Encoders connected to SIMOTION D via an SMx module 

● Additional encoders on SIMOTION D 

– Encoders connected via PROFIBUS 

– Encoders connected via PROFINET 
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Configuring additional encoders 
The additional encoder can be used in SIMOTION, for example, as: 

● Machine encoder (second encoder = direct measuring system) 

A direct measuring system measures the technological parameter directly, i.e. without the 
interference of influences such as torsion, backlash, slip, etc. This can facilitate improved 
smoothing of mechanical influences by means of the closed-loop control. If you use a 
second encoder as a machine encoder, you can work with the encoder changeover 
function.  

● External encoders 

You can use the external encoder to record an external master value, for example. 

● Encoder for hydraulic axes 

● Encoders for the implementation of cam controllers 

7.10.2 Additional encoders on the drive 
The following options are available for configuring additional encoders on the drive: 

● Configuration of a second encoder on the drive 

● Configuration of an encoder as drive object (as of SINAMICS firmware V4.3). 

The following options are available for configuring additional encoders on the drive. 

Second encoder on the drive 
The configuration of a second encoder on the drive is useful when the second encoder value 
is also to be used for this drive (e.g. motor or machine encoder). Note that only a maximum 
of two encoder values can be transferred via PROFIdrive message frames.  

In principle, the second encoder value can be freely used (e.g. for acquisition of an external 
master value), however the use of an encoder as a separate drive object (drive object 
DO encoder) is preferable because of the clear functional separation.  

 
Figure 7-45 Configuration of a second encoder on the drive 
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Encoder as drive object 
The configuration of an encoder as drive object (drive object DO encoder) has the advantage 
that this encoder can be used independently of a configured drive (e.g. for acquisition of a 
master value).  

The configuration is performed by inserting an encoder via the project navigator.  

The DO encoder is only available as of SINAMICS V4.3, i.e. only available on control units of 
the latest generation (e.g. SINAMICS S120 CU320-2, SIMOTION D4x5-2, CX32-2 --- but not 
for the SINAMICS Integrated of a D4x5 and CX32) 

 
Figure 7-46 Configuration of an encoder as drive object 

7.10.3 Additional encoders via PROFIBUS/PROFINET 
Additional encoders for the encoder integration can be connected via PROFIBUS or 
PROFINET. The following options are available: 

● Encoder interconnection using a PROFIdrive message frame (encoder with message 
frame type 81) 

● Encoder interface as a direct value in the I/O area 

Additional references 

Detailed information is contained in the  
SIMOTION TO Axis, Electric/Hydraulic, External Encoder Function Manual 
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7.11 Symbolic assignment of I/O variables (PROFIdrive message frame / 
drive parameters) 

7.11.1 Symbolic assignment of I/O variables to the PROFIdrive message frame of the 
TO axis 

You can assign I/O variables from the address list which you require for display and 
diagnostic purposes, for example, to individual components (status word, for example) of the 
PROFIdrive message frame using the assignment dialog. Only components suitable for the 
data type of the I/O variable are displayed. If no data type is specified at the I/O variable, this 
is determined via the assignment partner after the selection. 

 
Figure 7-47 Assignment of I/O variables to the PROFIdrive message frame 

7.11.2 Symbolic assignment of I/O variables to drive parameters 
I/O variables from the address list can be assigned to drive parameters using the assignment 
dialog. Only parameters suitable for the data type of the I/O variable are displayed. If no data 
type is specified at the I/O variable, this is determined by the parameter selection. 

An extension of the standard message frame is created automatically for the transfer of the 
parameters to/from the drive. 
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Procedure 
1. Open the assignment dialog box from the address list (view of all addresses). 

The assignment dialog opens with the corresponding assignment partners.  

2. Click the  button in the parameter selection line to open the parameter list. 

 
Figure 7-48 Assignment dialog for drive parameters 
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3. Select the desired signal source (e.g. DO drive). Then select the required parameter. 

 
Figure 7-49 Dialog box for the DO and parameter selection 

4. Click "OK" to accept the selection. 
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5. The desired SINAMICS parameter is assigned to the I/O variable in the interconnection 
dialog box. 

 
Figure 7-50 Assigned drive parameters 

6. Click "OK" to accept the assignment. 

The following table shows the possible types of assignment: 

 
Name of the assignment Data type Direction Transferrable BICO parameters 
BICO_IW.<parameter number>  WORD Input  All CO parameters (BICO source) 
BICO_QW.<parameter number> WORD Output All CI parameters (BICO sink) 
BICO_ID.<parameter number> DWORD Input All CO parameters (BICO source) 
BICO_QD.<parameter number> DWORD Output All CI parameters (BICO sink) 

Syntax of the assignment names 
● A number of parameters (separated by periods) are specified for outputs (SINAMICS side 

= received data) which can be interconnected with a number of BICO sinks. 

● If the transferred parameter is on another drive object (DO), the DO name precedes the 
parameter. "#" is used as a separator between the DO name and the parameter. 

● Individually transferred bits of a parameter appear in brackets [x]. 
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7.12 Configuration of drive-related I/Os (with symbolic assignment) 

Overview  
SIMOTION D4x5, the CX32 controller extension as well as the SINAMICS S110/S120 
control units and additional components (TB30, TMs) have I/Os that can be used by the 
drive unit and SIMOTION. 

So that I/Os, which were originally assigned to SINAMICS can be used by SIMOTION they 
must be interconnected to a message frame. 

Symbolic assignment 
As of version V4.2, SIMOTION SCOUT supports the symbolic configuration of I/Os. "Use 
symbolic assignment" must be activated for this purpose (see also Section Symbolic 
assignment/adaptation (Page 135)) 

The symbolic assignment simplifies the configuration significantly: 

Table 7- 8 Comparison of configuration with/without symbolic assignment 

 With symbolic assignment Without symbolic assignment 
Configuring message frames So that SIMOTION can use 

SINAMICS I/Os, the required message 
frames are created automatically 

Message frames must be set manually 
(either predefined message frame 
(e.g. 39x) or free message frame 
configuration) 

BICO interconnections The required BICO interconnections 
are made automatically (I/Os are 
interconnected to message frame) 

With predefined message frames 
(e.g. 39x), the BICO interconnections 
are made automatically  
With free message frame configuration 
with BICO, the interconnection must be 
made by the user 

Parameterization the I/O functionality 
(e.g. measuring input) 

Parameterization via screen forms Parameterization via screen forms and 
partly via parameters in the expert list 

Handling of I/O addresses Handling of addresses is not required 
because of symbolic assignment 

I/O addresses must be determined 

Setting up addresses Addresses are set up automatically, 
see also Section Setting up 
communication for symbolic 
assignment (Page 216) 

Addresses must be set up manually, 
see also Section Message frame 
configuration (Page 216) 

Only the configuration with symbolic assignment is described in the following. For further 
information on the configuration of drive-related I/Os without symbolic assignment, see 
Appendix  
Configuration of drive-related I/Os (without symbolic assignment) (Page 323). 
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Procedure 
The configuration of the I/Os is divided into two basic steps: 

1. Configuration of the I/O terminals (Page 227). The functionality of an I/O channel is 
configured (e.g. configuration of a DI/DO as digital output) 

2. Configuration of the technology objects and I/O variables (Page 230). 
The access of technology objects and I/O variables to I/Os is configured. 
The configuration is performed symbolically, whereby only "function-compatible" I/O 
channels are offered for selection.  
Example:  
For the TO measuringInput, only symbolic assignments of the type MI (measuring input) 
are offered for selection. 

The required message frames and the interconnection are then set automatically by the 
engineering system. 

See also 
Configuration of drive-related I/Os (without symbolic assignment) (Page 323) 

7.12.1 Configuration of the I/O terminals 
The following table provides an overview of the configuration options for the I/O terminals of 
various modules.  

Table 7- 9 Overview of the configuration of the I/O terminals  

Use of the I/Os by Configuration of the I/O terminals Supports symbolic 
assignment 

Module 

SIMOTION SINAMICS   
SIMOTION D4x5-2 
- X122/X132 
- X142 

 
X1) 
X 

 
X 
- 

 
On the drive unit (CU) 
On the D4x5-2 (HW Config) 

As of SIMOTION V4.2  

SIMOTION D4x5 X1) X On the drive unit (CU) As of SIMOTION V4.2  
CX32-2,  
CX32 

X1) X On the drive unit (CU) As of SIMOTION V4.2  

SINAMICS S110 
CU305 

X1) X On the drive unit (CU) As of SINAMICS V4.3 

SINAMICS S120  
- CU310 
- CU320 
- CU320-2 

X1) X On the drive unit (CU)  
- As of SINAMICS V2.6.2 
- As of SINAMICS V2.6.2 
- As of SINAMICS V4.3 

TB30, TM15 DI/DO, 
TM31 

X1) X On the drive unit (TB30 or TM) Yes 
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Use of the I/Os by Configuration of the I/O terminals Supports symbolic 
assignment 

TM41 X1) X On the drive unit (TM41) Yes 2) 
TM15, TM17 High 
Feature 

X - On the drive unit (TM15  
or TM17) 

Yes 

1) I/Os are originally assigned to a SINAMICS drive unit and can be assigned to SIMOTION via configuration  
2) TM41 only supports the symbolic assignment for the encoder interface (no symbolic assignment for the DI, DO and AI) 
 

 

 Note 

The module hardware for TM15 and TM15 DI/DO is identical. A distinction is only made by 
the addition of the component in the SIMOTION SCOUT project navigator using "Inserting 
input/output component".  

 

I/Os that are originally assigned to the SINAMICS drive unit can also be used by SIMOTION 
via configuration. 

● An output is always only exclusively available for the SINAMICS drive unit or SIMOTION. 

● An input used by SIMOTION can also be interconnected on the drive side. 

The configuration of the I/O terminals is described in detail in the following: 

● Configuration of the D4x5 I/Os (terminal X122/X132) (Page 228) 

● Configuration of the CX32/CU3xx/TB30/TMxx I/O terminals (Page 229) 

7.12.1.1 Configuration of the D4x5 I/Os (terminal X122/X132) 

Procedure 
The I/Os of terminals X122 and X132 are originally assigned to the drive unit. The 
configuration is therefore performed via the drive unit ("SINAMICS_Integrated" > 
"Control_Unit" > "Inputs/outputs).  

The properties of the I/O channel can be configured in the parameterization dialog box. With 
the bidirectional digital inputs/outputs, for example, an I/O channel can be: 

● Parameterized as input or output 

● Inverted 

● BICO-interconnected (use as drive I/O) 

● Used as digital input for SIMOTION with "DI (SIMOTION)" 
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● Used as digital output for SIMOTION with "DO (SIMOTION)" 

● Used as global measuring input for SIMOTION with "Measuring input (SIMOTION)" 

 
Figure 7-51 Configuration of the D4x5 I/Os (terminal X122/X132) 

 

7.12.1.2 Configuration of the CX32/CU3xx/TB30/TMxx I/O terminals 
The configuration is performed in a similar way as for the onboard I/Os X122/X132 for the 
SIMOTION D4x5, i.e. I/Os can be 

● BICO-interconnected (use as drive I/O) 

● Used by SIMOTION 

See also Section Configuration of the D4x5 I/Os (X122/X132) (Page 228) 
 

 Note 

If symbolic assignment is subsequently activated for a project in which message frames 
have already been configured and interconnected, these can be changed together with the 
BICO interconnections! 

For this reason, make a backup copy of your project before activating the symbolic 
assignment. TB30, TM15 DI/DO and TM31 are especially affected. 

See also Section Symbolic assignment / adaptation (Page 135) 
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7.13 Configuration of the technology objects and I/O variables 

7.13.1 Configuration of global measuring inputs 

Overview  
The type of measuring input must be selected during the configuration of the TO 
measuringInput. 

The following measuring input types are available: 

Table 7- 10 Measuring input types 

Measuring input types Explanation 
Standard (global 
measuring input) 

Compared with the drive-related local measuring inputs, global measuring 
inputs have extended functionality and also support a symbolic 
configuration.  
They are therefore set as standard. 

Drive-related (local 
measuring input) 

The drive-related local measuring inputs are configured via drive 
parameters, see Section Configuration of drive-related I/Os (without 
symbolic assignment) (Page 323) in the appendix. 

Listening measuring 
input 

Through the configuration of a listening measuring input, measuring can be 
performed simultaneously on several axes or external encoders with one 
measuring input. Detailed information can be found in the SIMOTION 
Motion Control Output Cams and Measuring Inputs Function Manual. 

A detailed comparison of "local" and "global" measuring inputs as well as an overview of 
which modules support local or global measuring inputs can be found in Section 
Configuration of drive-related I/Os (without symbolic assignment) (Page 323) in the 
appendix. 

Procedure  
If a global measuring input is selected, it must be assigned a hardware input. 

To do this, open the assignment dialog box via  and select a free (i.e. not yet used) I/O.  
 

 Note 

Only those I/Os are displayed that have the appropriate measuring input functionality (MI_xx 
[channel name, terminal number]). If no suitable I/Os are displayed, you must first configure 
the I/Os (I/O must be configured as "measuring input") 
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Figure 7-52 Configuration of a global measuring input for the D4x5 

Detailed information on the configuration of the TO measuringInput can be found in the 
SIMOTION Output Cams and Measuring Inputs Function Manual. 

7.13.2 Configuration of local measuring inputs 
Local measuring inputs are drive-related measuring inputs. The configuration is performed 
via drive parameters. 

For further details, see: 

● Section Configuration of drive-related I/Os (without symbolic assignment) (Page 323) in 
the appendix 

● SIMOTION Output Cams and Measuring Inputs Function Manual 

See also 
Configuration of drive-related I/Os (without symbolic assignment) (Page 323) 

7.13.3 Configuration of output cams / cam tracks 

Overview 
The type of cam output must be selected during the configuration of the TO outputCam and 
TO camTrack. 
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The following output types are available: 

Table 7- 11 TO outputCam / TO camTrack output types 

Cam output on... Explanation 
Cam output (CAM) The cam output is performed on the basis of an internal time stamp. 

The temporal resolution of the cam output depends on the hardware 
used. 
Supported hardware: 
• SIMOTION D4x5-2 (terminal X142): Resolution 1 μs 
• TM17 High Feature: Resolution 1 μs 
• TM15: Typical resolution 125 μs (DRIVE-CLiQ cycle clock) 

High-speed digital output 
(DO) 

The cam output is performed via onboard outputs of the SIMOTION 
CPU. The output is via a hardware timer, whereby the cam output is 
achieved with a resolution with respect to time < servo cycle clock.  
Supported hardware: 
 SIMOTION D4x5 (terminal X122, X132) 
 SIMOTION D410 (terminal X121) 
 SIMOTION C240, C240 PN (terminal X1) 

Standard digital output 
(DO) 

The output cam calculations are performed in the execution cycle (IPO 
or IPO2 cycle clock or in the servo cycle clock).  
The actual cam output is performed in the servo cycle clock. The 
resolution with respect to time of the cam output is generally reduced 
by the output cycle of the I/O used. 
The resolution is therefore dependent as follows: 
 For the standard I/O (e.g. ET 200), on the cycle time of the bus 

system (PROFIBUS DP / PROFINET IO) 
 For the TM15 / TM17, on the cycle time of the bus system 

(PROFIBUS Integrated / PROFIBUS DP / PROFINET IO) 
 For the TM15 DI/DO, TM31, TM41, TB30, on the configured 

sampling time: 
– cu.p0799 (CU inputs/outputs sampling time) for the TB30 and 

onboard outputs 
– p4099 (TMxx inputs/outputs sampling time) for TM15 DI/DO, 

TM31 and TM41 
Supported hardware: 
 Onboard outputs (SIMOTION D, CX controller extension, 

SINAMICS CU3xx control unit) 
 Centralized I/O (SIMOTION C) 
 Distributed I/O via PROFIBUS DP / PROFINET IO (e.g. ET 200, 

etc.) 
 Drive-related I/O (TM15, TM15 DI/DO, TM17 High Feature, TM31, 

TM41, TB30) 
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Procedure  
To achieve the best possible output cam resolution on the onboard I/Os of a SIMOTION 
D4x5, activate the output and select "Cam output on fast digital output (DO)".  

Then assign a hardware output. To do this, open the assignment dialog box via  and 
select a free (i.e. not yet used) I/O.  

 

 Note 

Only those I/Os are displayed that have the appropriate functionality (DO_xx [channel name, 
terminal number]). If no suitable I/Os are displayed, you must first configure the I/Os (I/O 
must be configured as "DO") 

 

 
Figure 7-53 Configuration of an output cam for the D4x5 

Detailed information on the configuration of the TO outputCam / TO camTrack can be found 
in the SIMOTION Output Cams and Measuring Inputs Function Manual. 
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7.13.4 Configuration of the I/Os (variables / TO axis) 

I/O variables 
The I/O variables are configured via the address list. Components that support a symbolic 
assignment can be configured without I/O addresses. Components that do not support 
symbolic assignment (e.g. standard PROFIBUS I/O) are configured via I/O addresses.  

 
Figure 7-54 Address list 

TO Axis 
The symbolic assignment of I/Os is also supported by the TO axis (e.g. for a HW limit 
switch).  

Substitute values for I/O variables 
Substitute values cannot be specified for input variables of the BOOL data type. If you do 
require substitute values however, proceed as follows: 

1. Assign a digital input (e.g. SINAMICS_Integrated.Control_Unit.DI_0 [DI 0, X122.1]) to an 
input variable of the BOOL type (e.g. sensor). 

2. Create a global variable (e.g. all_inputs) (at least data type WORD, e.g. 
SINAMICS_Integrated.Control_Unit.DI_0_15). 

3. Configure the substitute value  
The appropriate bit of the substitute value must then contain the substitute value for the 
BOOL variable.  
In the same way, you can assign a substitute value to a BICO parameter. 

For various SINAMICS drive objects, higher-level types are available for the assignment of 
substitute values.  

 
Figure 7-55 Configuration of substitute values 
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7.14 DMC20/DME20 DRIVE-CLiQ hub 

7.14.1 Hub properties 

DRIVE-CLiQ hub characteristics 
The DMC20 and DME20 DRIVE-CLiQ hub modules are used to implement point-to-point 
distribution of a DRIVE-CLiQ line. With the DMC20/DME20, an axis grouping can be 
expanded with four DRIVE-CLiQ sockets for additional subgroups. 

● DMC20 is the hub for the control cabinet configuration 

● DME20 is the hub for use without a control cabinet (IP67 degree of protection). 

The modules are especially suitable for applications which require DRIVE-CLiQ nodes to be 
removed in groups, without interrupting the DRIVE-CLiQ line and therefore the data 
exchange.  

Application examples 
Typical applications of DRIVE-CLiQ hubs are encoder expansion and hot plugging. 

● In an encoder expansion, direct measuring systems are connected. For example, these 
are attached directly to the machine in the control cabinet. Several encoders can be 
connected to one hub in the cabinet. 

● Hot plugging is the option for changing motor modules while in operation. To do so, the 
motor modules are connected via a DRIVE-CLiQ hub in the form of a point-to-point 
topology. This means they can be deactivated without impairing downstream components 
(via cascading). 

  Note 

Cascading is permitted one time only (from hub to hub). 

Additional references 
Additional information on the DMC20/DME20 DRIVE-CLiQ is contained in the  

● SIMOTION D4x5 Manual. 

● SINAMICS S120 Control Units and Additional System Components Manual. 
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7.14.2 Creating a DMC20/DME20 DRIVE-CLiQ hub 

Introduction 
A DMC20/DME20 can be inserted directly in the project navigator. The hub is not wired 
when you insert the DMC20/DME20 and is displayed in the topology tree in the component 
storage. The hub has to be wired manually.  

Procedure 
1. Right-click "Topology" in the project navigator. 

2. Select the "Insert new object" > "DRIVE-CLiQ hub" command from the context menu and 
confirm with "OK". 

3. Double-click "Topology" to display the topology tree. 

In the topology tree, the hub is stored in the component archive.  

4. Drag-and-drop the hub to the required DRIVE-CLiQ interface. 

The components connected to the hub are displayed in the topology tree. 

Result 
The added hub is displayed for the "Topology" entry in the project navigator. All components 
connected to a hub are also displayed during an automatic configuration.  

7.15 TM41 Terminal Module 

7.15.1 Overview 
The TM41 terminal module can be used to expand the number of digital I/O and of analog 
inputs within a drive system. TM41 also returns TTL signals which emulate an incremental 
encoder, for example, for a master control system.  

The emulated encoder signal has the signal characteristic of an incremental TTL encoder (A 
track, B track, R track). The resolution of the encoder signal can be specified in the 
configuration. 

 

 Note 

The digital I/Os and the analog input can be interconnected with BICO configuration in the 
same way as a TM31. 
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The TM41 encoder interface (incremental encoder representation) can 

● Be interconnected with an encoder signal of the control unit by means of 
parameterization, e.g. sin/cos incremental encoders. For detailed information, see the 
SINAMICS manuals. 

● From the SIMOTION viewpoint, can be accessed as axis. This allows you to return the 
axis position (a master value) as an encoder signal to a second controller, for example. 
The configuration can be performed symbolically and is described in the following. 

  Note 

TM41 only supports the symbolic assignment for the encoder interface (no symbolic 
assignment for the DI, DO and AI). 

Configuring the TM41 involves the following steps: 

● Configuring TM41 at SINAMICS Integrated 

● Configuring TM41 using the axis wizard. 

7.15.2 Configuring TM41 at SINAMICS Integrated 
TM41 can be configured after you completed the configuration of SINAMICS Integrated. 
Proceed as follows:  

1. Double-click "Insert input/output component" at "Input/output component" in the project 
navigator. 

2. Select TM41 from the "Drive object type" field of the "Insert Input/Output Component" 
dialog box and assign a unique name to the module. 

3. Confirm your entry with "OK". 

The TM41 is inserted in the project navigator by the name you entered. 

4. Double-click "Inputs/outputs". The "Inputs/Outputs Properties" dialog box of TM41 opens. 

5. Set "SIMOTION" as the operating mode on the "Pulse encoder emulation" tab, and make 
the settings for the emulated sensor signal. 

6. Double-click "Configuration" under "SINAMICS_Integrated" in the project navigator and 
select the "PROFIdrive message frame" tab. 

7. Click "Close" to exit the dialog box. 

You programmed TM41 and aligned it with HW Config. 
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7.15.3 Configuring TM41 using the Axis Wizard. 
After configuring the TM41 for a SINAMICS Integrated device in the project navigator, you 
can interconnect it with an axis using the axis wizard. The wizard implements the TM41 as 
drive device.  

1. Open the axis wizard and create a positioning or synchronization axis (electrical). 

2. Step the axis wizard forward until the "Drive Assignment" dialog box opens. 

3. Select "SINAMICS_Integrated" as the drive device and "TM41" as the drive. 

TM41 operates as setpoint sink of the axis with this setup.  

 

4. Run through the wizard to the end. 

Detailed information on configuring incremental encoder emulation with the TM41 can be 
found in: 

● FAQ list http://support.automation.siemens.com/WW/view/en/27554028  

● SIMOTION Utilities & Applications. 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 

7.16 Optimizing drive and closed-loop controller 

7.16.1 Overview of automatic controller setting 

Overview 
For the controller optimization of the drive, SIMOTION SCOUT offers a wizard for the 
automatic controller setting. 

In the "Automatic Controller Setting" screen form, you can configure an automatic setting for 
the speed controller and the DSC (dynamic servo control) position controller for SINAMICS 
drive units. The necessary steps for this calculation can be controlled from this screen form. 
The parameter values calculated for the speed controller or position controller are displayed; 
these can then be transferred online to the drive or axis on the controller. 
You can set the controller automatically using the menu command "Target system" > 
"Automatic controller setting". 

For a detailed description of the parameters that can be defined, to the SIMOTION SCOUT 
Online Help. 
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Requirements 
● You have configured a SINAMICS drive. 

● The configured drive is operated in the "Servo" drive object type. 

● Closed-loop control takes place with the motor encoder. 

● There is an online connection to the relevant drive unit. 

Procedure 
Automatic controller setting involves the following steps: 

1. Setting the speed controller 

2. Setting the position controller 

  Note 

You can cancel automatic controller setting by pressing the SPACEBAR. 
 The step currently being executed is aborted. 
 The drive enable is canceled. 

Additional references 
Information on the controller structure can be found in the SIMOTION TO Axis, 
Electric/Hydraulic, External Encoder Function Manual. 

In addition to automatic controller setting, SIMOTION SCOUT also offers the option of 
optimizing the drive and controller manually by means of measuring functions, trace, and 
function generator (see Measuring functions, trace, and function generator (Page 242) and 
Manual speed controller optimization (Page 243) in this manual). 

7.16.2 Automatic speed controller setting 

Characteristics  
The automatic speed controller setting has the following features: 

● Attenuation of resonances in the speed-controlled system 

● Automatic setting of the gain factor Kp and the integral time Tn of the speed controller 

● The speed setpoint filter and the reference model are not changed  
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Procedure 
To perform an automatic setting of the speed controller, proceed as follows: 

1. Select the "Target system" > "Automatic controller setting" menu command. 

2. Select the drive unit and the drive. 

3. Select the "Speed controller" from the "Controller selection". 

4. Click "Assume control priority" to assume control priority. 

5. Press the "Drive On" button to enable the drive. 

Perform these steps (1 to 4) in automatic mode or as individual steps. 

6. Click "Transfer" to transfer the calculated parameter values for the speed controller to the 
drive. 

7. Disable the drive by clicking the "Drive Off" button. 

8. Click "Give up control priority" to give up control priority of the PG/PC. 

9. Save the online parameters. 

You can now transfer the automatically set parameters to the project. 

Backing up parameters 
Proceed as follows to back up the parameters: 

1. In the project navigator, select the SINAMICS unit with the drive for which you want to 
perform the automatic setting 

2. Select "Target device" > "Copy RAM to ROM" in the context menu. 

3. Select "Target device" > "Load CPU / drive unit to PG" in the context menu. 

If necessary, the automatic controller settings can be verified with the measuring functions.  

7.16.3 Automatic position controller setting 

Introduction  
In the "Automatic Controller Setting" screen form, you can select the SINAMICS drive unit 
and the drive for which you want to carry out an automatic DSC position controller setting. 
The necessary steps for this calculation can be performed from this screen form. The 
calculated Kv value is displayed and can then be accepted online in the configuration data of 
the axis that is assigned to the drive.  
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Requirements 
In addition to the General requirements for the automatic controller setting, the following 
boundary conditions apply for setting the position controller: 

● DSC is required for the position controller setting.  
Tip: 
Activate the project setting "Use symbolic assignment" and select the Standard/Automatic 
option for the axis-drive communication when configuring the drives. You automatically 
use DSC for the servo drives with these settings. 

● The speed controller has already been configured (e.g. with the automatic speed 
controller setting). 

● At least one axis is connected to the SINAMICS drive (servo). 

● An online connection to the SIMOTION device must be established to transfer the results 
of the automatic position controller setting. 

● The balancing filter is not changed. 

● For operation without precontrol, the equivalent time constant of the position controller 
must be adjusted manually by the user (PositionTimeConstant = 1/Kv). 

● Vibration on the load side is not taken into account for the position controller setting. 

Procedure 
To perform an automatic setting of the position controller, proceed as follows:  

1. Select the "Target system" > "Automatic controller setting" menu command. 

2. Select the drive unit and the drive (axis). 

3. Select the "Position controller (DSC)" from "Controller selection". 

4. Click "Assume control priority" to assume control priority. 

5. Press the "Drive On" button to enable the drive. 

Perform the steps either in automatic mode or as individual steps. 

6. Select the axis data sets to which the Kv factor is to be transferred. 

7. Click "Transfer" to transfer the calculated Kv factor to the axis data sets. 

8. Disable the drive by clicking the "Drive Off" button. 

9. Give up the control priority of the PG/PC. 

10. Save the online parameters. 

You can now transfer the automatically set parameters to the project.  

Backing up parameters 
Proceed as follows to back up the parameters:  

1. In the project navigator, select the SIMOTION unit with the axis for which you want to 
perform the automatic setting 

2. Select "Target device" > "Copy current data to RAM" in the context menu. 
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3. Select "Target device" > "Copy RAM to ROM" in the context menu. 

4. Select "Target device" > "Load CPU / drive unit to PG" in the context menu. 

If necessary, the automatic controller settings can be verified with the measuring functions.  

7.16.4 Measuring functions, trace, and function generator 

Drive optimization 
Drive optimization is part of commissioning and can be performed with SIMOTION SCOUT.   

 

CAUTION  
Controller optimization may only be performed by skilled personnel with control engineering 
knowledge. 

 

Controller optimization   
Various measuring functions are available for controller optimization of the drive. These 
measuring functions enable the control of the higher-level control loop to be selectively 
switched off and the dynamic response of individual drives to be analyzed through simple 
parameter assignment. The function generator and the trace recorder are used.   

The control loop is supplied with the ramp-function generator signal at a specific point (e.g., 
speed setpoint), and the signal from the trace recorder is recorded at another point (e.g., 
speed actual value). 

 
Figure 7-56 Optimizing a closed-loop controller 
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Depending on the form of controller optimization to be performed, it is possible to define the 
quality (e.g. signal form, amplitude, transient recovery time) of the disabled signal, the 
measuring duration for step functions in the time range, or the bandwidth and number of 
averaging operations in the frequency range for the trace. The analytical and graphical 
evaluation can then be performed accordingly (FFT diagram, Bode diagram). 

The following measuring functions are available: 

● Setpoint step-change at current controller 

● Reference frequency response at current controller 

● Setpoint jump at speed controller 

● Disturbance step-change at speed controller 

● Reference frequency response at speed controller 

● Disturbance frequency response at speed controller 

● Speed-controlled system (input at current setpoint filter) 

Additional references 
For additional information about drive optimization, consult the SINAMICS S120 
Commissioning Manual. 

Additional information on trace and measuring functions, as well as on the function 
generator, can be found in the SIMOTION SCOUT Online Help. 

7.16.5 Manual speed controller optimization 

Requirement 
You have already created a project and configured an axis and a drive. You can now 
optimize the speed controller.  

Procedure 
1. Open the project and go to online mode. 

2. Click  to call the "Measuring Functions" dialog. The activated Service function is 
displayed via the LEDs (RUN flashes green at 2 Hz and SU/PF flashes yellow at 2 Hz) 

3. Select the drive unit and the drive. 
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4. Select "Speed controller setpoint jump".  
You can change the values in the following fields: "Settling time", "Amplitude", "Offset", 
"Ramp-up time" and "Measuring time". 

 
Figure 7-57 Speed controller measuring function 

 

Four channels can be traced. Certain channels are preassigned, depending of the 
measuring function. 

5. Download the changes to the drive by clicking  (Download parameter assignment). 

Starting the measuring function  
1. Click "Assume control priority" to assume control priority. 

Read the notice that appears and click "Accept" to confirm. 

2. Press the "Drive On" button to enable the drive. 



 Commissioning (software) 
 7.16 Optimizing drive and closed-loop controller 

SIMOTION D4x5 
Commissioning and Hardware Installation Manual, 11/2010 245 

3. Click  (Start measuring function) to start the measuring functions. 

The axis is moved during the measurement. For this reason, a safety message that 
allows the process to be aborted is displayed. 

After reading the notices, you can begin the measurement with "Accept" or abort it with 
"Abort". 

4. The traced signals are represented on the "Timing Diagram" tab. 

 
Figure 7-58 Timing diagram before parameter change 
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Adjusting the P-Gain  
You can adjust the P-gain of the controller to optimize the transient response. 

1. In the project navigator under the corresponding drive, for example, Servo_1, use the 
menu command "Open-Loop/Closed-Loop Control" > "Speed Controller" to display the 
"Speed Controller with Encoder" dialog. 

2. Enter an appropriate value in the "P-gain" field and the "Integral time" field. 

CAUTION  
 

The values entered take immediate effect. 

 
Figure 7-59 Entering P-gain 
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3. For verification purposes, perform the measurement again. 

4. With the modified parameters, the controller displays a much better transient response. If 
necessary, you can continue changing the value until the transient response is optimal. 

 
Figure 7-60 Measurement with modified P-gain 

7.17 Downloading and storing user data 

Overview 
After commissioning the SIMOTION D4x5, we recommend that you back up the user data 
(programs, configuration data, and parameter assignments) to the CF card. 

Loading user data 
The menu command "Target system" > "Load" > "Download project to target system" is used 
to transfer the following data from the SIMOTION SCOUT engineering system to the "non-
volatile data" area of the SIMOTION D4x5: 

● Configuration data 

● Programs 

● Parameter assignments 

● Technology packages 
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The hardware configuration of SIMOTION D4x5 and the retain variables are also saved to 
the "non-volatile data" area.  

 

 Note 

Using the menu:  
 "Target system" > "Load" > "Load project to target system" downloads all of the project 

data to the target system. 
 "Target system" > "Load" > "Download CPU / drive unit to target device" only downloads 

the data of the selected device / drive element to the target device. 

After the SIMOTION D4x5 is switched off, the contents of the "volatile data" area are lost. 
 

Additional information on the SIMOTION SCOUT Engineering System can be found in the 
SIMOTION SCOUT Configuration Manual. 

Storing user data 
The "Copy RAM to ROM" function is used in SIMOTION SCOUT to save the following data 
from RAM to the CF card: 

● Technology packages and user data (units, configuration data, parameter assignments, 
task configuration) from the "volatile data" area 

● Current values are copied to the "volatile data" area, depending on the settings in 
SIMOTION SCOUT 

  Note 

The "Copy RAM to ROM" function does not save the current values of the retain variables 
to the CFcard. 

You have the following options for backing up the current values of retain variables to the 
CF card: 

● In the user program 
Use the "_savePersistentMemoryData" system function for this purpose. 

● Using a switch position (SIMOTION D4x5 Service selector switch) or IT DIAG. 
See Section Backing up diagnostics data and non-volatile data (Page 310). 

With the SCOUT functions "Back up variables" and "Restore variables", you also have the 
option of backing up to your PC and restoring data that was changed during operation and 
only stored in the runtime system. 

Execute the "Copy RAM to ROM" function separately for the SINAMICS Integrated. This 
requires that the drive element has been selected in the project navigator.  

See also 
Properties of the user memory (Page 89) 
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7.18 Deleting data 

7.18.1 Overview of data deletion 
The SIMOTION D4x5 memory described in the "user memory concept" can be deleted in 
various gradations. This enables you to determine whether data in your system should be 
deleted completely or partially.  

You have the following options for deleting SIMOTION C4x5 data: 

● Memory reset of SIMOTION D4x5 (Page 249) 

● Deleting user data on CF card (Page 252) 

● Setting SINAMICS Integrated to the factory settings (Page 253) 

● Setting SIMOTION D4x5 to the default settings (Page 253) 

● Deleting/restoring non-volatile data (Page 317) 

7.18.2 Overall reset of SIMOTION D4x5 

Introduction 
During the overall reset, the memory of the SIMOTION D4x5 and the non-volatile data in the 
SRAM (with the exception of the communication configuration (baud rates, network 
addresses, etc.)), are deleted. The data on the CF card are retained during the memory 
reset.  

You must perform a memory reset of SIMOTION D4x5: 

● When you want to undo changes you have made to your user data (programs, 
configuration data, parameter assignments) that you have not backed up with the "Copy 
RAM to ROM" menu command. 

● If the STOP LED is flashing (yellow and slowly) to indicate that the SIMOTION D4x5 is 
requesting a memory reset. 

● If the non-volatile data and the project on the CF card do not match and an error occurs 
(diagnostic buffer entry). 

You can perform the memory reset online via SIMOTION SCOUT or offline via the mode 
selector on the SIMOTION D4x5. 

Data deleted on memory reset 
The following data is deleted during a memory reset: 

● User data (units, configuration data, parameter settings, task configuration) 

● Technology packages 
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● Retain TO (absolute encoder adjustment) 

● Retain variables 

Retain variables are variables in the interface or implementation section of a UNIT that 
are declared with VAR_GLOBAL RETAIN or global device variables with the RETAIN 
attribute. 

  Note 

Absolute encoder data is deleted during a memory reset operation and must therefore be 
readjusted after the memory reset. 

Reset-proof data 
The following data is retained during a memory reset: 

● TCP/IP parameters and DP parameters 

● Diagnostics buffer 

● Data saved with the _savePersistentMemoryData, _saveUnitDataSet or 
_exportUnitDataSet system functions and with the "Copy RAM to ROM" function 

If backup files (PMEMORY.XML/PMEMORY.BAK) have been backed up with 
_savePersistentMemoryData, the data in these files are backed up again to the non-
volatile data after the memory reset. Thus, the user can perform a memory reset to force 
the backed up non-volatile data to be restored. This also includes the absolute encoder 
position. 

● Licenses 

The technology packages and user data (configuration data, programs, parameter 
assignments) that were previously backed up to the CF card using the "Copy RAM to ROM" 
menu command will be transferred to the "non-volatile data" area of the SIMOTION D4x5 
during the next power-up. Thus, an existing configuration on the CF card is loaded to the 
SIMOTION device following the memory reset. 

Memory reset via SIMOTION SCOUT 
You can only perform a memory reset via SIMOTION SCOUT if you are online with the 
SIMOTION D4x5. 

1. Select the SIMOTION D4x5 in the project navigator of SIMOTION SCOUT. 

2. Select "Target device" > "Operating mode" in the context menu to open the "D4x5: 
Operating Mode" dialog. 

3. Select the STOP mode. 

4. Then select MRES mode to perform the memory reset.  
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Memory reset with the mode selector 
You can perform a memory reset with the mode selector if you are offline with the 
SIMOTION D4x5. 

 

CAUTION  
Always use an insulated screwdriver to activate the mode selector. Otherwise, static 
electricity can destroy the switch. 

 

Proceed as follows to initiate a memory reset:  

1. Place the mode selector in the STOP position (switch setting 2, see figure below). 

 
Figure 7-61 Memory reset with the mode selector (STOP position) 

 

2. When the STOP LED is steadily yellow, turn the switch to the MRES position (switch 
position 3). The STOP LED starts to flash slowly (slow yellow flashing). 

Wait until the STOP LED stops flashing. 

3. Turn the switch back to the STOP setting. 
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4. You must turn the selector back to the MRES position again within 3 seconds. The 
memory reset will now be performed. 

The SIMOTION D4x5 has completed the overall reset when the STOP LED lights up 
steady yellow. 

  Note 

If you do not return the mode selector to the MRES position (switch setting 3) within 3 
seconds (i.e. you allow more time to elapse), under certain circumstances the memory 
reset will not take place. You must then repeat the procedure. 

5. Now move the mode selector back to the required operating mode. 

NOTICE  
 

Note that the MRES position (switch setting 3) during power-up causes the default 
settings to be restored. See Setting SIMOTION D4x5 to the default settings (Page 253). 

Make sure you do not accidentally switch the power supply OFF/ON in the MRES 
selector setting, as this will reproduce the default settings instead of performing the 
desired memory reset. 

7.18.3 Deleting user data from CF card 

Overview 
If you want to save a different (new) project to the CF card, it may be necessary to delete 
user data from an "old project" (e.g. unit data sets) which might be stored on the CF card 

You can delete the user data with SIMOTION SCOUT. This requires you to go online on the 
SIMOTION D4x5. The following data is deleted during this operation: 

● User data from the "volatile data" area 

● Non-volatile data, with the exception of IP and DP parameters 

● User data on the CF card (user directories), including the SINAMICS configuration 

You can thus continue to go online to the SIMOTION D4x5 with your PG/PC. The licenses 
on the CF card are retained.  

Deleting user data 
1. In SIMOTION SCOUT, open the project you want to modify. 

2. Go online with the SIMOTION D4x5. 

3. Select the SIMOTION D4x5 in the project navigator and select the "Delete user data on 
card" option in the "Target system" menu. 

4. Confirm the "Delete user data from card" prompt with "OK". 

The user data is deleted and the SINAMICS Integrated goes offline. 
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See also 
Upgrading technology packages (Page 279) 

7.18.4 Restoring the default settings of SINAMICS Integrated 

Prerequisite 
You must be online to SINAMICS Integrated in order to restore its default settings.    

Restoring the default settings 
1. Right-click "SINAMICS_Integrated" in the Project Navigator. 

2. Select the "Target device > Restore default settings" command from the shortcut menu. 

This restores the delivery state of SINAMICS Integrated. 

7.18.5 Setting SIMOTION D4x5 to the default settings 

Overview 
SIMOTION D4x5 is supplied with preset parameters, such as the transmission rate or 
PROFIBUS addresses. You can restore the default settings with the mode selector. The 
following data are deleted during this operation: 

● Non-volatile data in the SIMOTION device 

● The backup copy of the non-volatile data on the CF card 
(PMEMORY.XML/PMEMORY.BAK) 

● User data from the "volatile data" area and on the CF card 

● The communication configuration (IP and DP parameters) on the CompactFlash Card is 
set to the factory settings. 

The licenses on the CompactFlash Card are retained.   

Restoring default settings with the mode selector 
1. The power supply is switched off. 

2. Set the mode selector on the SIMOTION D4x5 to MRES (selector setting 3). 
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3. Switch on the power supply. 

The backed-up SRAM and the user data are deleted. The default settings are loaded. 
SIMOTION D4x5 is in STOP mode. 

4. Now use the mode selector to change to the desired operating mode. 

  Note 

The communication parameters are now reset to the default settings (PROFIBUS 
address 2, baud rate of 1.5 Mbit/s). The communication configuration for SIMOTION 
D4x5 must be repeated. 

7.19 Powering down the system 
If you wish to shut the system down, you must ensure that all axes and system parts are set 
to a safe state. You can set this up by providing a separate motion task, for example.   

Once the system is at a standstill, you can switch off the power supply. 
 

 Note 

You must observe the safety notes for SINAMICS components, which you will find in the 
corresponding SINAMICS manuals. 

 

7.20 Configuring Safety Integrated functions 

Integrated safety functions 
When used in conjunction with SIMOTION D, the integrated safety functions of 
SINAMICS S120 provide highly effective practical protection for personnel and machinery. 

The following Safety Integrated functions on the basis of the SINAMICS FW V2.6.2 are 
currently available: 

(Terms in accordance with IEC 61800-5-2) 

● Safe Torque Off (STO) 

● Safe Brake Control (SBC) 

● Safe Stop1 (SS1) 

● Safe Stop2 (SS2) 

● Safe Operating Stop (SOS) 

● Safely-Limited Speed (SLS) 

● Safe Speed Monitor (SSM) 
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Control circuit 
The Safety Integrated functions are completely integrated into the drive system. They can be 
activated as follows: 

● Via terminals on the control unit and on the power unit (STO, SBC, SS1 only) 

● Via terminals on the TM54F terminal module (as of SIMOTION V4.1 SP1) 

● Via PROFIBUS with PROFIsafe (as of SIMOTION V4.1 SP1 HF6) 

● Via PROFINET with PROFIsafe (as of SIMOTION V4.2) 

The Safety Integrated functions are implemented electronically and therefore offer short 
response times in comparison to solutions with externally implemented monitoring functions.  

 

 Note 

Although SIMOTION does not contain any safety-related functionality, it provides support for 
SINAMICS drives that can perform safety-related functions. 

The purpose of this support that SIMOTION offers for the safety-related monitoring functions 
is to prevent fault reactions at the drive end by ensuring that the drive does not exit the 
monitored operating state. 

 

Hardware required 
Where safety functions are controlled via the TM54F or via PROFIBUS/PROFINET with 
PROFIsafe, at the very least the following hardware versions must be used: 

● SIMOTION D425: 6AU1425-0AA00-0AA0, product version D 

● SIMOTION D435: 6AU1435-0AA00-0AA1, product version D 

● SIMOTION D445: 6AU1445-0AA00-0AA0, product version B 

● SIMOTION D445-1: 6AU1445-0AA00-0AA1, product version A 

● SIMOTION CX32: 6SL3040-0NA00-0AA0, product version A 

The hardware requirements of the drive components can be found in the SINAMICS S120 
Safety Integrated Function Manual. 
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Quantity structures 
The maximum number of servo drives with Safety Integrated functions for each control unit 
is: 

Table 7- 12 SIMOTION D4x5 quantity structures 

Control unit Maximum number of servo drives when safety function is activated  
 Via CU/EP terminals 

(STO, SBC, SS1 only) 
Via TM54F terminals Via PROFIBUS with 

PROFIsafe 1) 
Via PROFINET with 
PROFIsafe (as V4.2) 2) 

SIMOTION D4x5 6 5 5 5 
SIMOTION D4x5  
(with CX32) 

5 4 4 4 

CX32 6 5 4 (V4.1 SP1 HF6) 
5 (as of V4.1 SP2) 

5 

CU320 6 5 5 (as of V4.1 SP2) 4 
CU320-2 6 (as of V4.1 SP5) 6 (as of V4.1 SP5) 6 (as of V4.1 SP5) 6 (as of V4.2) 

1)  If SIMOTION D is operated as an intelligent DP slave on an F-CPU, a maximum of 32 safety slots can be configured for 
each intelligent DP slave in HW Config. If the Safety Integrated functions are controlled via PROFIBUS with PROFIsafe, 
one slot in the input area and one slot in the output area are used for each safety axis. This results in a maximum of 16 
drives with the Safety Integrated function for each PROFIBUS interface (intelligent DP slave) of the D4x5.  
If with SIMOTION D both PROFIBUS interfaces are operated as intelligent DP slave on a F-CPU, the quantity structure 
increases to 2 x 16 drives (sum of the drives on the SINAMICS Integrated, CX32 and SINAMICS control units). In this 
case however, no PROFIBUS master interface is available for the connection of I/Os, for example.  

2)  The maximum permissible quantity structure for the D4x5 is 64 drives with Safety Integrated function (sum of the drives 
on the SINAMICS Integrated, CX32 and SINAMICS control units). 

Safety Integrated functions with TM54F 
Safety Integrated functions are activated via fail-safe digital inputs on the TM54F. This 
means that every drive control (SINAMICS Integrated of SIMOTION D4x5, CX32, CU320, 
CU320-2, etc.) requires its own TM54F (assuming relevant safety functions are to be used 
on the control unit concerned). Only one TM54F can be connected for each 
SIMOTION D4x5, CX32 or SINAMICS S120 control unit. 
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Safety Integrated functions with PROFIsafe (PROFIBUS example) 
Safety Integrated functions are activated via "PROFIsafe on PROFIBUS" safe 
communication. Control (F logic) is based on a SIMATIC F-CPU connected via PROFIBUS 
with PROFIsafe, e.g. a SIMATIC S7-300 F-CPU (see figure) or an ET 200S IM151-7 F-CPU 
with PROFIBUS DP master interface module (not shown in the figure).  

 
Figure 7-62 SIMOTION D, control of F functions via PROFIBUS with PROFIsafe  

A function example can be found at 
(http://support.automation.siemens.com/WW/view/en/36489289) 

http://support.automation.siemens.com/WW/view/en/36489289�


Commissioning (software)  
7.20 Configuring Safety Integrated functions 

 SIMOTION D4x5 
258 Commissioning and Hardware Installation Manual, 11/2010 

Topologies 
The topologies that may be used with the SIMOTION D4x5 and CX32 are listed below. In 
each case, the description specifies whether the control of Safety Integrated functions is 
routed through the drives. 

● SIMATIC F-CPU (master), connected via PROFIBUS with PROFIsafe to SIMOTION 
D4x5 (intelligent DP slave) 

– Routing to SINAMICS Integrated drives for the D4x5 and CX32, as of V4.1 SP1 HF6 

– Routing to the drives of a SINAMICS S120 CU as of V4.1 SP2 connected to the D4x5  
- CU is connected as slave via PROFIBUS to the DP master interface of the D4x5 
- Routing to a CU connected via PROFINET is not possible. 

● SIMATIC F-CPU (controller), connected via PROFINET with PROFIsafe to 
SIMOTION D4x5 (intelligent device) 

– Routing to SINAMICS Integrated drives for the D4x5 and CX32, as of V4.2 

– Routing to the drives of a SINAMICS S120 CU as of V4.2 connected to the D4x5 
- CU is connected as intelligent device via PROFINET to the PROFINET interface of 
the  
 D4x5 (=controller)  
- CU is connected as slave via PROFIBUS to the DP master interface of the D4x5. 

● The SIMOTION D4x5 is the PROFIBUS master for a fail-safe data exchange broadcast, 
e.g. between a SIMATIC F-CPU (e.g. ET 200S F-CPU) and a SINAMICS S120 CU as of 
V4.1 SP1 

  Note 

Control for the Safety Integrated functions cannot be routed to the SINAMICS Integrated 
of the D4x5 or a CX32 in this constellation. 

Additional references 

Additional information on configuring Safety Integrated functions can be found in the  

● SINAMICS S120 Safety Integrated Function Manual 

● TO Axis Electrical/Hydraulic, External Encoder Function Manual 

● Available on the Internet at 
(http://support.automation.siemens.com/WW/view/en/27585482). 

http://support.automation.siemens.com/WW/view/en/27585482�
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7.21 Migration D445 to D445-1 

7.21.1 Overview 

Characteristics 
Due to the following functional improvements, we recommend using SIMOTION D445-1 in 
place of SIMOTION D445 for new applications: 

● An increase of 30% in PLC and motion control performance, dependent upon the 
application 

● Less mounting depth (mounting is possible even without spacers) 

● New fan/battery module with increased availability thanks to double fan 

 
Figure 7-63 SIMOTION D445-1 control unit 

Requirements 
 
Components 
Designation Version 

Comment 

SIMOTION SCOUT as of V4.1 SP2 Full support for SIMOTION D445-1 configuration 
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V4.1 SP1 Support of SIMOTION D445-1 configuration, with the constraint that the 
D445-1 control unit must be configured as "D445". 

SIMOTION D 
firmware (kernel) 

as of V4.1 SP2 HF3 For information on firmware updates, see Section Performing a firmware 
and project update (Page 284). 

SIMOTION D445-1 
hardware 

as of HW version A Order number 6AU1 445-0AA00-0AA1 

CompactFlash cards 
(CF cards) supported 
by SIMOTION D445-
1 

- - -  1 GB CF card (6AU1 400-2PA01-0AA0) 
1 GB CF card (6AU1 400-2PA00-0AA0)  
512 MB CF card (6AU1 400-2NA00-0AA0) 
The 32 MB and 64 MB CF cards used previously are no longer supported. 
We recommend using 1 GB CF cards. 

SIMOTION project 
version 

≥ V4.1 SP1 Projects from any V4.1 SPx version can run on SIMOTION D445-1 provided 
that the CF card has firmware ≥ V4.1 SP2 HF3. 

7.21.2 Configuration 

SCOUT as of V4.1 SP2 
SIMOTION D445-1 can be configured with SIMOTION SCOUT as of V4.1 SP2. The D445-1 
features "D445" in the "Create new device" dialog as a variant of the CPU type. In the HW 
Config module catalog, the D445-1 can be found in the SIMOTION D445 folder under order 
number 6AU1 445-0AA00-0AA1.  

SCOUT V4.1 SP1 
SIMOTION D445-1 can also be configured with SIMOTION SCOUT V4.1 SP1. To do this, 
configure a SIMOTION D445- in place of the SIMOTION D445-1 Control Unit.  

With SIMOTION SCOUT V4.1 SP1 you can: 

● Go online with a SIMOTION D445-1 

● Download the configuration to the SIMOTION D445-1 

A D445-1 Control Unit which has been defined with SCOUT V4.1 SP2 as a D445-1 cannot 
be configured with SCOUT V4.1 SP1. 

7.21.3 Compatibility 
As of V4.1 SP2, SIMOTION D445-1 (6AU1 445-0AA00-0AA1) is upwardly compatible for use 
with SIMOTION D445 (6AU1 445-0AA00-0AA0).  
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Project ← → Firmware ← → Module 
The following compatibility factors must be taken into account for V4.1 SPx: 

● Device replacement in HW Config 
A D445 (6AU1 445-0AA00-0AA0) can be replaced by a D445-1 (6AU1 445-0AA00-0AA1) 
of the same version (and vice versa) in HW Config. Configurations are retained in the 
case of replacements, as is a CBE30, including configuration. 

● Common firmware 
As of V4.1 SP2 HF3, D4xx firmware can run on all SIMOTION D platforms (D410, D425, 
D435, D445, and D445-1). 

● D445 and D445-1 are project-compatible with firmware as of V4.1 SP2 HF3. This allows a 
V4.1 SPx CF card from a D445 to be used in a D445-1 without SCOUT. 
Using windows tools and a card reader, copy the "/USER" directory from any V4.1 SPx 
version to a CF card with a firmware version ≥ V4.1 SP2 HF3; this will enable the project 
to run on both a D445 and a D445-1. 

● A D445-1 project can run on a D445 (and vice versa). 

● It is possible to go online on a D445-1 using a SCOUT project for D445 (and vice versa). 
In this case, it is possible to download from SCOUT and HW Config. 

● D445 and D445-1 projects on a CF card with a firmware version as of V4.1 SP2 HF3 can 
be used in both D445 and D445-1 control units. 

  Note 

A CF card can likewise run on D445 and D445-1 subject the following conditions: 
 When changing from D445-1 to D445, the lower PLC and motion control performance 

is sufficient for the application. If this is not the case, adjustments (e.g. cycle clock 
settings) need to be made. 

 When changing from D445 to D445-1, the application is able to cope with the 
increased PLC and motion control performance; i.e. the application is designed in 
such a way that shorter running times do not alter the program sequence. 

Spacers 

SIMOTION D445-1 comes with pre-assembled spacers. In contrast to the D445, these 
spacers can be removed from the D445-1 in the same way as from the SIMOTION D425 and 
D435. (In the case of the D445, spacers are always required due to the cooling fins on the 
module backplane.)  

Mounting on the side of the line module 

Mounting on the SINAMICS S120 line module using five lateral fixing elements is not 
possible with SIMOTION D445-1. SIMOTION D445-1 must always be screwed to the control 
cabinet wall. 

Interfaces 

The interfaces (connectors) of a D445-1 are compatible with a D445. 

Fan/battery module 
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The standard scope of delivery of SIMOTION D445-1 includes a double fan/battery module 
(SIMOTION D445: fan/battery module with single fan). 
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Service and maintenance 8
8.1 Overview 

Introduction  
It is possible to distinguish between the following scenarios when replacing and updating 
components:  

● Replacing modules (spare part scenario) 

– General information about the spare parts procedure for SIMOTION D4x5 (Page 267) 

– Removal and replacement of the SIMOTION D4x5 (Page 268) 

– Replacing DRIVE-CLiQ components (Page 269) 

– For information on replacing SIMOTION D4x5 fans, see Section "Replacing the 
battery in the fan/battery module" in the SIMOTION D4x5 Manual 

– Replacing the CompactFlash card (Page 272) 

● Adapting a project (new device type / device version)  
The project needs to be adapted if you want to change the type (e.g. D425 ⇒ D435) or 
version of the SIMOTION device in your existing project. 

– Creating backup copies (Page 273) 

– Backing up user data (backup variables) (Page 273) 

– Upgrading a user project to the new SCOUT version (Page 275) 

– Platform replacement via XML export/import (Page 276) 

– Preparing the device replacement (Page 277) 

– Device replacement in HW Config (Page 279) 

– Upgrading technology packages (Page 279) 

– Upgrading the device version of SINAMICS S120 control units (Page 282) 

– Upgrading a library (Page 283) 

– Save project, compile and check consistency (Page 284) 

● Performing a firmware and project update 

– Upgrading the CF card's boot loader (Page 284) 

– Update - preparatory measures (Page 285) 

– Update via IT DIAG (Page 286) 

– Upgrade via device update tool (upgrading SIMOTION devices) (Page 286) 
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– Upgrade via CF card (Page 291) with the steps: 
 • Backing up the CF card data (Page 291) 
 • Firmware update via CF card (Page 292) 
 • Upgrading the SINAMICS (Page 293) 
 • Downloading the project to the target system (Page 294) 
The upgrade data is generated with the SCOUT function "Start device update tool" 
and then transferred to the SIMOTION D4x5 via CF card or IT DIAG file. Upgrading 
modules using upgrade data offers the option of downgrading if the upgrade does not 
produce the desired result. 

  Note 

Upgrading using the device update tool offers a number of advantages (keeping retain 
data, option of downgrading, no license key handling, etc.). We would, therefore, 
recommend using this method for firmware and project upgrades. 

Please also observe the information on handling the CompactFlash card.  

● Changing the CompactFlash card (Page 295) 

● Writing to a CompactFlash card (Page 296) 

● Formatting the CompactFlash card (Page 297) 

● Boot loader on the CompactFlash card (Page 297) 

● Recommended method of handling CF cards (Page 298) 

● Card reader for CF cards  (Page 298) 

  Note 

This document uses the following terms: 
 Upgrade: Denotes upgrading to a higher version of a component/software 
 Downgrade: Denotes reverting to a previous version of a component/software 
 Update: In general terms, denotes the act of bringing a component/software up to date 

(or, more specifically, an upgrade or downgrade) 

Overview 
The exact procedure when replacing or upgrading components depends on various factors. 

If a project is upgraded, the procedure depends on the scope of change of the versions.  

● Change of the SIMOTION main version 

● Change of the SIMOTION service pack or hotfix version 

● Change of the PROFINET version 

● Change of the SINAMICS version  
(There are SIMOTION versions that contains several SINAMICS versions for a device) 

If another SIMOTION controller is to be used, then the procedure depends on whether a 
device or a platform replacement is required.  
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Examples of upgrade scenarios are listed in the following overview table.  
They are shown in the columns. The lines list the principle measures that have to be 
performed. Whether the measure has to be performed in a specific case, must be decided 
project-specifically.  
Grayed-out cells mean that a measure is not required. 

 

 Note 

If the version is changed and the SIMOTION controller replaced at the same time, then all 
measures apply; the measures must be performed in the TOP-DOWN sequence according 
to the table. 
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1)Downloading the project 
to the target system  

Upgrading SINAMICS 

Firmware update using a 
CompactFlash Card

Backup of the CompactFlash 
Card data 

Selection of the 3 update methods

Upgrade via CompactFlash Card 

only possible if the 
CompactFlash Card features 
a valid firmware version

Update via 
device update tool  

Update via IT DIAG 

Update - preparatory measures  

2)Check if the new device 
requires a new bootloader 

2)Check if the new version 
requires a new bootloader  

Upgrading the boot loader on the 
CompactFlash Card 

Updating firmware and/or project

Save/compile project; check 
consistency  

Libraries may be 
device-dependent 

Libraries are 
version-
dependent

Upgrading a library  

for external 
CUs if required 

3)Upgrading device version of 
SINAMICS S120 CUs  

Upgrading 
technology packages (TP)  

Device replacement in HW Config  
Preparing the device replacement 

When replacing the platform, the target version is also 
determined (= version of the device into which it is imported)

Platform replacement via 
XML export/import  

Upgrading a user project to the new 
SCOUT version 

only if required only if 
required

Backing up user data
(backup variables) 

Creating backup copies
(project/CF) 

D445
(SM150) 

D445
(S120)

D445-2D410
D445-2C240

D410 PN D410 DP
D4x5-2 D4x5
D455-2D445-2

V2.6.2 
V2.5 

PN2.2 

PN2.1 
 V4.1 SP4 

V4.1 SP2 
 V4.2 

V4.1  Examples 

Platform replacement 
via XML export/import 

Device replacement via
 HW Config  

SINAMICS 
version 

PROFINET
Version

Service pack or 
hotfix version

Main 
version 

Action/measure Upgrading a project

Overview of upgrade options

4)4) 4)

only if required 
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Replacement of the SIMOTION controller Activity
affects

Libraries may be 
device-dependent 
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1) Alternative: Loading the project to the CF card using a card reader 
2) See SW compatibility list (http://support.automation.siemens.com/WW/view/en/18857317) 
3) The version of the SINAMICS Integrated and the Controller Extensions are automatically upgraded in HW Config 

during a device replacement  
4) The technology packages are upgraded automatically. The user can directly specify a TP 
5) SINAMICS components are upgraded/downgraded to the component version of the CompactFlash Card. Ensure 

that LED codes are observed. Following an upgrade, a POWER ON/OFF is required 

Figure 8-1 Upgrade options 

http://support.automation.siemens.com/WW/view/en/18857317�
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8.2 Replacing modules (spare part scenario) 

8.2.1 Parts replacement for SIMOTION D4x5 

Replacement rules for SIMOTION D435 
In the case of replacement parts, you cannot replace the modules as you wish. You must 
comply with the following rules for a SIMOTION D435: 

● A SIMOTION D435 with the order number 6AU1 435-0AA00-0AA0 can be replaced by a 
SIMOTION D435 with the order number 6AU1 435-0AA00-0AA1. 

● A SIMOTION D435 with the order number 6AU1 435-0AA00-0AA1 cannot be replaced by 
a SIMOTION D435 with the order number 6AU1 435-0AA00-0AA0. 

SIMOTION D4x5 replacement with firmware downgrade 
When replacing a SIMOTION D4x5 V3.2.x with a SIMOTION D4x5 on which a version ≥ 
V4.0 has previously been run, the following behavior may be observed: 

● The module signals "Reset requested" (after power-up, the STOP LED flashes yellow at 
0.5 Hz) and 

● It is not possible to go online. 

This scenario occurs if the module still contains retain data from a project ≥ V4.0 that is not 
compatible with a V3.2.x project (buffering of retain data by SuperCap or the battery used).  

The following is a description of how you can delete the retain data. 

Use of used modules 
If a used D4x5 is used for the module replacement, we recommend that the retain data be 
deleted on the used D4x5. 

Two options are available for this.  

Table 8- 1 Options for deleting the retain data 

Option Reference to description Notes 
Module memory reset See Section SIMOTION D4x5 

memory reset (Page 249) 
Controller via mode selector 
(position "3" MRES). 
Is available on all SIMOTION 
platforms. 

Deleting/restoring non-
volatile data 

See Section Deleting/restoring non-
volatile data (Page 317) 

Controller via Service switch 
(position "1"). Is only available 
on SIMOTION D. 
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NOTICE  
With a Power OFF/ON, "Restore factory settings" is performed instead of "Memory reset" in 
switch position "3" (MRES) of the mode selector.  

Restore factory settings deletes all the project data on the CF card.  

To avoid and unintentional/accidental deletion of the project data on the CF card, we 
recommend that the retain data be deleted via the Service selector switch. 

 

See also 
Setting SIMOTION D4x5 to the default settings (Page 253) 

8.2.2 Removal and replacement of the SIMOTION D4x5 

Removing the control unit 
 

WARNING  
The control unit can be replaced only when the load power supply has been switched off. 
Therefore, switch off the power supply now. 

 

How to remove the SIMOTION D4x5:  

1. Switch off the power supply. 

2. Remove the front cover and remove the CompactFlash card from the plug-in slot. 

3. Disconnect the terminal block for the power supply. 

4. Disconnect the DRIVE-CLiQ connectors to the SINAMICS S120 modules, the connectors 
for the PROFIBUS DP interfaces (X126 and X136), and, if necessary, the Ethernet 
connectors to the X120 and X130 interfaces. 

5. Disconnect the connectors to the digital inputs and outputs at interfaces X122 and X132. 

6. Disconnect any option module which may be inserted (CBE30, TB30). 

7. Depending on the mounting method, lift the control unit from the connection to the 
SINAMICS S120 drive assembly or remove the mounting screws of the control unit. 

Installing a new module 
Proceed as follows to install a new SIMOTION D4x5: 

1. Remove the front cover from the new control unit. 

2. Mount the new control unit. 

3. Reconnect all connectors that were removed previously. 
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4. Connect the terminal block for the power supply. 

5. Reattach the designated shielding for all cables. 

6. Reinsert the original CompactFlash card into the plug-in slot. 

7. Reattach the front cover and close it. 

8. Switch on the power supply. The control unit is immediately ready to operate. 

Replacing SIMOTION D4x5 modules without PC/PG 
To enable a module replacement without a PG/PC, you must back up the current non-
volatile data to the CF card during operation.  

The "_savePersistentMemoryData" system function allows the user program to save the 
content of the non-volatile data to the CF card. This ensures that the retain variables and the 
absolute encoder position are backed up to the CF card in the event that a spare part is 
fitted. 

As an additional option, you can back up the non-volatile data by setting the service selector 
switch or using IT DIAG; for details, see the section titled Backing up diagnostic data and 
non-volatile data (Page 310).  

 

 Note 

Non-volatile data that is not backed up to the CF card will be lost if a spare part is installed 
(in the event of a module defect). (For example, failing to back up the current values of the 
retain variables will result in them being lost and reset to their initial values.) 

If an absolute encoder overflow occurs after "_savePersistentMemoryData", the actual 
position value will no longer be correct once the non-volatile data has been restored. In this 
case, homing (absolute encoder adjustment) must be repeated. 

 

See also 
Parts replacement for SIMOTION D4x5 (Page 267) 

8.2.3 Replacing DRIVE-CLiQ components 

Module replacement 
DRIVE-CLiQ components can be replaced or reinserted during operation (without POWER 
OFF) or when the system is switched off.  

Requirement 
● The affected components are located at the end of the line. 

● If an infeed is affected, the power units supplied by it do not function. 
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Procedure for "Removing a component" 
1. Deactivate the affected component or the drive object. 

2. Remove the DRIVE-CLiQ connector. 

3. Remove the supply voltage of the component and uninstall the component. 

Procedure for "Installing a component" 
1. Install the component and reconnect the supply voltage. 

2. Reconnect the DRIVE-CLiQ cable at the same location (port). The cable must have the 
same length as the old one. 

3. Activate the affected component or drive object. 

WARNING  
 

In order to replace this component, the power in the module must be switched off. 

Parameters for topology comparator and component replacement 
In the expert list, you can use CU parameter p9906 to specify how the electronic rating 
plates are compared for all the components of a control unit. The type of comparison can be 
changed subsequently for each individual component by using p9907/p9908 or right-clicking 
in the topology. All data on the electronic type plate is compared by default. 

● If p9909 = 1, the serial number and the hardware version of the new replaced component 
will be transferred automatically from the actual topology to the target topology and then 
saved to non-volatile memory. 

● For p9909 = 0, serial numbers and hardware versions are not automatically transferred. 

Setting p9901 = 1 facilitates spare parts / component replacement without tool support (as of 
SINAMICS V2.2). The new serial number of the spare part is automatically transferred from 
the actual topology to the setpoint topology and saved in non-volatile memory. Prerequisite 
is that the replaced components are of the same type and have the same order number, e.g. 
"6SL3055-0AA00-5BA2". The last or last two digits of the order number (depending on the 
component type) are not checked, as the HW version, for example, is encoded in these 
positions. This mechanism is also applied when several components are replaced. 

Modified wiring following module replacement 
In the default setting for the topology comparator, modified wiring configurations of 
DRIVE-CLiQ components (e.g. cross-exchange) cannot be accepted for safety reasons and 
a fault is generated.  
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If a cross-exchange of components is required (i.e. existing components are replaced with 
other existing components, and no spare parts are used), e.g. for troubleshooting purposes, 
the topology comparator must be reduced via parameter p9906, or preferably via 
p9907/p9908; alternatively, by right-clicking in the topology. 

 

NOTICE  
In this case, incorrect insertion of components is no longer monitored. 

 

Automatic upgrading/downgrading (FW upgrade) 
As of SINAMICS firmware version 2.5, the DRIVE-CLiQ components are automatically 
upgraded or downgraded to the version of the component firmware on the CF card. 
Components that cannot be downgraded to the component firmware version on the CF card 
(for example, old firmware on the CF card and new components on which the old firmware 
cannot be loaded) retain their firmware version. The resulting firmware version combinations 
are always functional.  

 
 

 Note 

During an automatic FW upgrade, please read the messages and alarms in the 
SIMOTION SCOUT detail window. 

 

The component version can be obtained from the CONTENT.TXT file in the main directory of 
the CF card. 

 

 Note 

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT. 

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red 
and green: 
 FW update running: RDY LED flashes slowly (0.5 Hz) 
 FW update complete: RDY LED flashes quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW update. 

Go offline once all the FW updates have been completed. POWER ON the 
upgraded/downgraded components.  

The upgrade/downgrade function can be deactivated using the p7826 CU parameter in the 
expert list.  
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Additional references 
You can find further information on this topic:  

● In the SINAMICS S120 Commissioning Manual 

● SINAMICS S120 Function Manual 

8.2.4 Replacing the CompactFlash Card 
If spare parts are being used, you must contact the Technical Support Center to convert the 
license key of the defective CF card to the new CF card. Proceed as described below to 
write your project to the new CF card: 

● Changing the CompactFlash card (Page 295) 

● Writing to a CompactFlash card (Page 296) 

Detailed information about licensing can be found:  

● In the SIMOTION SCOUT Configuration Manual 

● As well as in the FAQ (http://support.automation.siemens.com/WW/view/en/36947932). 

8.3 Adapting a project (Updating the project / Replacing the SIMOTION 
controller) 

8.3.1 Overview 

Overview 
You will need to adapt the project if you want to replace the type (e.g. D425 -> D435) or 
version of the SIMOTION device in your existing project. 

Procedure 
The exact procedure for project adaptations depends on the scope of the target hardware 
and version changes. 

An overview of the various applications can be found in Section Service and maintenance at 
Overview (Page 263). 

http://support.automation.siemens.com/WW/view/en/36947932�
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8.3.2 Creating backup copies (project/CF) 

Requirement 
Before adapting the project, it is essential that you create the following backup copies: 

● A backup copy of the project and 

● A backup copy of the contents of the CF card, see Backing up the CF card data 
(Page 291) 

8.3.3 Backing up user data (backup variables) 

Overview 
With the SCOUT functions "Back up variables" and "Restore variables", you have the option 
of backing up and restoring data that was changed during operation and only stored in the 
runtime system. This is necessary if a SIMOTION platform is changed or a version 
upgraded, for example.  

The "Back up variables" function creates XML files which are stored in a folder of your 
choice. 

The following types of data can be backed up: 

● Retentive global device variables and unit variables, as well as TO retain data (as of 
V4.1), located in the SRAM or NVRAM depending on the controller 

● Data saved with _saveUnitDataSet or _exportUnitDataSet and located on the CF card 

  Note 

When performing an upgrade with a firmware version ≥ V4.1, this function is only required 
for backing up and restoring unit data sets that have been created using 
_saveUnitDataSet. 

Retain and unit data (saved with _exportUnitDataSet) remains valid even after a version 
upgrade. 

Retain data can also be easily backed up to a memory card without the use of 
SIMOTION SCOUT. For this purpose, use:  
 The _savePersistentMemoryData function or 
 The service selector switch on the SIMOTION D4x5 or IT DIAG 

See also Diagnostic data and non-volatile data (Page 310).  

Procedure 
The backup of the user data must be performed before the upgrade of the SCOUT project. 
This is possible for a version upgrade with the "old" SCOUT version or the "new" SCOUT 
version. 
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The following is a description of the procedure with a "new" SCOUT. 

1. Open the project.  
When opening the project a window appears with a message that the project to be 
opened was created with another SCOUT version, as well as a prompt as to whether the 
upgrade should be performed. 

 
Figure 8-2 Prompt as to whether the project should be upgraded 

2. Confirm the prompt with "OK". The project is upgraded. 

3. After the conversion another prompt appears as to whether the project should be opened 
write-protected. Confirm this prompt with "Yes" (open write-protected). 

 
Figure 8-3 Prompt as to whether the project should be opened write-protected 

Open write-protected means: The project remains consistent. The data is the same in the 
controller and in the project. Diagnostic functions (status, trace, etc.) can be executed 
directly. The project does not have to be loaded to the controller first.  

Go online on the SIMOTION device (in STOP mode) and execute the Save variables 
SCOUT function. The retain variables (interface and implementation) and also the user files 
(saved with _saveUnitDataSet or _exportUnitDataSet) are saved to the PG/PC. 

The project must then be closed. 

If you are using a different PC or PG than that configured for the controller, an online 
connection is not possible.  

Update the PG/PC assignment for this.  

You can go directly to the PG/PC assignment via the  button. 

The SCOUT project can then be opened again write-protected --- online connection is now 
possible.  

Additional references 
For further information, see the SIMOTION SCOUT Configuration Manual.  
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8.3.4 Upgrading a user project to the new SCOUT version 

Requirement 
It is essential that a backup copy be made of the original project before the upgrade, 
because the data storage of the project is also upgraded during the upgrade. This ensures 
that you can always return to the original project if the upgrade fails (power interruptions, 
unexpected faults, maloperation, etc.).  

Procedure 
1. When opening the project a window appears with a message that the project to be 

opened was created with another SCOUT version, as well as a prompt as to whether the 
upgrade should be performed.  
Confirm the prompt with "OK". 

 
Figure 8-4 Prompt as to whether the project should be upgraded 

2. After the conversion another prompt appears as to whether the project should be opened 
write-protected. Confirm this prompt with "No" for a version upgrade (do not open write-
protected). 

 
Figure 8-5 Prompt as to whether the project should be opened write-protected  

Do not open write-protected means:  

The project can be edited. The data in the controller and in the project is not consistent after 
going online. Diagnostic functions cannot be executed directly. The project must be loaded 
to the controller first.  
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Open write-protected:  

The project remains consistent. The data is the same in the controller and in the project. 
Diagnostic functions (status, trace, etc.) can be executed directly. The project does not have 
to be loaded to the controller first. 

 

 Note 

A project that was last edited with a higher SCOUT version cannot be opened by a SCOUT 
with a lower version. However, the project with the more current SCOUT version can first be 
converted to the required software version (command: "Project" > "Save in old project 
format"). The project can then be opened with the lower SCOUT version. However, debug 
information (e.g. for program status) is no longer available.  

 

8.3.5 Platform replacement via XML export/import 

Overview 
A platform replacement is always required when an existing project is to be used for another 
SIMOTION platform. The platform replacement is always performed via an 
XML export/import.  

The following devices can be interchanged via a platform replacement: 

● Replacement between SIMOTION C, P and D (e.g. C240 ⇒ D445-2 DP/PN) 

● Replacement between D410 and D4x5/D4x5-2 (e.g. D410 ⇒ D445-2 DP/PN) 

● Replacement between SIMOTION D (SINAMICS S120 Integrated) ⇒ SIMOTION D 
(SINAMICS SM150 Integrated) 

Platform replacement during project downgrades: 

It is not possible to downgrade to a lower SINAMICS version. However, it is possible to 
transfer project data by means of an XML export/import.  

Preparations 
Before the platform replacement can be performed, preliminary work may be necessary in 
the existing project.  

If a D4x5 is to be imported into a D410, then only the permitted quantity structure of the 
D410 may be configured in the D4x5. This applies for all components, e.g. not only an 
infeed, but also the permissible power units.  

A D4x5 with CU adapter and PM340 can be imported into a D410 when the CU adapter is 
connected to port 0. Otherwise, the topology will be destroyed. 

Generally, the success of an import always also depends on the specific configurations of 
the drive units, and whether the configuration is possible for the device to which the import is 
to be performed. Also note any error messages that may occur.  
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Procedure 
Proceed as follows: 

1. In the project navigator of SIMOTION SCOUT, right-click the SIMOTION controller that is 
to be replaced.  
Select "Expert" > "Save project and export object" in the context menu.  
"Save project and export object" exports selected data of the selected object in XML 
format. This data export can then be reimported into other projects. The entire project is 
not exported, only the data of the selected object (e.g. only the D4x5 or only the 
SINAMICS Integrated) 

2. Specify the desired path and start the XML export. 

3. When the export has been performed error-free, delete the device from the project and 
confirm the prompt. 

4. Insert the desired platform as new device in the project navigator of SIMOTION SCOUT. 
With the selection of the device, you also define the SIMOTION version, and with a 
SIMOTION D, also the SINAMICS version. 

5. Import the data of the original platform into the new device. To do this, right-click the new 
device and select "Expert" > "Import object" in the context menu. 

6. Select the location where the XML export data is to be stored and start the import. 
Confirm the prompt to continue with the import. 

Confirm the message with regard to the import of a "non-compatible type" with "OK". 

8.3.6 Preparing the device replacement 

Overview 
The device replacement process differs from the platform replacement process in that it is 
really easy to accept project data during device replacement.  
The device replacement is performed via HW Config, whereas an XML export/import is 
required for a platform replacement.  

A device replacement is only possible within SIMOTION D. 

The following devices can be interchanged: 

● Replacement between different performance classes (e.g. D425 ⇔ D435) 

● Replacement between generations (D4x5 ⇒ D4x5-2) 

● Replacement between variants (D410 DP ⇔ D410 PN) 

● Replacement between SIMOTION, SINAMICS and/or PROFINET version (e.g.  
D425 V4.1 - PN V2.1 SINAMICS S120 V2.5 ⇒ D425 V4.2 - PN V2.2 SINAMICS S120 
V2.6.2). 

One SIMOTION D can only be replaced with another SIMOTION D if the SINAMICS version 
involved is the same or higher. It is not possible to downgrade to a lower SINAMICS version.  
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Preparation 
Before the device replacement can be performed, it is recommended that preliminary work 
be performed in the existing project. The existing project must be adapted so that it can be 
mapped to the new device during the device replacement.  

Examples: 

1. Number of DRIVE-CLiQ interfaces  
If the replacement is to a device with fewer DRIVE-CLiQ interfaces, then the ports that 
are no longer available must be rewired before the device replacement (double-click 
"Topology" in the project navigator). Components on DRIVE-CLiQ ports that are no 
longer available are moved to the component archive during the device replacement.  
Example:  
Replacement of D445-1 (six DRIVE-CLiQ ports) with D435 (four DRIVE-CLiQ ports)  
→ ports X104 and X105 are no longer available.  
Procedure for CX32 
If a CX32 is to be moved to another port, this is only possible via HW Config. Note the 
dependency between "DRIVE-CLiQ port" and "Address on the PROFIBUS Integrated" in 
Section Preparing for configuration (Page 176). 

2. Number of CX32s 
If the replacement is with a D4x5 that only supports a small number of CX32 modules, 
then a device replacement in HW Config is not possible.  
In this case, the CX32 must be replaced by a SINAMICS S120 CU320/CU320-2. 

3. PROFINET interface 
If a D4x5 with CBE30 is replaced by a D4x5-2 DP/PN with onboard PROFINET interface, 
then the number of PROFINET ports is reduced from four to three.  
Components on port 4 have to be rewired 

4. Retrofitting to V4.1 

If a SIMOTION D4x5 is downgraded by replacing a device in HW Config, you must take 
into account the fact that symbolic assignments are only available as of version V4.2. If 
symbolic assignments are used and, for example, a D4x5 V4.2/SINAMICS V2.6.2 is 
downgraded to D4x5 V4.1/SINAMICS V2.6.2, "communication for symbolic assignment" 
must be set up prior to replacing the device in HW Config. This sets up the required 
addresses. 

See also Section Communication for symbolic assignment setup (Page 216). 

TIP for synchronous grouping 

If you use device-dependent ST libraries, then the upgrade can be accelerated through the 
following procedure: 

1. Upgrade the device version for all devices that participate in the synchronous grouping in 
the ST libraries (example: Change D445 V4.1 to D445-2 V4.2).  
See also Section Upgrading a library (Page 283). 

2. Save the project and close it in SIMOTION SCOUT. 

3. Perform the module replacement for all devices of the synchronous grouping in 
HW Config for this project and then save. 

4. Open the project in SIMOTION SCOUT.  
The entire synchronous grouping is now completely upgraded. 
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8.3.7 Device replacement in HW Config 

Procedure 
1. Double-click the SIMOTION device to be replaced in the project navigator in 

SIMOTION SCOUT. HW Config opens. 

2. Open the "SIMOTION Drive-based" folder in the hardware catalog. 

  Note 

SIMOTION D is modeled as a compact device in HW Config. When modules are being 
replaced, this means the new module must be moved to the header of the module rack 
shown and not to slot 2. Please make sure that you do not delete the D4x5 rack!  

When you move the new module to the rack header using drag-and-drop, the old module 
will be replaced. Alternatively, you can: 
 Select the rack header and double-click the new module in the module catalog to 

replace the previous module, or 
 Right-click the rack header and select "Replace Object" 

3. Move the new module to the top field of the module rack using drag-and-drop. 

4. Confirm the dialog that appears with "Yes" to replace the SIMOTION device. The module 
is replaced. 

5. Accept the changes made to the hardware configuration with "Station" > "Save and 
compile". 

6. Close HW Config. 

  Note 

As of SIMOTION SCOUT V4.2, the following actions are performed automatically by the 
engineering system during the module replacement (if required): 
 Upgrade of the technology packages (TPs) 
 Automatic upgrade of the SINAMICS Integrated 
 Automatic upgrade of all connected CX32 

The upgraded data is transferred to the project and the entire project saved. 

If the module hardware changes (e.g. a D425 is replaced with a D435), proceed as 
described in Section Removal and replacement of the SIMOTION D4x5 (Page 268). 

8.3.8 Upgrading technology packages 

Overview 
The SIMOTION technology packages (e.g. TP CAM, TP PATH, DCBlib) are available in 
various versions.  
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You can only use the functions of the technology objects selected if the technology objects 
are available in the target system. You can select the technology packages and their version 
for each SIMOTION device. Each version of SIMOTION SCOUT has a kernel (FW version) 
for the SIMOTION CPU and an appropriate technology package.  

TPs during upgrades 
Device replacement (in HW Config), platform replacement (XML export/import), or even 
upgrades may cause versions of SIMOTION technology packages (TPs), which are 
assigned to individual technology objects (TOs), to change. 

● The TP version may change when the main version is changed.  
The TP version depends on the relevant main version in all cases; it may, however, 
remain unchanged through a number of main versions. 

● If service packs and hotfixes are installed, there may even be a selection of TP product 
versions available for the same TP version 

The TP version is automatically upgraded during device replacement (in HW Config). If the 
TP version changes and there are several product versions available for the new TP version, 
the latest product version is set automatically. If another product version is preferred, this 
must be set manually (e.g. selection of V 4.1.5.3).  

With a platform replacement (XML export/import), the required technology package along 
with the TP version and, if necessary, the product version have to be selected manually after 
the import.  

When a SIMOTION CPU is inserted, the TP CAM (latest TP version and product version) is 
preset per default.  

Special displays in the "version" field 

● "Select" means that no TP product version has been selected; this state occurs when 
older projects, in which the selection of a specific product version was not supported, are 
upgraded. If the project is loaded to the CPU without making a selection, the latest 
available technology package is loaded automatically. 

● "---" means that no version can be determined (e.g. for the TP DCBlib or for older CPU 
versions < V4.1). If no version can be determined, you must select "---". 
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Selecting the TP product version 
The desired technology package is selected with fine granularity in SIMOTION SCOUT at 
"Target device" > "Select technology packages ...". 

 
Figure 8-6 Select technology packages 

 

 Note 

Device diagnostics can provide information on which technology package product version 
has been loaded to a CPU.  

 

Loading technology packages to the target device 
Technology packages are only loaded to the target device if no technology package has 
been loaded so far or if "Load to file system" is executed.  

If a technology package version changes, the technology package must be explicitly 
reloaded to the target device. Proceed as follows: 

1. Select "Download project to target system" in SIMOTION SCOUT. 

2. Select the "Replace product versions of the technology packages" option and confirm 
with "OK". 

For further information, please refer to the online help for SIMOTION SCOUT.  
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See also 
Deleting user data from CF card (Page 252) 

8.3.9 Upgrading the device version of SINAMICS S120 control units 

Overview 
You can upgrade the device versions of SINAMICS S120 control units that are connected to 
the SIMOTION D via PROFIBUS or PROFINET in the SIMOTION SCOUT. The SINAMICS 
version can only ever be upgraded in a project; it cannot be downgraded.  

 

 Note 

During the device replacement in HW Config, the SINAMICS version 
 Of the SINAMICS Integrated of the SIMOTION D4x5 as well as 
 The connected CX32 controller extensions 

are also upgraded automatically.  
 

A CX32 always has the same SINAMICS version as the SINAMICS Integrated. During the 
module replacement in HW Config, the SIMOTION and the SINAMICS version is always 
defined with the selection of a D4x5 module.  

If a SINAMICS S120 control unit is connected via PROFIBUS or PROFINET, the SINAMICS 
version can be selected independently of the SINAMICS Integrated version. 
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Procedure 

To upgrade a SINAMICS drive unit: 

1. Right-click the relevant device, e.g. the SINAMICS S120 CU320-2 DP. 

2. Select "Target device" > "Upgrade device version/characteristic" in the context menu. 

The "Upgrade Device Version/Characteristic" dialog box is displayed, listing all available 
firmware versions.  

 
Figure 8-7 Upgrading the device version 

3. Select the desired device version/characteristic and click "Upgrade". 

This upgrades the SINAMICS S120 control unit.  

8.3.10 Upgrading a library 
Depending on the configured properties of the libraries used in the project (device-
dependent or device-independent), an upgrade of the libraries may be required if the 
SIMOTION device or the device version changes. 

1. Open the LIBRARY directory in the project navigator. 

2. Select a library, right-click to open the context menu, and select "Properties...." 

3. Select the "TPs/TOs" tab in the "Properties" window. 

4. Select the SIMOTION device and the technology packages for which the library is to be 
valid. 

5. Close the dialog with "OK". 

  Note 

Please also observe the information on device-dependencies in the SIMOTION SCOUT 
online help. 
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8.3.11 Save project, compile and check consistency 

Procedure 
1. Execute "Save and recompile all" ("Project" > "Save and recompile all" menu). 

2. Then perform a consistency check ("Project" > "Check consistency" menu). 

3. If error messages occur, correct these and repeat the operation. 

  Note 

Note the difference between  
 "Save and recompile all" and 
 "Save and compile changes" 

 

Save and recompile all 
All sources of the entire project are recompiled with this command. 

The command is suitable if you are quite sure that all the old data from older SCOUT 
versions should be removed and replaced with new compilation results.  

Use this command if you specifically want to convert a project from an earlier SCOUT 
version to a newer version. In this way, you take over all error corrections and optimizations.  

Save and compile changes 
On this command, the whole project is searched for changes. Therefore only the changes 
are compiled. Use this command for day-to-day operations within a SCOUT version. 

 

8.4 Performing a firmware and project update 

8.4.1 Upgrading the CompactFlash Card's boot loader 
Upgrading the SIMOTION D may also render it necessary to upgrade the boot loader of the 
CompactFlash card. 

Detailed information on the compatibility relationships for the CF card, boot loader version, 
SIMOTION D hardware and SIMOTION firmware version can be found in the software 
compatibility list. This list is available both in the documentation supplied on the SIMOTION 
SCOUT DVD (\1_Important\English\Compatibility\...) and on the Internet at 
(http://support.automation.siemens.com/WW/view/en/18857317).  

http://support.automation.siemens.com/WW/view/en/18857317�
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8.4.2 Update - preparatory measures 

Upgrading the SIMOTION D 
The actions described in this section also apply to downgrading to an older version.  

Various options are available for performing a firmware and/or project upgrade on the 
SIMOTION D. 

● Update via IT DIAG (Page 286) 

● Upgrade via device update tool (upgrading SIMOTION devices) (Page 286) 

● Upgrade via CF card (Page 291) 

  Note 

Upgrading using the device update tool offers a number of advantages (keeping retain 
data, option of downgrading, no license key handling, etc.). 

We therefore recommend using this method for firmware and/or project upgrades. 

Requirement (firmware upgrade) 
You can find the latest firmware for SIMOTION D:  

● On the SIMOTION SCOUT DVDs (e.g. at ...\3_D4xx\Firmware\V4.2\....) 

● at Internet address (http://support.automation.siemens.com/WW/view/en/31045047) 

Upgrading the SIMOTION D automatically upgrades the firmware of all connected 
SINAMICS DRIVE-CLiQ components.  

 

 Note 

Observe the information in the the Read Me files and the upgrade instructions included in the 
scope of delivery of new SIMOTION versions. 

Use only CF cards that have been released for SIMOTION D and have an appropriate and 
correct boot loader version. 

 

You can find the compatibility relationships in the SIMOTION SCOUT Add-Ons "software 
products" compatibility list, as well as at Internet address 
(http://support.automation.siemens.com/WW/view/en/18857317). 

 

NOTICE  
The upgrade operation deletes all project data and parameters from the CF card! 

 

http://support.automation.siemens.com/WW/view/en/31045047�
http://support.automation.siemens.com/WW/view/en/18857317�
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Requirement (project upgrade) 
You have upgraded your project and, if necessary, adapted the device type and device 
version, see Section Adapting a project (Updating the project / Replacing the SIMOTION 
controller) (Page 272). 

8.4.3 Update via IT DIAG 
The SIMOTION D features an integrated Web server.  

In addition to customized Web sites and comprehensive device/diagnostic information, one 
of the options that IT DIAG offers is performing firmware and project upgrades using a 
standard PC with Internet Explorer.  

As of firmware version V4.2, it is no longer necessary to purchase licenses for SIMOTION IT 
DIAG and SIMOTION OPC-XML. 

 

 Note 

D410, D4x5, and D4xx firmware ZIP archives are available for SIMOTION D. The firmware in 
D4xx archives will run on SIMOTION D410 and SIMOTION D4x5. However, it cannot be 
loaded with IT DIAG if the CF card contains a firmware version < V4.1 SP2. In this case you 
should use the D410 or D4x5 firmware archive. 

 

Detailed information can be found in the  
SIMOTION IT Ethernet-Based HMI and Diagnostic Functions Diagnostics Manual. 

 

See also 
Adapting a project (Updating the project / Replacing the SIMOTION controller) (Page 272) 

8.4.4 Upgrade via device update tool (upgrading SIMOTION devices) 

Overview 
As of SIMOTION V4.1 SP2, SIMOTION D control units and projects can be upgraded using 
previously created upgrade data. 

Performing an upgrade using upgrade data has the following advantages: 

● User-friendly creation of upgrade data via SIMOTION SCOUT with the aid of a wizard (at 
the machine manufacturer's site) 

● SIMOTION devices can be upgraded by the machine operator without the SIMOTION 
SCOUT Engineering System. 

● The machine manufacturer can conveniently send upgrade data via e-mail or post to the 
machine operator. 
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● There is no need to use license keys, as licenses are retained. 

● Retain data and unit data is retained when upgrades are performed, even across 
versions. 

● An upgrade which has been imported can be discarded again, and the previous 
configuration restored. 

● You can update either a single SIMOTION device or multiple devices from one or more 
SIMOTION projects. 

● It is possible to upgrade parts of a configuration only (e.g. Technology Packages only, 
firmware only, project only, etc.). 

Upgrade data is created by the application engineer at the machine manufacturer's premises 
using SIMOTION SCOUT. The upgrade data can then be handled flexibly depending on both 
the SIMOTION device in question (SIMOTION C, D, or P) and the customer requirements: 

● Creating upgrade data and then copying it to a storage or upgrade medium: 

– CF card 

– USB stick or 

– IT DIAG file 

● Alternatively, the upgrade data can be created and stored in an archive on the PC, with a 
view to importing it to an upgrade medium suitable for SIMOTION devices at a later point. 

● The process of importing the data to an upgrade medium can be performed at the 
machine manufacturer's premises; alternatively, if the upgrade archive has been 
transferred to the machine operator, the service engineer can do this on-site. 

● The service engineer imports the upgrade data on an operator-guided basis (without any 
involvement by the application engineer) to the SIMOTION device(s), and upgrades the 
SIMOTION devices in the process (SIMOTION SCOUT is not required on-site). 

The following describes how to upgrade a SIMOTION D with a USB stick. This assumes you 
have a USB stick containing the appropriate upgrade data.  

Requirement 
● You have a USB stick containing the upgrade data. 

● You have a SIMOTION D module with the required HW version. 

The following hardware is required in order to upgrade a SIMOTION D4x5 using a USB stick: 

Table 8- 2 Hardware required for USB stick upgrades 

Module Order No. Minimum hardware release 
required 1) 

SIMOTION D425 6AU1 425-0AA00-0AA0F F 2) 
SIMOTION D435 6AU1 435-0AA00-0AA0 Upgrade via USB stick not 

supported 
SIMOTION D435 6AU1 435-0AA00-0AA1 F 2) 
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Module Order No. Minimum hardware release 
required 1) 

SIMOTION D445 6AU1 445-0AA00-0AA0 A 
SIMOTION D445-1 6AU1 445-0AA00-0AA1 A 

1)  The HW version is listed on the SIMOTION D type plates.  
2)  Modules with HW version C to E can be upgraded (upgrade to BIOS ≥ V00.00.04.00). 

Required BIOS version 
With SIMOTION D425/D435, a BIOS version of at least V00.00.04.00 is required for USB 
support. Modules as of hardware version "F" are supplied with a corresponding BIOS 
version. A BIOS upgrade can be conducted on SIMOTION D425/D435 modules with a BIOS 
version < V00.00.04.00. The BIOS version is shown in the device diagnostics in SIMOTION 
SCOUT. 

Proceed as follows to do this: 

1. Switch the module off and insert a CF card with SIMOTION D4x5 firmware version V4.1 
SP2 or higher. 

2. Turn the left rotary switch (SIM/NCK) to switch position C. 

3. Switch the module on and wait until the BIOS upgrade has been carried out. The BIOS 
upgrade is completed when the 7-segment- display shows "5" (RUN LED flashes green at 
2 Hz, RDY LED lights up red). 

4. Switch the module off and reset the rotary switch to "0". 

NOTICE  
 

A BIOS upgrade must not be interrupted under any circumstances. With this in mind, do 
not switch the module off until the BIOS upgrade is complete. A damaged BIOS will 
require expensive repair work to be carried out at the plant. 

5. A successful BIOS upgrade is also displayed in the diagnostic buffer at the next power-
up. 

Procedure 
When using a USB stick to perform an upgrade, proceed as follows: 

1. Check the position of the service selector switch (left rotary switch SIM/NCK). The switch 
position must be at "0". 

2. Insert the USB stick into one of the two USB interfaces on the activated D4x5 (only one 
USB stick may be inserted). 

3. Switch the device OFF/ON or reset it using the RESET button. 
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4. SIMOTION D4x5 will now begin copying the data from the USB stick to the CF card. The 
copying procedure begins with some LED status changes until finally a yellow/green 
flashing RDY LED is displayed (0.5 Hz). In the end phase of the upgrade, the RDY LED 
has longer steady green or yellow phases (< 10 s). 

Once copying is complete, the RDY LED will change to 

– "Steady green" (only when the RDY-LED is constantly green for > 10 s, has the 
copying procedure been completed successfully) 

– "Steady red" if copying was not successful 

5. Switch the D4x5 off and remove the USB stick. 

6. Switch the D4x5 back on. The D4x5 now begins with the actual upgrade. The SF LED 
flashes green (0.5 Hz) during the upgrade. The procedure can take several minutes. 

7. Observe the green flashing of the SF LED. 

– As soon as the upgrade procedure has been completed successfully, the SF LED 
goes out.  
The device then boots up automatically in the upgraded configuration (SF LED display 
then depends on the operating mode of the device). 

– If the upgrade procedure was not successful, the SF LED flickers red (10 Hz). 

If the upgrade has not been successful "from the point of view of the application" (for 
example, the machine is not behaving as desired), it can be undone as follows: 

1. Switch the D4x5 off. 

2. Turn the left rotary switch (SIM/NCK) to position "B". 

3. Switch the D4x5 back on. 

The system restores the data saved during the upgrade. The data from the upgrade 
process will be deleted. 
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4. The restoration is indicated by a green flashing SF LED (0.5 Hz) and can take several 
minutes. When the flashing code is displayed, immediately reset the Service selector 
switch to "0". 

5. Observe the flashing of the SF LED. 

– As soon as the restore procedure has been completed successfully, the SF LED goes 
out. 
The device then boots up automatically in the restored configuration. (SF LED display 
then depends on the respective mode of the device.) 

– If the restore procedure was not successful, the SF LED flickers red (10 Hz). 

  Note 

If the Service selector switch is not reset or not reset in good time to "0", this results in 
fault state "Service selector switch is still set to restore" (SF LED flickers red at 10 Hz). 
In this case, switch the D4x5 off, reset the Service selector switch and switch the D4x5 
on again. If the restoration was otherwise successful, the D4x5 boots up with the 
restored configuration. 

  Note 

In the case of a CPU upgrade via USB stick the SIMOTION D4x5 is booted from the 
USB stick. A bootable USB stick must, therefore, be used. Due to the rapid 
developments within the market for USB sticks, it is not possible to recommend any 
specific devices. SIMATIC USB sticks are an exception to this rule. For more 
information, see Available on the Internet at 
(http://support.automation.siemens.com/WW/view/en/32580863). 

  Note 

If the firmware for SIMOTION D is being upgraded or downgraded, the component 
firmware will also be upgraded or downgraded automatically depending on the 
firmware version on the CF card and the firmware version on the SINAMICS 
components (DRIVE-CLiQ components, CBE30, PM340, etc.).  

The upgrade procedure can take several minutes and is indicated by LED displays.  

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing 
red and green: 
 FW upgrade running: RDY LED flashing slowly (0.5 Hz) 
 FW upgrade complete: RDY LED flashing quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on 
components connected to the SIMOTION D/CX32 or that all components have 
completed the FW update. 

Once the FW upgrade is complete on all components, the components that have been 
upgraded/downgraded must be powered up.  

Requirement 
You have a USB stick containing the upgrade data. 

http://support.automation.siemens.com/WW/view/en/32580863�
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Additional references 
Detailed information on upgrading devices can be found in the  
Upgrading SIMOTION Devices Operating Instructions. 

8.4.5 Upgrade via CF card 

8.4.5.1 Backup of the CF card data 

Backing up licenses, retain data, and user data  
Prior to upgrading/downgrading, as a precaution we would generally recommend backing up 
the entire content of the CF card to the PC/PG using the card adapter and Windows 
Explorer. 

How you should proceed when it comes to backing up and subsequently restoring data on 
the CF card depends on whether licenses and/or other retain data and user data which will 
be required again after the upgrade/downgrade are located on the CF card.  

Scenario 1: If the CF card contains no licenses and no retain data or user data which will be required 
after the upgrade/downgrade  

You do not need to take any steps in this case. Delete the content of the CF card and 
upgrade the firmware as described. 

Scenario 2: If the CF card contains licenses (e.g. axis licenses) 
Before loading the new firmware, back up the "KEYS" directory to your PC. This can then be 
copied back to the CF card once you have installed the new firmware. 

 

 Note 

The license key is stored in the "KEYS" directory on the CF card. When the 
SIMOTION device starts up for the first time (as of firmware version V4.1), the license key is 
saved in the boot sector of the CF card.  

A license key saved in the boot sector cannot be deleted by means of a user operation; nor 
can it be deleted by formatting the CF card or rewriting the boot loader.  

If the Keys.txt file is no longer present on the CF card (because the "KEYS" directory has 
been deleted, for example), it will be written again from the boot sector to the "KEYS" 
directory while the SIMOTION device is starting up. The license key can be changed at any 
time (by relicensing, for example). When the device is next started up, the license key will be 
saved in the boot sector again. 

 

In the event of the loss of a license key, a copy can be obtained via the Web License 
Manager at the following Internet address (http://www.siemens.com/automation/license). 
You will need the HW serial number printed on the CF card. In the Web License Manager, 
you have the option of displaying the associated license key. 

http://www.siemens.com/automation/license�
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Scenario 3: If the CF card contains retain data / user data which will be required after the 
upgrade/downgrade 

If you are using your application to back up data to the CF card, you must back this up 
before upgrading the new firmware.  

Example:  

● Backing up retain data (non-volatile data saved with _savePersistentMemoryData): 

– user\simotion\pmemory.xml 

● Backing up IT DIAG user files, settings (e.g. trace.xml), task trace data, log files, and 
Java files (classes, archives, user file system, etc.), stored in the following directories: 

– user\simotion\hmicfg 

– user\simotion\hmi 

● Backing up configuration data for modular machines in conjunction with the 
_activateConfiguration system function, stored in the following directory: 

– install\simotion 

● Backing up unit data (data saved on the CF card using 
_saveUnitDataSet/_exportUnitDataSet), stored in the following directory: 

– user\simotion\user dir\<unitname> 

  Note 

When a version is changed, you must use the "Back up variables" function to back up 
data saved using _saveUnitDataSet or _exportUnitDataSet in a way that is not 
dependent on the version. You then have the option of restoring them using "Restore 
variables". 

When performing an upgrade with a firmware version ≥ V4.1, these two functions are 
only required for backing up and restoring unit data sets that have been created using 
_saveUnitDataSet. 

Retain and unit data (saved with _exportUnitDataSet) remains valid even after a 
version upgrade.  

 

8.4.5.2 Firmware upgrade via CF card 

Procedure 
Proceed as follows to perform the upgrade: 

1. Switch off the power supply to the D4x5. 

2. Remove the CF card from the SIMOTION D4x5 and insert it into the CF card adapter on 
your PC. 

3. Open Windows Explorer. The CF card must be visible as a removable data carrier in the 
Windows Explorer under an arbitrary drive letter. 
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4. If necessary, back up the licenses, retain data, and user data on the CF card to your PC 
(see Section Backup of the CF card data (Page 291)). 

5. Delete all the data from the CF card. 

6. Unzip the firmware file to the CF card using a ZIP file utility such as WinZip. Always 
maintain the file structure when setting up the decompression tool. 

7. Copy the data saved in step 4 back to the appropriate folder structure on the CF card. 

8. Remove the CF card from the CF card adapter on your PG/PC. 

9. Insert the CF card into the D4x5. 

10. Switch on the power supply for the D4x5. The new firmware is loaded from the CF card to 
the SIMOTION D4x5. 

8.4.5.3 Upgrading SINAMICS 
Depending on the settings, the SINAMICS components are also automatically upgraded to 
the component version of the CF card with a firmware upgrade of the SIMOTION D. 

The component version can be obtained from the CONTENT.TXT file in the main directory of 
the CF card. 

Upgrading the firmware of SINAMICS components automatically 
When starting up, the system automatically upgrades or downgrades all DRIVE-CLiQ 
components to the version of the component firmware on the CF card. Components that 
cannot be downgraded to the component firmware version on the CF card (e.g. old firmware 
on the CF card and new components to which the old firmware cannot be loaded) retain their 
firmware version. The resulting firmware version combinations are always functional.  

 

 Note 

The components' firmware is upgraded or downgraded automatically based on the FW 
version on the CF card and the FW version on the SINAMICS components (DRIVE-CLiQ 
components, CBE30, PM340, etc.).  

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT.  

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red 
and green: 
 FW upgrade running: RDY LED flashes slowly (0.5 Hz) 
 FW upgrade complete: RDY LED flashes quickly (2 Hz) 

These flashing patterns are also displayed on the yellow RDY LED on the 
SIMOTION D/CX32, and indicate that a FW update has been carried out on components 
connected to the SIMOTION D/CX32 or that all components have completed the FW update.

Go offline once all the FW upgrades have been completed. POWER ON the  
upgraded/downgraded components. 
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Upgrading the firmware of the SINAMICS components 
The SINAMICS components' firmware is upgraded automatically, depending on the setting of 
parameter p7826.  

● p7826 = 0: Upgrade/downgrade deactivated (factory setting) 

● p7826 = 1: Upgrade and downgrade 

● p7826 = 2: Upgrade only 

CAUTION  
 

The automatic FW upgrade via p7826 = 1 (upgrade and downgrade) must not be 
deactivated when using Safety Integrated. 

If you are upgrading the firmware manually, proceed as follows:  

1. Select the SINAMICS component in the project navigator, e.g. SINAMICS Integrated. 

2. Double-click "Overview" in the project navigator. 

The "SINAMICS_Integrated - Overview" dialog box opens with a list of available drive 
objects. 

3. Click "Version overview" to open the list of connected SINAMICS components. 

4. Go online and select the devices whose firmware you wish to upgrade. 

The list displays the current firmware version of the devices. 

5. Click "Firmware upgrade" to download the new firmware to the devices. To do so, you 
must select all components whose firmware is to be upgraded. 

6. When the firmware upgrade is complete, switch the 24 V power supply off and back on 
again. The device is now ready for operation. 

  Note 

The SINAMICS components must be configured for a firmware upgrade to take place. 
The firmware cannot be upgraded if the components have not been configured. 

You can also upgrade the firmware using the expert list. See the SINAMICS S120 
Commissioning Manual for a description of how to do this. 

 

8.4.5.4 Loading a project to the target system 
Once all the changes required for upgrading your project have been made, you must 
download the project to the SIMOTION D4x5. You have recompiled the project and checked 
it for consistency. See Section Saving the project and checking the consistency (Page 284).  

Requirement 
The firmware required is located on the CF card; for information, see Section Firmware 
upgrade using a CF card. 
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Procedure 
1. Save and compile the project. 

2. Click "Connect to selected target systems" to establish a connection to the target system. 

3. Execute "Download project to target system" and then "Copy RAM to ROM" to download 
the upgraded project to the CF card as well. 

4. Because of the automatic follow-up configuration in the SINAMICS Integrated drive, you 
must now execute "Load CPU / drive unit to PG". 

5. Save the project. 

  Note 

When upgrading SINAMICS drive units (e.g. SINAMICS Integrated) only the p 
parameters (setting parameters) are loaded into the upgraded project. The r parameters 
(monitoring parameters) are not loaded. The r parameters in the drive unit are derived or 
calculated from an automatic subsequent parameterization and must therefore be 
uploaded to the project. To do this, execute "Load CPU/drive unit to PG". If the upload is 
not performed, this can lead to inconsistencies in the drive parameterization dialog boxes. 

8.5 SIMOTION Compact Flash card 

8.5.1 Changing the CompactFlash Card 

Requirement 
 

CAUTION  
The CF card may only be unplugged and plugged in when the system is switched off (zero 
current)! The SIMOTION D4x5 is in a de-energized state when all the LEDs are OFF. 

 

Procedure 
To change the CF card, proceed as follows:   

1. Switch off the power supply. 

2. Remove the CF card from the plug-in slot of the control unit. 
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3. Gently insert the new CF card into the empty plug-in slot until it clicks into place. The 
direction of insertion of the CF card is indicated by an arrow located on both the plug-in 
slot and the CF card. 

When properly installed, the card does not extend beyond the housing of the SIMOTION 
D4x5. 

4. Switch the power supply on again. 

8.5.2 Writing to the the CompactFlash card 

Overview 
You can write to the CF card by:  

● Writing to a CF card inserted into a SIMOTION D 

This function requires the connection to be established between the PG/PC and the 
module. 

● Writing to a CF card without a SIMOTION D module 

For this function, you need a CF card adapter. 

  Note 

The CF card always comes formatted. It contains the SIMOTION Kernel (SIMOTION D 
firmware). 

To ensure that the CF card functions properly, the card must not be repartitioned. 

Writing to a CF card inserted into a SIMOTION D 
The CF card can be used to store technology packages and user data (programs, 
configuration data and parameter assignments) from the "volatile data" area on the CF card. 
Proceed as follows: 

1. Establish the connection between the SIMOTION D and the PG/PC. 

2. In SIMOTION SCOUT, the CF card is written to by means of the "Copy RAM to ROM" 
menu command. 

 Writing to a CF card without a SIMOTION D module  
With a suitable memory card adapter, you can write to the CF card directly via a PG/PC. 
Always save your project data to the CF card using the PG/PC before you upgrade the 
SIMOTION firmware, for example. 

 

 Note 

Files that have been written to the CF card with "Copy RAM to ROM" in SIMOTION SCOUT 
must not be modified or deleted with Windows. This can corrupt the project. 
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8.5.3 Formatting the CompactFlash card 
You can format the CF card, for example, if it is corrupt. Proceed as follows:   

1. Insert the CompactFlash Card into a CompactFlash Card adapter connected to your 
PG/PC. 

2. Format the CF card in Windows (FAT or FAT16 file system). 

3. If the boot sector of the CF card is also defective, you will have to rewrite the bootloader. 

NOTICE  
 

The CF card must only be formatted with FAT or FAT16, and must not be formatted with 
FAT32 or NTFS.  

See also 
Bootloader on the CompactFlash card (Page 297) 

8.5.4 Bootloader on the CompactFlash card 

Writing a boot loader 
A boot loader may need to be written in the following situations:  

● When a new boot loader is required for the SIMOTION D firmware version used 

● When a new boot loader is required for the SIMOTION D hardware version used 

● When the boot loader is defective. 

The boot loader version can be read out using the SIMOTION SCOUT device diagnostics. If 
this is not possible, the boot loader version may be incorrect. Possible description of error: 
All eight LEDs light up yellow.  

In this case, replace the boot loader version with the current version.  

Use the "Options > Write boot sector..." function to write the boot loader version in the 
SIMOTION SCOUT to the CF card. 

 

 Note 
Up to and including V4.2:  

You require PG/PC administrator rights to write to the boot sector. If you do not have 
administrator rights on your PG/PC, an administrator can enter an administrator login for you 
to use this function under "Options" > "Settings" > "Rights". 
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Detailed information on the compatibility relationships for the CF card, boot loader version, 
SIMOTION D hardware and SIMOTION firmware version can be found in the software 
compatibility list. This list is available both in the documentation supplied on the SIMOTION 
SCOUT DVD (\1_Important\English\Compatibility\...) and on the Internet at 
(http://support.automation.siemens.com/WW/view/en/18857317). 

8.5.5 Recommended method for dealing with CF cards 

Handling CF cards correctly 
Please note the following when handling the CF card: 

● The CF card may only be inserted or removed when the system is de-energized. 

● CF cards are not designed to be rewritten as many times as the user wishes. 

With this in mind, you should avoid writing user data from the application to the CF card 
cyclically. Depending on the system, a write operation from the application may trigger 
one or more write operations on the CF card. Therefore, we recommend you adopt a 
conservative approach in terms of the number of writing processes. In other words, do 
not perform more than 100,000 write access instances from the user program over the 
estimated service life of the application. 

● Switching off the SIMOTION D Control Unit during write accesses to the CF card must be 
avoided at all costs (examples of write accesses to the CF card: "Copy RAM to ROM", 
savePersistentMemoryData, _saveUnitDataSet, _exportUnitDataSet, etc.). In the worst 
case scenario, switching off the SIMOTION D Control Unit during write access can 
damage the file system on the CF card. In this case, the CF card must be reformatted 
and the firmware/user data reloaded. During this process the licenses remain on the 
CF card. 

8.5.6 Card reader for CF cards 
Because of the quickly changing market and the large differences in the quality of card 
readers, no specific recommendation can be made (except for the following card reader).  

If problems occur identifying the CF card, this may be due to an incorrect power up of the 
card reader. 

Designation and ordering data 

Card reader for CF/SD memory media, 
with USB connection 
Order number: 6FC5 335-0AA00-0AA0 

http://support.automation.siemens.com/WW/view/en/18857317�
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Diagnostics 9
9.1 Diagnostics via LED displays 

Arrangement of LED displays 
The front panel of the SIMOTION D4x5 has eight LED displays arranged in two rows of four. 
There is also a 7-segment display below the blanking cover. 

 
Figure 9-1 7-segment and LED displays on the D4x5 
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LED status key 
The LED displays indicate the different operating modes and any errors occurring on the 
SIMOTION D4x5. They do so by illuminating, flashing, or flickering in different colors.  

The following table provides an overview of all occurring LED display combinations. 

Meaning of the characters/symbols used: 

● 1 = LED on 

● 0 = LED off 

● 0.5/1 = flashing LED (0.5 Hz) 

● 2/1 = flashing LED (2 Hz) 

● Λ = flickering LED 

● x = LED can light up 

9.1.1 SIMOTION D4x5 and SINAMICS Integrated displays 
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LED displays 
Every LED can illuminate in yellow, red, or green. In the following table, the color of the LED 
is indicated along with the illumination status.  

Table 9- 1 LED displays  

Meaning LED display 
 RDY RUN STOP SU/PF SF DP1 DP2 OPT 
Power-up 1 

(yellow) 
1 
(yellow) 

1  
(yellow) 

1  
(yellow) 

1  
(yellow) 

1 
(yellow) 

1  
(yellow) 

1 
(yellow) 

Power-up of the D4x5 without CF card 
or with CF card without valid operating 
system (the boot loader may be 
defective). 

1  
(yellow) 

1 
(yellow) 

1 
(yellow) 

1 
(yellow) 

1 
(yellow) 

1 
(yellow) 

1 
(yellow) 

1 
(yellow) 

Incorrect firmware  
(e.g. D4x5-2) 

x 2/1 
(yellow) 

2/1 
(yellow) 

2/1 
(yellow) 

2/1 
(yellow) 

2/1 
(yellow) 

2/1 
(yellow) 

x 

CF card has begun to boot, however, an 
error has occurred (faulty FW). 

0.5/1 
(red) 

0 0 0 0 0 0 0 

BIOS update Λ (red) x x x x x x x 
D4x5 is ready to operate: SIMOTION 
task system is running, and SINAMICS 
Integrated is ready to operate 

1 
(green) 

x x x x x x x 

Read or write access to CF card Λ 
(yellow) 

x x x x x x x 

RUN X 1 
(green) 

0 0 x x x x 

Transition from RUN - STOPU X 1 
(green) 

0 2/1 
(yellow) 

x x x x 

Transition from STOPU - RUN x 2/1 
(green) 

0 1 
(yellow) 

x x x x 

STOPU x 0 0 1 
(yellow) 

x x x x 

Service mode (axis control panel / 
measuring function) 

x 2/1 
(green) 

0 2/1 
(yellow) 

x x x x 

Transition from STOPU - STOP x 0 2/1 
(yellow) 

1 
(yellow) 

x x x x 

STOP x 0 1 
(yellow) 

0 x x x x 

Transition from STOP - STOPU x 0 1 
(yellow) 

2/1 
(yellow) 

x x x x 

Request for memory reset by the D4x5 
itself or via the mode selector 

x 0 0.5/1 
(yellow) 

0 x x x x 

Overall reset in progress active 1) x 0 0 0 0 0 0 0 
Memory reset completed x 0 1 

(yellow) 
0 0 0 0 0 

An interrupt that can be acknowledged 
(alarm, message, note) is pending 

x x x X 1 
(red) 

x x x 



Diagnostics  
9.1 Diagnostics via LED displays 

 SIMOTION D4x5 
302 Commissioning and Hardware Installation Manual, 11/2010 

Meaning LED display 
 RDY RUN STOP SU/PF SF DP1 DP2 OPT 
"FAULT" state 
(7-segment display  
shows "F").  
For details, see "7-segment display" and 
"Special operating modes" 

Λ  
(red)  

Λ  
(red) 

Λ  
(red) 

Λ  
(red) 

Λ  
(red) 

Λ  
(red) 

Λ  
(red) 

Λ  
(red) 

HOLD mode 
SIMOTION switches to HOLD mode as 
soon as the program comes to a 
breakpoint. When the program leaves 
the breakpoint, SIMOTION switches out 
of HOLD mode 

x 0.5/1 
(green) 

1 
(yellow) 

1 
(yellow) 

x x x x 

"RESET" state 
(7-segment display  
shows "8")  
For details, see "7-segment display" and 
"Special operating modes" 

2/1 
(red/yell
ow) 

x x x x x x x 

Incompatible hardware; SIMOTION 
Kernel is no longer operating with 
complete functionality on the hardware 
being used 

1  
(yellow) 

1  
(red) 

x x x x x x 

Underlicensing of technology/ 
option objects 

x x x x 0.5/1 
(red) 

x x x 

SINAMICS Integrated 
Firmware initialization 1  

(yellow) 
x x x x x x 0 

Module identification (identification via 
LED) selected via SCOUT or with 
p124[0]=1. 

1 
(yellow) 

x x x x x x x 

Commissioning/reset 0.5/1 
(green) 

x x x x x x 0 

SINAMICS Integrated is ready for 
operation and cyclic DRIVE-CLiQ 
communication is taking place. 

1 
(green) 

x x x x x x x 

General SINAMICS Integrated error 
(check parameterization/configuration) 

2/1 
(red) 

x x x x x x x 

SINAMICS Integrated has not powered 
up (SINAMICS firmware not available or 
faulty), or a fault has occurred 

1 
(red) 

x x x x 0 0 x 

Read or write access to CF card Λ 
(yellow) 

x x x x x x x 

Upgrade/downgrade of DRIVE-CLiQ 
components running  

0.5/1 
(yellow) 

x x x x x x x 

The upgrade/downgrade of DRIVE-CLiQ 
components is completed (power 
OFF/ON of the upgraded/downgraded 
devices is necessary) 

2/1 
(yellow) 

x x x x x x x 

PROFIBUS DP interfaces as master 
No parameter assignment available x x x x x 0 0 x 
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Meaning LED display 
 RDY RUN STOP SU/PF SF DP1 DP2 OPT 
At least one slave is missing. x x x x x 1 

(red) 
1 
(red) 

x 

Bus status "Clear" x x x x x 0.5/1 
(green) 

0.5/1 
(green) 

x 

Bus status "Operate" x x x x x 1 
(green) 

1 
(green) 

x 

PROFIBUS DP interfaces as i-slave 
No parameter assignment available x x x x x 0 0 x 
No parameter assignment master 
available 

x x x x x 1 
(red) 

1 
(red) 

x 

Bus status "Clear" x x x x x 0.5/1 
(green) 

0.5/1 
(green) 

x 

Bus status "Operate" x x x x x 1 
(green) 

1 
(green) 

x 

PROFINET IO interface (CBE30, X1400) 
No CBE30 connected x x x x x x x 0 
CBE30 runs error-free x x x x x x x 1 

(green) 
Bus error (CBE30): 
 Failure of a connected I/O device. 
 At least one of the assigned I/O 

devices cannot be addressed. 
 Incorrect or no configuration. 

x x x x x x x 2/1 
(red) 

Firmware downloaded x x x x x x x 2/1 
(green) 

Firmware download faulty x x x x x x x 0.5/1 
(red) 

Upgrading SIMOTION devices (device update tool) 
Upgrade/downgrade running x x x x 0.5/1 

(green) 
x x x 

Upgrade/downgrade completed with 
error  

x x x x Λ  
(red) 

x x x 

Upgrade/downgrade completed without 
error 3) 

x x x x 0 4) x x x 

Upgrade data is being copied from USB 
stick to CF card 

0.5/1 
(yellow/
green) 

x x x x x x x 

Booting is not possible from the used 
USB stick 

0.5/1  
(yellow) 
min. 
10 s 

x x x x x x x 

Upgrade data copying from USB stick to 
CF card completed with error 

Λ  
(red) 

x x x x x x x 
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Meaning LED display 
 RDY RUN STOP SU/PF SF DP1 DP2 OPT 
Upgrade data copying from USB stick to 
CF card completed without error 

1  
(green), 
min. 
10 s 2) 

x x x x x x x 

Backing up diagnostics data and non-volatile data 
Backing up diagnostic data and non-
volatile data (backup running) 

x x Λ 
(yellow) 

Λ 
(yellow) 

x x x x 

Backing up diagnostic data and non-
volatile data (backup completed) 

x Λ  
(green) 

x x x x x x 

The RDY LED of the SIMOTION D4x5 does not flash yellow/green as in the case of CUs, but instead lights up yellow 
constantly. 

1)  The LED state appears only very briefly due to the speed at which the "overall reset" is completed. The modules then 
power up (the STOP LED flashes yellow at 2 Hz). 

2)  The copying procedure is completed when the SF LED is steady green for at least 10 s  
3) The upgrade or downgrade has been completed when the SF LED goes out. The device then boots up automatically in 

the upgraded or downgraded configuration (SF LED display then depends on the operating mode of the device). 

Additional references 
More detailed information can be found in the Upgrading SIMOTION Devices Operating 
Instructions.  

7-segment display  
The 7-segment display provides further status information in addition to the LED displays. 

Table 9- 2 States of the 7-segment display 

State Meaning 
8 Module in the RESET state 

(RESET button pressed; overtemperature; faulty/disconnected 
fan/battery module) 

F F state (FAULT)  
In the F state, the CPU of the D4x5 is in HOLD mode, i.e. no 
software is running  
(D4x5 operating system is stopped) 

6 SIMOTION D has powered up 
Flashing point Communication is taking place between SIMOTION and 

SINAMICS Integrated 
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Special operating modes 
The following "special operating modes" are displayed via the status LEDs and the 
7-segment display.  

F state (FAULT) 

In the F state, the CPU of the D4x5 is in HOLD mode, i.e. no software is running (D4x5 
operating system is stopped).  

The state occurs for faults to which the D4x5 operating system cannot react (e.g. when the 
max. module temperature has been excessively exceeded).  

The state is displayed as follows: 

● All LEDs flicker red and 

● The 7-segment display shows "F" 

Possible measures: 

● Check the CF card 

● Perform a commissioning again 

● Correct any overtemperature 

● Replace the D4x5 

The state can only be exited by switching the D4x5 off and on. 

RESET state (permanent RESET) 

In the RESET state, the CPU of the D4x5 is in a permanent RESET, i.e.  

● No software is running (D4x5 operating system is stopped) and 

● The hardware is in a state that produces less power loss 

The state is displayed as follows: 

● The RDY LED flashes red/yellow at 2 Hz 

● The 7-segment display shows "8" 

Possible measures: 

● Correct any overtemperature 

● Ensure that the 24 V supply is stable without any power dips 

● Connect a fan/battery module (only on modules that require this) 

The state can only be exited by switching the D4x5 off and on. 
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9.1.2 LED displays of the PROFINET interface 

Position of the PN interface of the CBE30 

 
Figure 9-2 CBE30 front view 

LED displays  

Table 9- 3 Meaning of the LED displays 

Name Color State Meaning 
LINK Green On A different device is connected to port x and a physical connection 

exists. 
ACT Yellow Flashing Data is being received or sent at port x. 

Off PROFINET interface is operating without error; the data exchange to 
all configured I/O devices is running. 

On PROFINET interface bus fault 
 No physical connection to a subnet/switch. 
 Incorrect transmission rate 
 Full duplex transmission is not activated 

Fault  red 

Flashing 
(2 Hz) 

 Failure of a connected I/O device 
 At least one of the assigned I/O devices cannot be addressed. 
 Incorrect or no configuration. 
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Name Color State Meaning 
Off The PROFINET interface has not synchronized yet to the send cycle 

clock of PROFINET IO with IRT, or PROFINET IO with IRT has not 
been configured (e.g. only PROFINET IO with RT or TCP/IP 
communication). 
If IRT has been configured for SIMOTION, the PROFINET interface 
generates a local substitute cycle clock as long as there is no 
synchronization to the send cycle clock of PROFINET IO with IRT: 
 SIMOTION task system has synchronized to the local substitute 
cycle clock of the PROFINET interface. SINAMICS Integrated and 
external isochronous DP interfaces are synchronized to the local 
substitute cycle clock of the PROFINET interface. 

On The PROFINET interface has synchronized to the send cycle clock of 
PROFINET IO with IRT 
If IRT data has been configured for SIMOTION, then the following 
applies:  
The task system of SIMOTION has synchronized to the send cycle 
clock of PROFINET IO with IRT.  
SINAMICS Integrated and external isochronous DP interfaces are 
synchronized to the send cycle clock of PROFINET IO with IRT. 

SYNC 1)  Green 

Flashing 
(2 Hz) 

The PROFINET interface has synchronized to the send cycle clock of 
PROFINET IO with IRT 
If IRT data has been configured for SIMOTION, then the following 
applies:  
The task system of SIMOTION has synchronized to the send cycle 
clock of PROFINET IO with IRT.  
SINAMICS Integrated and external isochronous DP interfaces are not 
yet synchronized to the send cycle clock of PROFINET IO with IRT. 

1) If no IRT has been configured, then generally no synchronization will be made to the send cycle 
clock. LED is off.  

9.1.3 LED displays of the Ethernet interface 
The Ethernet ports are equipped with LEDs to display Link and Activity.  

Table 9- 4 State of the Link and Activity LEDs 

LED State Meaning 
OFF No or faulty connection LINK (upper LED) 
Lights up green Transfer rate 10 or 100 Mbit/s: 

A different device is connected to port x and a 
physical connection exists. 

OFF No LAN connection ACT (lower LED) 
Flickers yellow LAN connection 

Data is being received or sent at port x 
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9.1.4 LED displays of the CX32 controller extension 
The different states that occur during power-up are indicated by the LEDs on the CX32 
controller extension. 

● The duration of the individual states varies. 

● If an error occurs, the power-up is terminated and the cause is indicated accordingly via 
the LEDs. 

● At the end of an error-free power-up, all LEDs are switched off briefly. 

● After power-up, the LEDs are controlled via the loaded software. 

9.1.4.1 Behavior of the LEDs during booting of the CX32 

Table 9- 5 Load software 1  

LED 

RDY DP1 

State Comment 

Red Red Reset Hardware reset 
Red, 2 Hz Red Error  D4x5 CompactFlash card not inserted 

or 
 Load software 2 has not been installed on the 

D4x5 CompactFlash card or is defective. 

 

Table 9- 6 Load software 2 

LED 

RDY DP1 

State Comment 

Off Red Loaded – 
Off Yellow Running – 
Off Red, 2 Hz Error file Software on the D4x5 CompactFlash card is 

incomplete or defective. 
Off Red, 0.5 Hz Error CRC CRC faulty. 
Off Off FW loaded – 

 

Table 9- 7 Firmware 

LED 

RDY DP1 

State Comment 

Off Off Initializing – 
Alternating Alternating Running See the table below 
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9.1.4.2 Behavior of the LEDs after booting of the CX32 

Behavior of the LEDs after booting 

Table 9- 8 Control unit - description of the LEDs after booting 

LED Color State Description, cause  Remedy 
- OFF Electronics power supply is missing or outside 

permissible tolerance range 
– 

Continuous 
light 

The component is ready and cyclic DRIVE-CLiQ 
communication takes place or the CX32 waits for 
initial commissioning 

– Green 

2 Hz 
flashing 
light 

Writing to the memory card – 

Continuous 
light 

At least one fault is present in this component Remedy and acknowledge 
fault 

Red 

2 Hz 
flashing 
light 

Boot error Check whether the D4x5 
CompactFlash card is 
inserted correctly  
Replace the D4x5 
CompactFlash card  
Replace the CX32  
Perform POWER ON 

Green/ 
red 

0.5 Hz 
flashing 
light 

CX32 is ready for operation. 
However, software licenses are missing 

Obtain licenses 

Continuous 
light 

System booting and DRIVE-CLiQ communication is 
being established 

– 

0.5 Hz 
flashing 
light 

Firmware update of the connected DRIVE-CLiQ 
components running 

- 

Yellow 

2 Hz 
flashing 
light 

Firmware update is complete for components. Wait 
for POWER ON for the components in question 

Turn POWER ON for the 
components in question 

RDY 
(READY) 

Green/ 
yellow or 
red/ 
yellow 

1 Hz 
flashing 
light 

Detection of the components via LED is activated 
(p0124[0]). 
Note: 
Both options depend on the LED status when 
activated via p0124[0] = 1 

- 

- Red Cyclic communication is not (yet) running. 
Note: 
The PROFIdrive is ready for communication when 
the CX32 is ready for operation (see RDY LED) 

– DP1 
PROFIdrive 
cyclic 
operation 

Green Continuous 
light 

Cyclic communication is taking place. – 
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LED Color State Description, cause  Remedy 
0.5 Hz 
flashing 
light 

Full cyclic communication has not yet taken place. 
Possible causes: 
 D4x5 does not transfer any setpoints 
 During isochronous operation, no global control 

(GC) or a faulty global control (GC) is 
transferred by the D4x5 

– 

Red Continuous 
light 

Cyclic communication has been interrupted. Remedy fault 

Yellow 2 Hz 
flashing 
light 

Firmware checksum error (CRC error) Check whether the memory 
card is inserted correctly  
Replace the memory card  
Replace the CX32  
Perform POWER ON 

9.2 Diagnostic data and non-volatile data 

9.2.1 Overview 
As of V4.1 SP2, and without the need for the SCOUT engineering system, you can use 
simple operations (e.g. setting switches) to:  

● Back up diagnostic data, including non-volatile data (retain data) to the CF card; for 
information, see Section Backing up diagnostic data and non-volatile data (Page 310). 

● Back up HTML pages (including the most up-to-date content) to the CF card for 
diagnostic purposes; for information, see Section Diagnostics via HTML pages 
(Page 315) 

● Restore backed-up non-volatile data (retain data); for information, see Section 
Deleting/restoring non-volatile data (Page 317) 

9.2.2 Backing up diagnostic data and non-volatile data 

9.2.2.1 Diagnostic data 
Following a fault on a SIMOTION device, diagnostic data (e.g. diagnostic buffer content, up-
to-date content of websites, etc.) can provide important information on the cause of the fault. 
For this purpose, such data can be backed up to the CompactFlash Card using a simple 
operation (e.g. by setting a switch on the D4x5).   

You then have the following options for the diagnostic data: 

● You can retrieve it from the CompactFlash Card using a card reader 

● You can download it using IT DIAG or FTP 
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You can also use it for diagnostic purposes or provide it to technical support for evaluation 
purposes. 

Various options are available to you for backing up diagnostic data: 

● Backup during operation (in STOP/STOPU/RUN mode); for information, see the section 
titled Procedure: "Backup during operation" (Page 311) 

– Using IT DIAG; 
IT DIAG also offers the option of retrieving diagnostic data online 

– Using a service selector switch 

● Backup while the module is powering up; for information, see the section titled Procedure: 
"Backup during power-up" (Page 312). 

– Using a service selector switch 

– Controlling diagnostic data creation using an INI file stored on the CompactFlash Card 

9.2.2.2 Non-volatile data (retain data) 
In addition to diagnostic data, non-volatile data (retain data) is saved on the 
CompactFlash Card. You can use these in situations where the non-volatile data has not 
been saved on the CompactFlash Card using the _savePersistentMemoryData system 
function, and you wish to restore the non-volatile data after a CPU has been replaced.   

 

 Note 

While the non-volatile data are stored as a "PMEMORY.XML" backup file in the 
"...USER/SIMOTION" directory using the _savePersistentMemoryData system function, 
backing up diagnostic data and non-volatile data involves storing data in the 
"...\USER\SIMOTION\HMI\SYSLOG\DIAG directory. 

 

9.2.2.3 Procedure for backing up during operation 

Procedure 
The advantage of backing up diagnostic data and non-volatile data during operation is that 
enhanced diagnostic information is available via HTML pages and TO alarm information.  

Data is backed up: 

● With IT DIAG by selecting "Diagnostics > Diagnostics Files"; for information, see Section 
Backing up diagnostic data and non-volatile data with IT DIAG (Page 318) 

● Using the service selector switch (see the description below) 
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Service selector switch 
To back up diagnostic data and non-volatile data using a service selector switch, proceed as 
follows: 

1. Set the service selector switch to "Diagnostics" (position "D"). 
The positions of the mode switch are not relevant (i.e. the set operating mode remains 
unchanged). 
The diagnostic data and non-volatile data can be created in STOP, STOPU, and RUN 
modes. 

 
Figure 9-3 Mode switch and service selector switch 

2. The diagnostic data and non-volatile data is backed up to the CF card. 
The backup process is indicated by the status LEDs as shown in the following table: 

3. Once the backup is complete, switch the D4x5 off. 

4. Remove the CF card and reset the service selector switch to its original setting. 

Table 9- 9 LED displays during backup process 

Status LED displays on the D4x5 
Backup in progress STOP LED and SU/PF LED flicker yellow  
Backup complete RUN LED flickers green  

9.2.2.4 Procedure for backing up during startup 

Procedure 
Backing up diagnostic data and non-volatile data during startup provides you with diagnostic 
information without HTML pages / TO alarm information. 

Backing up during startup is particularly advisable for SIMOTION devices that are not run 
capable or have crashed.  

Diagnostic data and non-volatile data is backed up 

● Using a service selector switch or 

● Using an INI file saved on the CF card 

The procedure for each is described below. 
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Service selector switch 
Data is backed up using a service selector switch as follows: 

1. Set the service selector switch to "Diagnostics" (position D). 
The positions of the mode selector switch are not relevant (i.e. the set operating mode 
remains unchanged). 

 
Figure 9-4 Mode switch and service selector switch  

2. Switch the D4x5 off and back on again. 

3. Wait for the device to power up. 
The diagnostics data and non-volatile data is backed up to the CF card during startup, 
provided that this is still possible and is not prevented by HW defects, for example. Note 
the LED displays as shown in the following table. 

4. Once the backup is complete, switch the D4x5 off. 

5. Remove the CF card and reset the service selector switch to its original setting. 

Table 9- 10 LED displays during backup process 

Status LED displays on the D4x5 
Backup in progress STOP LED and SU/PF LED flicker yellow  
Backup complete RUN LED flickers green  

INI file in the main CF card directory 
1. Use a text editor (such as Notepad) to create a file called simotion.ini 

2. Add the following text: DIAG_FILES=1 
You must use a text editor and may not use any formatting in the text. 

3. Copy the simotion.ini file to the main CF card directory. 

4. Insert the CF card into the module, which is switched off. 

5. Switch the D4x5 on and allow the SIMOTION device to power up. 
The diagnostic data and the non-volatile data will be backed up to the data carrier during 
power-up if this is still possible and is not prevented by HW defects, for example. Note 
the LED displays as shown in the following table. 

6. Once the backup is complete, switch off the SIMOTION device. 

7. Remove the CF card. 
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Table 9- 11 LED displays during backup process 

Status LED displays on the D4x5 
Backup in progress STOP LED and SU/PF LED flicker yellow  
Backup complete RUN LED flickers green  

 
 

NOTICE  
To suppress startup in diagnostics mode again, you must delete the simotion.ini file from 
the CF card. 

 

9.2.2.5 Storing data 

Storing diagnostic data and non-volatile data  
You can find diagnostic data and non-volatile data on the CompactFlash Card in 
the \USER\SIMOTION\HMI\SYSLOG\DIAG directory.    

Copy these data and transfer them to technical support on request. A standard card reader 
can be used to transfer the diagnostic data the CompactFlash Card via standard IT DIAG 
sites or FTP. 

The following data are stored: 

Table 9- 12 Diagnostic data on the CompactFlash Card 

File Application 
DIAGBUF.TXT Diagnostic buffer in a simple text format: 

Numerical values; no specific plain text. A text editor is used for evaluation 
purposes. 

PMEMORY.XML Non-volatile data (retain data) 
Operator input can be used to restore the non-volatile data saved after a 
CPU has been replaced. 
(For information, see the section titled Restoring non-volatile data 
(Page 317)). 

TOALARMS.TXT Text file containing the pending TO alarms. Only TO IDs, alarm numbers, 
and associated HEX values. 
Note: 
The TO alarms are only created if diagnostic data have been created during 
operation (STOP/STOPU/RUN). 

Website If the diagnostic data is backed up, the URLs are requested from the text file 
(DIAGURLS.TXT) and stored as websites together with their content. 
(For information, see the section titled Diagnostics for websites (Page 315)). 
Note: Note:The websites are only stored if diagnostic data are created 
during operation (STOP/STOPU/RUN). 

Other files All other files stored in the directory are only of relevance to technical 
support. 
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 Note 

Use websites if you wish to back up diagnostic data in plain-text format. Websites enable 
user-friendly diagnostics. In addition to the standard IT DIAG diagnostics sites, you have the 
option of creating your own websites (e.g. for the axis status or for machine diagnostics). 
Customized diagnostics sites are particularly suitable for application problems, as you can 
define the contents yourself. 

 

9.2.3 Diagnostics via websites 
In the "DIAGURLS.TXT" text file, found in the ...\USER\SIMOTION\HMI\SYSLOG\DIAG 
directory, you can specify HTML files whose status is to be stored on the CF card when 
diagnostic data is created during operation. (For example, "devinfo.mcs" must be entered for 
the "devinfo.htm" HTML page.)  

Since the pages in question are stored together with their most up-to-date contents, this 
enables the latest status information regarding the SIMOTION device, as well as the 
machine/system, from the point at which diagnostic data were created (e.g. when the service 
selector switch was activated) to be archived. 

In addition to the standard IT DIAG diagnostics pages, it is possible to store customized 
sites. Information on creating pages of this type can be found in, for example, Utilities & 
Applications. 
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Figure 9-5 Diagnostics buffer with generated diagnostic data 

The following points must be noted for the DIAGURLS.TXT file: 

● A DIAGURLS.TXT file containing the standard IT DIAG pages is automatically created if 
you have not stored your own DIAGURLS.TXT file. 

● Standard IT DIAG pages are entered "without" a path specification (e.g. "devinfo.mcs" for 
the standard IT DIAG site "devinfo.htm"). 

● Customized IT DIAG pages (such as "user.htm") in the \USER\SIMOTION\HMI\FILES 
directory on the CF card must contain the FILES/ path specification. 

● If you have created subfolders (e.g. "myfolder" in the FILES directory), these must also 
appear in the path. 

● Only one file name may be used per line. 

● Empty lines are not permitted (an empty line will be interpreted as the end of the list). 
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● No distinction is made between upper-case and lower-case letters. 

● It does not matter whether you use "\" or "/" in the path name. 

 
Figure 9-6 Depiction of DIAGURLS.TXT editor 

Additional references 
For detailed information about IT DIAG device and diagnostic information, see the 
SIMOTION IT Ethernet-Based HMI and Diagnostic Functions Diagnostics Manual. 

9.2.4 Deleting/restoring non-volatile data 

Requirement 
The diagnostic data and non-volatile data has been backed up to the CF card; for 
information, see Section Backing up diagnostic data and non-volatile data (Page 310).  
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Procedure 
To restore non-volatile data after a CPU has been replaced, proceed as follows: 

1. Insert the CF card into the new D4x5 (which must be switched off). 

2. Set the service selector switch to the "Delete/restore non-volatile data" setting (switch 
position "1"). 
The positions of the mode selector are not relevant (i.e. the set operating mode remains 
unchanged). 

 
Figure 9-7 Switch position 1 for deleting/restoring non-volatile data 

3. Allow the D4x5 to power up; the non-volatile data is first deleted and then restored while 
this is taking place. 
If there is a file called "PMEMORY.XML" in the "USER/SIMOTION" directory on the 
CompactFlash Card, this will be restored (rather than the "PMEMORY.XML" file saved 
using diagnostics in directory \USER\SIMOTION\HMI\SYSLOG\DIAG). 
The order of priority for restoration is as follows: 

– /USER/SIMOTION/PMEMORY.XML 

– /USER/SIMOTION/PMEMORY.BAK 

– /USER/SIMOTION/HMI/SYSLOG/DIAG/PMEMORY.XML 

  Note 

When the "Delete/restore non-volatile data" switch position is selected, the non-
volatile data of the D4x5 is first deleted and then restored by means of the PMEMORY 
backup file. 

4. Once the D4x5 has powered up, switch it off. 

5. Reset the service selector switch to its original setting. 

6. Switch the D4x5 back on. 

9.2.5 Backing up diagnostic data and non-volatile data using IT DIAG 
SIMOTION devices feature pre-configured, standard IT DIAG pages. These pages can be 
displayed via Ethernet using a commercially available browser. Additionally, you have the 
option of creating your own HTML pages and incorporating service and diagnostic 
information.  
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You can also use IT DIAG to back up diagnostic data and non-volatile data. IT DIAG is 
opened by entering the IP address of the SIMOTION device in the address bar of the 
browser; e.g. http://169.254.11.22 

This opens the IT DIAG start screen. To back up diagnostic data and non-volatile data, call 
up the "Diagnostic files" page from the "Diagnostics" menu. 

 
Figure 9-8 IT DIAG 
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Table 9- 13 Functions on the "Diagnostic files" HTML page 

Button Function 
Create general diagfiles This button saves diagnostic data and non-volatile data in the 

...\USER\SIMOTION\HMI\SYSLOG\DIAG directory. HTML files 
used for diagnostics purposes are not saved. 

Create html diagfiles This button is used to save diagnostics HTML pages on the data 
carrier. It should be noted that only those pages that are listed in 
the DIAGURLS.TXT file in directory 
...\USER\SIMOTION\HMI\SYSLOG\DIAG are backed up, see 
Section Backing up diagnostic data and non-volatile data 
(Page 310). 

Zip all diagfiles The "zip all Diagfiles" button enables you to compress 
diagnostics files. This stores all files and folders in a ZIP file in 
directory ...\USER\SIMOTION\HMI\SYSLOG\DIAG, while 
retaining the folder structure. 

Get diagarchive This button is used to save the ZIP archive to connected 
programming devices/PCs. 

Delete all diagfiles This button is used to delete all data stored in the 
...\USER\SIMOTION\HMI\SYSLOG\DIAG directory; the directory 
itself is not removed, however. 

You can find diagnostic data and non-volatile data on the CF card in the following directory: 
\USER\SIMOTION\HMI\SYSLOG\DIAG 

Additional references 
Detailed information can be found in the SIMOTION IT Ethernet-Based HMI and Diagnostic 
Functions Diagnostics Manual. 

9.3 Additional service and diagnostics options 

9.3.1 SIMOTION Task Profiler application 
The SIMOTION Task Profiler is a dedicated application installed parallel to 
SIMOTION SCOUT during SIMOTION SCOUT setup. The Task Profiler can be called in 
online mode using device diagnostics in SIMOTION SCOUT or the Windows application. In 
the event of a malfunction or error, the Task Trace data can be written to a directory or the 
CompactFlash Card. They can then be processed using the Task Trace Viewer.    

Additional references 
For detailed information, refer to the SIMOTION Task Trace Function Manual. 
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9.3.2 Diagnostics using IT DIAG 
The SIMOTION D features an integrated Web server.  

In addition to customized Web pages and the option of performing firmware and project 
updates, IT DIAG provides comprehensive device and diagnostic information that can be 
called up using a standard PC with Internet Explorer.  

As of firmware version V4.2, it is no longer necessary to purchase licenses for SIMOTION IT 
DIAG and SIMOTION OPC-XML. 

Additional references 
Detailed information can be found in the  
SIMOTION IT Ethernet-Based HMI and Diagnostic Functions Diagnostics Manual. 
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Configuration of drive-related I/Os (without symbolic 
assignment) A
 

Further information and programming examples for configuring drive-related I/Os without 
symbolic assignment can be found 

● On the Internet at http://support.automation.siemens.com/WW/view/en/29063656 
(http://support.automation.siemens.com/WW/view/en/29063656) 

● In SIMOTION Utilities & Applications 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.  

The configuration of local measuring inputs is fundamentally different to the configuration of 
global measuring inputs.  

The assignment of the local measuring inputs is permanently related to the hardware of the 
control unit and is performed  

● On the drive side via the drive expert list and 

● During the configuration of the TO measuringInput via the measuring input number 

Local and global measuring inputs have different properties. Detailed information on the 
differences can be found in the appendix,  
in Section Local and global measuring inputs (Page 323) 

Information on the configuration can be found 

● For global measuring inputs (with symbolic assignment) in Section Configuration of global 
measuring inputs (Page 230) 

● For local measuring inputs in the appendix, in Section Configuration of local measuring 
inputs (Page 325) 

A.1 Local and global measuring inputs 

Local and global measuring inputs 
Depending on the used hardware platform, the following local and global measuring inputs 
are available for the measuring tasks:  

● Local measuring inputs are axis-related and implemented in the SINAMICS drive. The 
actual position value is measured. 

● Global measuring inputs can be freely assigned to the axes and add an internal time 
stamp to the measurement result for more precise determination of the axis positions. 

The term "central measuring input" is also used within the context of drives.  

http://support.automation.siemens.com/WW/view/en/29063656�
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Table A- 1 Comparison of local and global measuring inputs 

 Local measuring input Global measuring input 
Hardware supported D410, D4x5, D4x5-2 (terminal 

X122/X132), CX32, CX32-2, CU310, 
CU320, CU320-2 

TM15, TM17 High Feature, D410, 
D4x5, D4x5-2 (terminal X122, X132, 
X142), CX32, CX32-2, CU310, CU320, 
CU320-2 

Measurement operation With a signal edge at the relevant input, 
the current actual values of an encoder 
connected to a control unit are 
measured with positioning accuracy to 
determine lengths and distances. 

With a signal edge at the relevant input, 
the current actual values of one or 
more encoders are measured using 
time stamp functionality with positioning 
accuracy in order to provide information 
for determining lengths and distances 
(possible with any encoders included in 
the project). 

Configuration of the TO measuringInput 
in the SIMOTION SCOUT 

The assignment of inputs is always 
permanent depending on the hardware 
of the control unit and is performed 
during the configuration of the TO 
measuringInput using the measuring 
input number. 

The assignment of inputs is not fixed 
depending on the hardware and is 
performed during the configuration of 
the TO measuring input by means of 
symbolic assignment or the hardware 
address. 

TO measuringInput setting: Single 
measurement 
(Measurement jobs must be issued 
individually for each measurement. 
Several interpolation cycle clocks lie 
between two measurements.) 

Yes Yes 

TO measuringInput setting: Cyclic 
measuring 
(Measuring is activated just once and 
runs cyclically until deactivated.) 

No Yes 
D410, D4x5, D4x5-2 (terminal X122, 
X132), CX32, CX32-2, CU310, CU320, 
CU320-2: 
The minimum interval between two 
measurements is three servo cycle 
clocks (max. two edges per 
measurement). 
D4x5-2 (terminal X142), TM17 High 
Feature: 
The minimum interval between two 
measurements is one servo cycle clock 
(max. two edges per measurement). 
TM15: 
No cyclic measurement available 

Use of multiple TO measuringInputs on 
one axis/encoder, whereby these can 
be active concurrently. 

No Yes 

Listening TO measuringInput No Yes 
Measuring on virtual axes No Yes 
Measuring on axes attached to a 
different drive unit 

No Yes 

SIMOTION Utilities & Applications includes, for example, a tool to estimate: 
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● The time between a measurement job being initiated and it being effective in the drive 

● The minimum time between two measurement jobs 

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 

Table A- 2 Measuring inputs - overview of quantity structures and functionality 

 Maximum available quantity structure 
 D410, CU310, 

CX32 
D4x5, CU320 CX32-2 D4x5-2  

- X122/X132 
- X142 

TM15 TM17 High 
Feature 

Maximum number of 
measuring input inputs 

3 6 4 - 8 
- 8 

24 16 

Can be configured as a 
local measuring input 

x x x - 8 
- 0 

- - 

Can be configured as a 
global measuring input 

x x x - 8 
- 8 

x x 

A.2 Configuring local measuring inputs 

Configuring local measuring inputs 
Local measuring inputs are always permanently assigned to an axis (drive). They are 
configured separately for each drive. The drive and the measuring input input must always 
be located on the same control unit. The measurement results are transferred using the axis 
message frame in accordance with the PROFIdrive profile. Message frame 39x does not 
need to be configured for local measuring inputs.  

The settings for the use of the local measuring inputs must be made in the expert list.  

In order to use an I/O terminal on a D4x5, CX32 or SINAMICS control unit as measuring 
input input, proceed as follows: 

1. Double-click the "Inputs/outputs" entry below the control unit in the project navigator. 

2. Click the "Bidirectional digital inputs/outputs" tab. 

3. In this tab, configure the required I/O terminal as input. The configuration can also be set 
channel-granular on the p728 parameter using the expert list of the control unit. 

Specification of the measuring input input terminal must be made in the expert list of the 
respective drive for local measuring inputs. 
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Table A- 3 Local measuring inputs, required settings in the expert list  

Parameterization as  Parameters in the expert list of the drive 

D4x5, CU320 CX32, CU310 
p488[0]  
(measuring input 1 input terminal, encoder 1) 
p488[1]  
(measuring input 1 input terminal, encoder 2) 
p488[2]  
(measuring input 1 input terminal, encoder 3) 
p489[0]  
(measuring input 2 input terminal, encoder 1) 
p489[1]  
(measuring input 2 input terminal, encoder 2) 

Specification of the 
input terminal of the 
measuring input in the 
expert list of the drive 

p489[2]  
(measuring input 2 input terminal, encoder 3) 

DI/DO 9 or 
DI/DO 10 or 
DI/DO 11 or 
DI/DO 13 or 
DI/DO 14 or 
DI/DO 15 

DI/DO 9 or 
DI/DO 10 or 
DI/DO 11 

 

As a maximum of three encoders can be assigned to a drive, the index [0...2] specifies 
whether the measurement applies to encoder 1, 2, or 3. 

The following must be taken into account: 

● Only two TO measuringInputs can be configured per TO axis or TO externalEncoder. 

● Only one TO measuringInput can be active on a TO axis or TO externalEncoder. 

Table A- 4 Local measuring inputs, configuration of the TO measuringInput 

Axis measuring system no. Under axis measuring system number, enter the number of the used 
encoder system (namely, encoder 1, 2 or 3). Encoder system 1 is the 
default setting. 

Drive-related (local 
measuring input) 

Activate the checkbox when a local measuring input is used. 

Measuring input number Enter here which measuring input is used (namely, 1 or 2). Input 1 is 
the default setting. 

Detailed information can be found in the SIMOTION Motion Control Output Cams and 
Measuring Inputs Function Manual. 
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Standards and approvals B
B.1 General rules 

EN 61131, EN 60950 
The SIMOTION programmable controller meets the requirements and criteria of the 
standards EN 61131 and EN 60950.  

CE marking 
 

 
Our products satisfy the requirements and protection objectives of the EC 
Directives and comply with the harmonized European standards (EN).  

EMC Directive 
SIMOTION products are designed for industrial use in accordance with product standard DIN 
EN 61800-3, Category C2.  

cULus Approval 
 

 

Listed component mark for United States and the Canada Underwriters 
Laboratories (UL) according to Standard UL 508, File E164110, File E115352, 
File E85972.  

EMC 
 
USA 
Federal 
Communications 
Commission 
Radio Frequency 
Interference 
Statement 

This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user 
will be required to correct the interference at his own expense. 

Shielded Cables Shielded cables must be used with this equipment to maintain compliance with 
FCC regulations. 
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USA 
Modifications Changes or modifications not expressly approved by the manufacturer could 

void the user’s authority to operate the equipment. 
Conditions of 
Operations 

This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 

 

 
CANADA 
Canadian Notice This Class B digital apparatus complies with Canadian ICES-003. 
Avis Canadien Cet appareil numérique de la classe B est conforme à la norme NMB-003 du 

Canada. 
 

 
AUSTRALIA 

 

D425, D435, D445, D445-1 meets the requirements of the AS/NZS CISPR 22. 

Declaration of conformity 
The current Declaration of conformity is available on the Internet at Declaration of conformity 
(http://support.automation.siemens.com/WW/view/en/10805446/134200).  

Electromagnetic compatibility 
Standards for EMC are satisfied, if the EMC Installation Guideline is observed.  

 

CAUTION  
There is a risk of injury or of damage to assets. In hazardous areas, personal injury or 
damage to assets can occur if plug-in connections are disconnected during operation. 
Always de-energize your equipment in hazardous areas before disconnecting plug-in 
connections. 

 

http://support.automation.siemens.com/WW/view/en/10805446/134200�
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 Note 

The product standard EN 61800-3 describes the EMC requirements placed on "Variable-
speed drive systems". As such, it defines different limits depending on the location of the 
drive system.  

SINAMICS S120 power units are designed for use in the second environment. The term 
second environment refers to all locations outside residential areas. These are basically 
industrial areas which are supplied from the medium-voltage line supply via their own 
transformers. 

It is essential to follow the installation instructions in the SINAMICS S120 Manuals in order to 
ensure compliance with emitted interference and immunity values. 

For more information on this topic also refer to Catalog PM21 as well as the SINAMICS 
Function Manuals.  

 

B.2 Safety of electronic controllers 

Introduction 
The following remarks relate to fundamental criteria and apply irrespective of the type of 
controller and the manufacturer.  

Risk 
A higher degree of safety standard applies to all applications and situations where there is a 
risk of material damage or injury to persons if there is a failure. Special regulations specific to 
the system apply to such applications. These must be taken into account for configuration of 
the controller (e.g. VDE 0116 for furnaces). 

For electronic controllers with safety responsibility, the measures required for preventing or 
controlling faults depend on the hazard inherent in the plant. In this respect, the basic 
measures listed above are no longer adequate once the hazard exceeds a certain potential. 
Additional measures (e.g. double redundancy, tests, checksums, etc.) for the controller must 
implemented and certified (DIN VDE 0801).  
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The residual risk 
When assessing his machine's risk in accordance with the EC Machinery Directive, the 
machine manufacturer must take into account the following residual risks emanating from the 
control and drive components: 

1. Unintentional movements of driven machine components during commissioning, 
operation, maintenance, and repairs caused by, for example: 

– Hardware defects and/or software errors in the sensors, controllers, actuators, and 
connection technology 

– Response times of the controller and drive 

– Operating and/or ambient conditions not within the scope of the specification 

– Parameterization, programming, cabling, and installation errors 

– Use of radio devices / cellular phones in the immediate vicinity of the controller 

– External influences / damage 

2. Exceptional temperatures as well as emissions of light, noise, particles, or gas caused by, 
for example: 

– Component malfunctions 

– Software errors 

– Operating and/or ambient conditions not within the scope of the specification 

– External influences / damage 

3. Hazardous shock voltages caused by, for example: 

– Component malfunctions 

– Influence of electrostatic charging 

– Induction of voltages in moving motors 

– Operating and/or ambient conditions not within the scope of the specification 

– Condensation / conductive contamination 

– External influences / damage 

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a 
risk to people with a pacemaker, implants or metal replacement joints, etc. if they are too 
close 

5. Release of environmental pollutants or emissions as a result of improper operation of the 
system and/or failure to dispose of components safely and correctly 
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ESD guidelines C
C.1 ESD definition 

What does ESD mean?  
All electronic modules are equipped with highly integrated modules or components. Because 
of the technology used, these electronic components are very sensitive to overvoltages and 
thus to discharge of static electricity.  

The acronym ESD has become the established designation for such Electrostatic Sensitive 
Devices. The ESD designation is used internationally to refer to electrostatic sensitive 
devices. 

Electrostatic sensitive devices are identified by the following symbol: 

 
Figure C-1 Symbol for identification of electrostatic sensitive devices 

 
 

CAUTION  
Electrostatic sensitive devices can be irreparably damaged by voltages that are far lower 
than anything a person can perceive. These voltages occur if you touch a component or the 
electrical connection of a module without having previously discharged any static from your 
body. Any damage that occurs to a module as a result of overvoltage is generally not 
recognized immediately and only comes to light after the equipment has been operating for 
some time. 

 



ESD guidelines  
C.2 Electrostatic charging of individuals 

 SIMOTION D4x5 
332 Commissioning and Hardware Installation Manual, 11/2010 

C.2 Electrostatic charging of individuals 
Any person who is not conductively connected to the electrical potential of the environment 
can accumulate an electrostatic charge. 

This figure indicates the maximum electrostatic charges that can accumulate on an operator 
when he comes into contact with the indicated materials. These values comply with the 
specifications in IEC 801-2. 

 
Figure C-2 Electrostatic voltage that can accumulate on operating personnel 
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C.3 Basic measures for protection against discharge of static electricity 

Ensure sufficient grounding 
When working with electrostatic sensitive devices, make sure that the you, your workstation, 
and the packaging are properly grounded. This prevents the accumulation of static 
electricity. 

Avoid direct contact 
You should only touch ESD components if unavoidable (for example, during maintenance 
work). When you touch modules, make sure that you do not touch either the pins on the 
modules or the printed conductors. If you follow these instructions, electrostatic discharge 
cannot reach or damage sensitive components. 

If you have to take measurements on a module, make sure that you first discharge any static 
that may have accumulated in your body. To do this, touch a grounded metal object. Only 
use grounded measuring instruments. 
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Configuration overview, 227 
Overview, 226 

Online configuration 
Procedure, 166 
Requirement, 166 

Output cam 
Configuration for D4x5, 233 

Overview 
Diagnostic data, 310 
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IO controller, 133 
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Back up, 291 
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Overview, 263 
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System overview, 13 
User memory concept, 88 
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SIMOTION SCOUT 
Documentation, 23 
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SIMOTION Task Profiler, 320 
SINAMICS Integrated 
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Optimum, 243 
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System 
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Testing the drive, 200 
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TM41 terminal module, 236 

Configuring, 237 
Totally Integrated Automation, 13 
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Back up, 273 
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Load, 248 

User memory concept, 88 
Backup time, 90 
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Non-volatile data, 89 
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Variables 
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